Digital Video Software
User Guide
# Table of Contents

**Chapter 1: Introduction** .............................................................13

Conventions Used in this Documentation .............................................................13

System Administration .................................................................15

**Chapter 2: Digital Video Folder** ................................................17

Digital Video Recorder Overview .................................................................17

Virtual Matrix Switcher for LDVR and Third Party Recorders ..................................18

LDVR-SP ..................................................................................................18

LDVR-SP30 ..................................................................................................19

LDVR- 408 ..................................................................................................20

LDVR- 444 ..................................................................................................21

LNVR ........................................................................................................22

LNVS ........................................................................................................23

Features ..................................................................................................24

Time-Lapse Recording ..................................................................................24

Integration with Storage Calculator ................................................................24

Video Recorder Form ..................................................................................25

Video Recorder Form (Connection Sub-tab) ..................................................26

LNVR Security and Passwords ........................................................................27

Video Recorder Form (Recording Sub-tab) ...................................................29

Video Recorder Form (Archiving/Purging Sub-tab) .........................................31

Video Recorder Form (Capacity Sub-tab) ......................................................33

Video Recorder Form (Performance Sub-tab) ...............................................34
### Table of Contents

**Video Recorder Form Procedures** .............................................................. 35

- Add LNVR Video Recorders ........................................................................ 36
- Add LNVR Failover Video Recorders ............................................................ 37
- Add LNVS Video Recorders ......................................................................... 38
- Add Video Recorders Other Than LNVR/LNVS Recorders .......................... 39
- Use the Video Recorder Form Right-Click Menu ........................................ 40
- Import IP Cameras from the Storage Calculator .......................................... 41
- Add Multiple LDVR Cameras ..................................................................... 41

**Camera Form** ............................................................................................. 42

- Analog Cameras .......................................................................................... 42
- IP Cameras .................................................................................................. 42

**Camera Form (Communication Sub-tab)** ................................................ 44

**Camera Form (Connection Sub-tab)** ....................................................... 47

**Camera Form (Record Settings Sub-tab)** ............................................... 50

**Camera Form (Quality Sub-tab)** ............................................................... 53

**Camera Form (Video Sub-tab)** ................................................................. 54

- Rotation for PTZ Cameras ......................................................................... 54

**Camera Form (Video Sensor Sub-tab)** .................................................. 55

**Camera Form (Normal Mode Sub-tab)** .................................................. 57

- Camera Time Stamps ................................................................................. 59

**Camera Form (Event Mode Sub-tab)** ..................................................... 61

- Event Mode Sub-tab Functions .................................................................. 61

**Camera Form (Audio Sub-tab)** ............................................................... 63

**Camera Form (In-Camera Storage Sub-tab)** .......................................... 64

**Camera Requirements** ........................................................................... 64
Camera Configuration ............................................................... 65
Software Configuration ............................................................. 66
Camera Form (Capacity Sub-tab) ............................................... 67
Camera Form Procedures ........................................................... 68
  Configure LNVR Cameras ...................................................... 68
  Configure LNVS Cameras ...................................................... 70
  Configure Cameras Other Than LNVR/LNVS Cameras ............ 71
Capture Video on Event Only ..................................................... 73
Capture Video on Demand ....................................................... 74
Increase Frame Rates During Events ........................................ 75
Estimate RAM Needed for Pre-roll ........................................... 75
Configure Motion Detection and Apply Motion Mask to a Camera 77
Configure Time-Lapse Recording for LDVR Cameras ................. 78
Configure Time-Lapse Recording with Motion Detection for LNVR Cameras 79
Camera Inputs Form ............................................................... 79
Camera Inputs Form Procedures ............................................... 81
  Add a Camera Input .............................................................. 81
  Modify a Camera Input .......................................................... 81
  Delete a Camera Input .......................................................... 81
Camera Outputs Form ............................................................. 82
Camera Outputs Form Procedures ............................................. 83
  Add a Camera Output ............................................................ 83
  Modify a Camera Output ........................................................ 83
  Delete a Camera Output ........................................................ 83
Remote Monitor .................................................................... 84
LNVR Security ...................................................................... 85
<table>
<thead>
<tr>
<th>Form</th>
<th>Procedures</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote Monitor Form</td>
<td>Procedures</td>
<td>85</td>
</tr>
<tr>
<td>Add a Remote Monitor</td>
<td></td>
<td>85</td>
</tr>
<tr>
<td>Modify a Remote Monitor</td>
<td></td>
<td>86</td>
</tr>
<tr>
<td>Delete a Remote Monitor</td>
<td></td>
<td>86</td>
</tr>
<tr>
<td>Device - Camera Links Form</td>
<td>Procedures</td>
<td>87</td>
</tr>
<tr>
<td>Add a Device - Camera Link</td>
<td></td>
<td>88</td>
</tr>
<tr>
<td>Modify a Device - Camera Link</td>
<td></td>
<td>89</td>
</tr>
<tr>
<td>Delete a Device - Camera Link</td>
<td></td>
<td>89</td>
</tr>
<tr>
<td>Alarm-Video Configuration Form</td>
<td>Procedures</td>
<td>90</td>
</tr>
<tr>
<td>Configure Video and Alarms</td>
<td></td>
<td>92</td>
</tr>
<tr>
<td>Video Event Text Form</td>
<td></td>
<td>93</td>
</tr>
<tr>
<td>Archive Server Form</td>
<td></td>
<td>94</td>
</tr>
<tr>
<td>Archive Server Form Procedures</td>
<td></td>
<td>96</td>
</tr>
<tr>
<td>Add an Archive Server</td>
<td></td>
<td>96</td>
</tr>
<tr>
<td>Modify an Archive Server</td>
<td></td>
<td>98</td>
</tr>
<tr>
<td>Delete an Archive Server</td>
<td></td>
<td>98</td>
</tr>
<tr>
<td>Security Form</td>
<td></td>
<td>99</td>
</tr>
<tr>
<td>Security Form Procedures</td>
<td></td>
<td>101</td>
</tr>
<tr>
<td>Change Network Video Password</td>
<td></td>
<td>101</td>
</tr>
<tr>
<td>Video Processing Form</td>
<td></td>
<td>101</td>
</tr>
<tr>
<td>Blind Camera (AI)</td>
<td></td>
<td>103</td>
</tr>
<tr>
<td>Brightness Change</td>
<td></td>
<td>106</td>
</tr>
<tr>
<td>Motion Detection (AI)</td>
<td></td>
<td>107</td>
</tr>
</tbody>
</table>
Open the Video Channel Configuration Dialog ............................................................. 134
Video Channel Configuration Dialog ........................................................................... 135
Video Channel Configuration Dialog Procedures ..................................................... 137
Configure Video Channel Parameters ....................................................................... 137
IntelligentVideo Application Form ............................................................................ 137
IntelligentAudio Events Form ....................................................................................... 139
Audio Level Event ........................................................................................................ 140
IntelligentAudio Events Form Procedures ................................................................... 142
Add IntelligentAudio Event Settings .......................................................................... 142
Modify IntelligentAudio Settings ................................................................................. 143
Delete IntelligentAudio Settings .................................................................................. 143

Chapter 4: Matrix Switcher Folder ........................................................................... 145
Matrix Switcher Overview ............................................................................................... 145
Matrix Switcher Form ......................................................................................................... 145
Matrix Switcher Form Procedures ...................................................................................... 147
Add a Matrix Switcher (Real and Virtual) ................................................................... 147
Modify a Matrix Switcher (Real and Virtual) ................................................................. 148
Delete a Matrix Switcher (Real and Virtual) .................................................................. 148
Matrix Switcher Type Form ............................................................................................... 149
Matrix Switcher Type Form Procedures .......................................................................... 150
Add a Matrix Switcher Type ............................................................................................ 150
Modify a Matrix Switcher Type ....................................................................................... 150
Delete a Matrix Switcher Type ....................................................................................... 150
Custom Command Grammar for Matrix-based Systems ........................................... 151
Custom Command Grammar for Direct PTZ Systems .............................................. 152
Alarm Monitoring ..............................................................157

Chapter 5: Video Monitoring ..................................................159

Video Monitoring Window ......................................................159

Video Monitoring Window Procedures .....................................160

Set up an Alarm Monitoring Station to View Video ......................160

View the Video Tour ..............................................................160

Video Player .............................................................................161

Video Player in Alarm Monitoring ..........................................162

Video Player in VideoViewer ..................................................162

Daylight Saving Time .............................................................165

Performance Dialog ..............................................................165

Video Monitoring Features .....................................................167

Buffering Streaming Video .....................................................167

Browser-based VideoViewer ..................................................167

Camera Lookup ........................................................................168

Two-way Audio .........................................................................168

Video Monitoring Procedures ...............................................170

Launch Video (Live/Recorded) From a Camera ...........................170

Export Video to a File ............................................................171

Load and View a Video File .....................................................171
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monitor Video of a Specific Camera</td>
<td>171</td>
</tr>
<tr>
<td>Switch Camera Views Displayed in Video Player</td>
<td>172</td>
</tr>
<tr>
<td>Monitor Video of Multiple Cameras (Successively)</td>
<td>172</td>
</tr>
<tr>
<td>Capture an Image</td>
<td>173</td>
</tr>
<tr>
<td>Create a Video Event</td>
<td>173</td>
</tr>
<tr>
<td>Automatically Launch both Live and Recorded Video on Alarm</td>
<td>174</td>
</tr>
<tr>
<td>Event Configuration/Search Dialog</td>
<td>175</td>
</tr>
<tr>
<td>Event Configuration/Search Dialog Menu Options</td>
<td>176</td>
</tr>
<tr>
<td>Event Configuration/Search Dialog Fields</td>
<td>178</td>
</tr>
<tr>
<td>Event Configuration/Search Dialog Procedures</td>
<td>180</td>
</tr>
<tr>
<td>Open the Event Configuration/Search Dialog</td>
<td>180</td>
</tr>
<tr>
<td>Configure Event Properties</td>
<td>181</td>
</tr>
<tr>
<td>Set Region of Interest</td>
<td>182</td>
</tr>
<tr>
<td>Video Search Performance Requirements</td>
<td>184</td>
</tr>
<tr>
<td>Search Video/Audio</td>
<td>184</td>
</tr>
<tr>
<td>View Search Results</td>
<td>184</td>
</tr>
<tr>
<td>Video Channel Configuration Dialog</td>
<td>185</td>
</tr>
<tr>
<td>Open the Video Channel Configuration Dialog</td>
<td>186</td>
</tr>
<tr>
<td>Configure Video Channel Parameters</td>
<td>186</td>
</tr>
<tr>
<td>Matrix View</td>
<td>187</td>
</tr>
<tr>
<td>Select Template Dialog</td>
<td>187</td>
</tr>
<tr>
<td>Save Layout Dialog</td>
<td>188</td>
</tr>
<tr>
<td>Load Layout Dialog</td>
<td>189</td>
</tr>
<tr>
<td>Matrix View Procedures</td>
<td>189</td>
</tr>
<tr>
<td>Monitor Video in Matrix View</td>
<td>189</td>
</tr>
<tr>
<td>Create a Matrix Layout</td>
<td>190</td>
</tr>
</tbody>
</table>
Save a Matrix Layout ................................................................. 191
Load a Matrix Layout ................................................................. 191
Pan, Tilt, and Zoom ................................................................. 192
Configure PTZ with LNVR or LNVS Machines ......................... 192
Configure PTZ with all other Digital Video Recorders ............. 192
Using PTZ in the Video Player .................................................. 193
PTZ Options Dialog ................................................................. 194
PTZ Control Adjustment Parameters ....................................... 196
PTZ Joystick Selection ............................................................. 199
Configure PTZ Locking ............................................................ 199
Presets ............................................................................... 199
PTZ Tours ............................................................................ 203
Remote Monitor ....................................................................... 206
LNVR Security ....................................................................... 206
Add Cameras to a Remote Monitor ......................................... 207
Remote Monitor Right-click Options ....................................... 207
Local Monitor Window in Alarm Monitoring ......................... 208
Remote Monitor Application .................................................... 209
Application Profiles ............................................................... 210

Chapter 6: Video Verification .................................................. 215

Video Verification Configuration Dialog ................................... 215

Digital Video Verification ...................................................... 216

Digital Video Verification Window ......................................... 216
Digital Video Verification Procedures .................................... 216

Standard Video Verification .................................................. 217

Standard Video Verification Window ...................................... 217
Table of Contents

Standard Video Verification Procedures ................................................................. 218

Appendices .......................................................................................................... 221

**Appendix A: Exporting Video** ................................................................. 223

- Video Converter Window ................................................................. 224
- Video Export Dialog ................................................................. 225
- Customize Overlay Information Dialog ................................................. 226
- Video Conversion Procedures ............................................................... 227
  - Export Video to a File ................................................................. 227
  - Convert and Export Video ................................................................. 228
  - Play Exported Video Clip Using Windows Media Player ........................................ 229
  - Authenticate a Video File with Watermarking ............................................. 229

**Appendix B: IntelligentAudio** ............................................................. 231

- Audio Level ................................................................. 231
  - Event Properties ................................................................. 231
- High Pitch Sounds ................................................................. 231
  - Event Properties ................................................................. 231
- Impact Sounds ................................................................. 232
  - Event Properties ................................................................. 232
- Unclassified Sounds ................................................................. 232
  - Event Properties ................................................................. 232

Index ...................................................................................................... 233
Chapter 1: Introduction

The following chapters contain information regarding Lenel Digital Video software. This solution delivers advanced data mining and investigative capabilities, whether it is implemented as a standalone digital video management system, or as a seamlessly integrated component.

Using Lenel Digital Video, digital video clips can be linked in real time to alarms associated with them. Cameras can be linked to specific hardware devices to create an association in the database. If an alarm or an event occurs at a given device, the video will be recorded by the associated camera(s). Pre- and post-roll time periods can be configured for every alarm or event in the system. Comprehensive traces, queries and reports can be run to assist in an investigation.

Conventions Used in this Documentation

- Where a term is defined, the word is represented in *italics*.
- Field names, menus, and menu choices are shown in **bold**.
- Keyboard keys are represented in angle brackets. For example: <Tab>, <Ctrl>.
- Keyboard key combinations are written in two ways:
  - `<Ctrl> + <Z>` means hold down the first key and press the second
  - `<Alt>, <C>` means press the first key, then press the second
- Window buttons on the screen are represented in square brackets. For example: [OK], [Cancel].
System Administration
Chapter 2: Digital Video Folder

The Digital Video folder enables you to perform the following procedures:

- Configure video recorders and cameras
- Specify video device configurations
- Link cameras to devices
- Associate video actions with alarms
- Specify video recorder event-based configurations
- Add, modify, or delete an archive server
- Require user authentication for LNVR devices
- Configure standard video processing events (motion detection, blind camera detection, and brightness change)

**Toolbar Shortcut**

The folder contains the following forms: the Video Recorder form, the Camera form, the Camera Inputs form, the Camera Outputs form, the Remote Monitor form, the Device-Camera Links form, the Alarm-Video Configuration form, the Video Event Text form, the Archive Server form, the Security form, the Video Processing form, and the PTZ Tour Server form.

You can display the Digital Video folder by selecting **Digital Video** from the **Video** menu, or by selecting the Digital Video toolbar button.

**Digital Video Recorder Overview**

Lenel Digital Video Recorders include the LDVR-SP, LDVR-SP30, LDVR-408, LDVR-444, LNVR, andLNVS recorders. With the exception of the LNVS, the Lenel Digital Video Recorders support the following features:

- Time-lapse recording mode
  - Records video at a low frame rate when little or no activity is detected
- Event Locking
  - Locks video so that it cannot be deleted during recording
- Real time preview of live video and playback of recorded video from multiple channels
- PTZ control
- Real time recording of all active channels
- Motion detection with selectable sensitivity and area
- Blind camera detection
- Real time export of any video channel (in native format)
- Archiving
• Security
  – Unauthorized access is prevented by Windows security
  – For more information, refer to Chapter 2: Security Form on page 99.

Note: Refer to LNVS on page 23 for LNVS recorder features.

Virtual Matrix Switcher for LDVR and Third Party Recorders

LDVR and third party recorders integrated via the SDK can now be set up using a virtual matrix switcher if no physical matrix switcher is present. For more information, refer to Add a Matrix Switcher (Real and Virtual) on page 147.

Things to note about the virtual matrix switcher:
• Multi-drop (connecting multiple cameras to the same COM port) is supported if the connecting cameras also support it. When using multi-drop, enter the drop-in address instead of the camera channel.
• When adding cameras to the virtual matrix switcher the address of the camera is used for the channel (the address is configured through the camera’s DIP switches.)

For more information refer to the Digital Video Hardware User Guide.

LDVR-SP

The LDVR-SP recorders are a family of board based recorders that record video from analog cameras. The LDVR-SP supports up to 4 boards per unit (per recorder) and up to 32 channels per recorder.

LDVR-SP Recorder Features
• Real time, multi-stream MPEG1 video recording
• 30 fps multiplexed over each board (up to 8 channels)
• PTZ control with matrix switcher
  – Serial connection between matrix switcher and Communication Server.
  – Analog video connection (coaxial cable with BNC connectors) between matrix switcher and LDVR-SP and, between matrix switcher and PTZ camera.
  – In B.A.S.I.S., create a matrix switcher. Link each camera configuration, to a channel number on the matrix switcher (on the Camera form > Communication sub-tab).
• PTZ control with virtual matrix switcher
  – Serial connection between Pelco Spectra Dome III camera and Communication Server, which may or may not be on the LDVR-SP.
  – Analog video connection (coaxial cable with BNC connectors) between Pelco Spectra Dome III camera and LDVR-SP.
• Multi-drop support with virtual matrix switcher
- RS-485 and RS-422 standards support multi-drop. Pelco Spectra Dome III cameras with RS-485 or RS-422 connections can be connected to the same COM port on the Communication Server.
- In B.A.S.I.S., create a virtual matrix switcher. For each camera configuration, enter the drop-in address instead of the channel number (on the Camera form > Communication sub-tab). This address needs to match the address set on the camera via a dip switch.
- RS-232 standards do not support multi-drop; only one camera is supported. The drop-in address for an RS-232 camera connection must be “1”.

- Audio recording
- Dry contacts
- Video export to standard MPEG1 format

LDVR-SP Video Channel Features

- Adjustable MPEG1 compression and frame rate
  - Any one channel can have a maximum of 15 fps
  - Each channel can have a unique frame rate as long as the total fps for all the channels does not exceed 30 fps
- Motion detection and blind camera detection configured on the Camera form > Communication tab.
- Flexible assignment of audio channels

LDVR-SP30

The LDVR-SP30 supports up to 4 boards per unit (recorder), and up to 16 channels per recorder.

LDVR-SP30 Recorder Features

- Real time, multi-stream MPEG1 video recording
- PTZ control with matrix switcher
  - Serial connection between matrix switcher and Communication Server.
  - Analog video connection (coaxial cable with BNC connectors) between matrix switcher and LDVR-SP30 and, between matrix switcher and PTZ camera.
  - In B.A.S.I.S., create a matrix switcher. Link each camera configuration, to a channel number on the matrix switcher (on the Camera form > Communication sub-tab).
- PTZ control with virtual matrix switcher
  - Serial connection between Pelco Spectra Dome III camera and Communication Server, which may or may not be on the LDVR-SP30.
  - Analog video connection (coaxial cable with BNC connectors) between Pelco Spectra Dome III camera and LDVR-SP30.
- Multi-drop support with virtual matrix switcher
  - RS-485 and RS-422 standards support multi-drop. Pelco Spectra Dome III cameras with RS-485 or RS-422 connections can be connected to the same COM port on the Communication Server.
– In B.A.S.I.S., create a virtual matrix switcher. For each camera configuration, enter the drop-in address instead of the channel number (on the Camera form > Communication sub-tab). This address needs to match the address set on the camera via a dip switch.
– RS-232 standards do not support multi-drop; only one camera is supported. The drop-in address for an RS-232 camera connection must be “1”.

• Audio recording
• Dry contacts
• Video export in standard MPEG1 format

**LDVR-SP30 Video Channel Features**

• Adjustment of MPEG1 compression and frame rate
  – Any one channel can have a maximum of 30 fps (25 fps for PAL)
• Motion detection and blind camera detection configured on the Camera form > Communication tab.
• Flexible assignment of audio channels
• Real time viewing of live video or, recorded playback of video for up to 4 active channels
• Archiving is limited to 4 channels if recorded at 30 fps

**LDVR-408**

The LDVR-408 supports 2 boards per unit (recorder), and up to 16 channels per recorder.

**LDVR-408 Recorder Features**

• Real time, multi-stream MPEG4 video recording
• Video resolution that applies to every camera associated with the recorder
  – High resolution 2CIF (640 x 240) or low resolution CIF (320 x 240)
  – High resolution: 45 fps (40 for PAL) multiplexed across an 8-channel board
  – Low resolution: 60 fps (50 for PAL) multiplexed across an 8-channel board
• PTZ control with matrix switcher
  – Serial connection between matrix switcher and Communication Server.
  – Analog video connection (coaxial cable with BNC connectors) between matrix switcher and LDVR-408 and, between matrix switcher and PTZ camera.
  – In B.A.S.I.S., create a matrix switcher. Link each camera configuration, to a channel number on the matrix switcher (on the Camera form > Communication sub-tab).
• PTZ control with *virtual* matrix switcher
  – Serial connection between Pelco Spectra Dome III camera and Communication Server, which may or may not be on the LDVR-408.
  – Analog video connection (coaxial cable with BNC connectors) between Pelco Spectra Dome III camera and LDVR-408.
• Multi-drop support with virtual matrix switcher
  – RS-485 and RS-422 standards support multi-drop. Pelco Spectra Dome III cameras with RS-485 or RS-422 connections can be connected to the same COM port on the Communication Server.
  – In B.A.S.I.S., create a virtual matrix switcher. For each camera configuration, enter the drop-in address instead of the channel number (on the Camera form > Communication sub-tab). This address needs to match the address set on the camera via a dip switch.
  – RS-232 standards do not support multi-drop; only one camera is supported. The drop-in address for an RS-232 camera connection must be “1”.

• Audio recording
• Dry contacts

**LDVR-408 Video Channel Features**

• Adjustment of MPEG4 compression and frame rate
  – Any one channel can have a maximum of 7.5 fps while recording at low resolutions
  – Any one channel can have a maximum of 3.75 fps while recording at high resolutions

• Motion detection and blind camera detection configured on the Camera form > Communication tab.

• Real time recording of up 16 active channels
• Flexible assignment of audio channels

**LDVR-444**

The LDVR-444 supports up to 4 boards per unit (recorder), and up to 16 channels per recorder.

**LDVR-444 Recorder Features**

• Real time, multi-stream MPEG4 video recording

• Video resolution that applies to every camera associated with the recorder
  – D1 (720 x 480)
  – 4CIF (640 x 480)
  – CIF (320 x 240)

• PTZ control with matrix switcher
  – Serial connection between matrix switcher and Communication Server.
  – Analog video connection (coaxial cable with BNC connectors) between matrix switcher and LDVR-444 and, between matrix switcher and PTZ camera.
  – In B.A.S.I.S., create a matrix switcher. Link each camera configuration, to a channel number on the matrix switcher (on the Camera form > Communication sub-tab).

• PTZ control with virtual matrix switcher
  – Serial connection between Pelco Spectra Dome III camera and Communication Server, which may or may not be on the LDVR-444.

*MPEG4 has a better compression ratio, clearer images, more storage space and less network bandwidth than MPEG1.*
– Analog video connection (coaxial cable with BNC connectors) between Pelco Spectra Dome III camera and LDVR-444.

• Multi-drop support with virtual matrix switcher
  – RS-485 and RS-422 standards support multi-drop. Pelco Spectra Dome III cameras with RS-485 or RS-422 connections can be connected to the same COM port on the Communication Server.
  – In B.A.S.I.S., create a virtual matrix switcher. For each camera configuration, enter the drop-in address instead of the channel number (on the Camera form > Communication sub-tab). This address needs to match the address set on the camera via a dip switch.
  – RS-232 standards do not support multi-drop; only one camera is supported. The drop-in address for an RS-232 camera connection must be “1”.

• Audio recording
• Dry contacts
• Video export in standard MPEG4 format

**LDVR- 444 Video Channel Features**

• Adjustment of MPEG4 compression and frame rate
  – Any one channel can have a maximum of 30 fps (25 fps for PAL)
• Motion detection and blind camera detection configured on the Camera form > Communication tab.
• Flexible assignment of audio channels
• Real time viewing of live video or recorded playback of video for up to 4 active channels
• Archiving is limited to 4 channels if recorded at 30 fps

**LNVR**

The LNVR provides network recording for up to 63 IP cameras.

[https://customer.lenel.com/?q=var/video-tools](https://customer.lenel.com/?q=var/video-tools)

There are no boards inside the recorder.

**LNVR Recorder Features**

• Real time, multi-stream MJPEG and MPEG4 video recording
• Security: unauthorized access is prevented by B.A.S.I.S.
• Video export to standard ASF and proprietary format (.LNR) files

**LNVR Video Channel Features**

• Multiple video resolutions based on camera capabilities
• Adjustable image quality and frame rate
  – Maximum frame rate of 30 fps per channel
• Event based video recording
– Triggered by any IntelligentVideo alarm or by any event configured on the Alarm -Video Configuration form

• IntelligentVideo image processing
• Motion detection and blind camera detection configured on the Video Processing form
• Supports surveillance-only mode
• PTZ support for the following configurations:
  – Pan-Tilt-Zoom (PTZ) IP cameras
  – Pan-Tilt (PT) IP cameras
  – Zoom (Z) cameras
  – IP cameras with ability to control PTZ housing
  – Video Servers with ability to control PTZ housing
  – For more information, refer to the Digital Video Hardware User Guide.

• Failover recorder creates a virtual channel for a camera
• Signal loss detection on Axis video servers
  – Note that for Axis 2400 and 2400+ servers, up to 4 analog cameras can be configured. Therefore, video signal loss and restored events should be tied to a specific channel (on the Alarm Definitions form).

LNVS

The LNVS provides network surveillance using up to 32,767 cameras per recorder. Network surveillance enables you to view live video only; video cannot be recorded or archived. LNVS supports the following IP cameras: Axis 2100, 2120 (NTSC and PAL), 2130 PTZ (NTSC and PAL), 2400 (NTSC and PAL), 2401 (NTSC and PAL), 2420 (NTSC and PAL), Sony SNC-RZ30 PTZ (NTSC and PAL), and the Sony SNC-VLP10P (NTSC and PAL) cameras.

All that is needed is for network surveillance is an IP camera and B.A.S.I.S. software. No recorder hardware is required.

LNVS Video Channel Features

• Real time, multi-stream MJPEG video recording
• Multiple video resolutions that depend on the camera’s capabilities
• Adjustable image quality and frame rate
  – Maximum frame rate of 30 fps per channel
• Only supports surveillance mode
• Motion detection for specific cameras configured on the Camera form > Communication tab.
• Full PTZ support with housing unit
• Signal loss detection on Axis video servers
  – Note that for Axis 2400 and 2400+ servers, up to 4 analog cameras can be configured. Therefore, video signal loss and restored events should be tied to a specific channel (on the Alarm Definitions form).
Features

Time-Lapse Recording

Time-lapse mode slows the rate at which video is recorded. Motion detection can be used to trigger recording at the normal (non-time-lapse) rate when activity occurs. The primary motivation of this feature is to save storage space on the video recorder.

LDVR cameras have a built-in motion detection mechanism which is used in conjunction with time-lapse to trigger the normal recording rate. This motion detection feature is always on, but may need additional configuration to filter out excess motion. For more information, refer to Configure Time-Lapse Recording for LDVR Cameras on page 78.

Time-lapse recording mode can be triggered into event recording mode by a wide variety of events with LNVR cameras. LNVR cameras do not have an automatic motion detection mechanism, and require additional configuration to trigger event mode recording. Many different combinations of device-camera links and alarm-video configurations can be used. Some examples of events that can be configured to trigger event recording include: door forced open alarms, input alarms, and video events. For more information, refer to Configure Time-Lapse Recording with Motion Detection for LNVR Cameras on page 79.

Integration with Storage Calculator

Camera information can be exchanged between System Administration and the Storage Calculator application. This enables a more accurate prediction of system resource usage and the easy addition of new cameras to the system.

The System Administration export includes the data on the Capacity sub-tab of the Camera form to provide statistics for your network to the Storage Calculator for estimating the bandwidth and storage needs for new cameras. To export the camera configuration for an LNVR, right-click the video recorder and select Export. This file can then be imported into the Storage Calculator application.

System Administration can also import cameras using the IP Camera Wizard to add cameras that have had their initial configuration calculated in the Storage Calculator. For more information, refer to Import IP Cameras from the Storage Calculator on page 41.

Note: Statistics may differ for the same camera between System Administration and the Storage Calculator. The camera information available in System Administration is based on the actual usage on your system and can vary depending on network traffic, activity level in the scene, etc.

For more information about import and export within the Storage Calculator, refer to the help available from within the Storage Calculator application.
# Video Recorder Form

## Video Recorder Form - Common Form Elements

<table>
<thead>
<tr>
<th>Form Element</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Listing window</td>
<td>Lists currently defined video recorders, the workstation they are connected to, and the segment that each recorder belongs to (if segmentation enabled).</td>
</tr>
<tr>
<td>Name</td>
<td>A descriptive name for the video recorder. This should be a “friendly” name assigned to video recorder making it easy to identify. Each name must be unique and contain no more than 32 characters.</td>
</tr>
<tr>
<td>Online</td>
<td>If selected, the video recorder will be online and the Communication Server will attempt to communicate with it.</td>
</tr>
<tr>
<td>Video Recorder Type</td>
<td>Specifies the type of video recorder.</td>
</tr>
<tr>
<td>Detect</td>
<td>Connects to the video recorder to determine the video recorder type.</td>
</tr>
<tr>
<td>Update Capabilities</td>
<td>Connects to the video recorder and obtains a list of camera capabilities for the firmware version currently installed.</td>
</tr>
<tr>
<td>Add</td>
<td>Create a new video recorder entry.</td>
</tr>
<tr>
<td>Modify</td>
<td>Enables changes to be made to the selected video recorder entry.</td>
</tr>
<tr>
<td>Delete</td>
<td>Removes the selected video recorder entry.</td>
</tr>
<tr>
<td>Help</td>
<td>Displays online help for this topic.</td>
</tr>
<tr>
<td>Close</td>
<td>Closes the Digital Video folder.</td>
</tr>
</tbody>
</table>
Video Recorder Form (Connection Sub-tab)

The following Connection sub-tab displays for Generic Video, LDVR-SP, LDVR-SP30, LDVR-408, LDVR-444, and Loronix recorders.

The following Connection sub-tab displays for LNVR recorders.
The following Connection sub-tab displays for LNVS recorders.

![Digital Video Form with Connection Tab]

**LNVR Security and Passwords**

When you install LNVR firmware, you have an opportunity to set the LNVR access level. There are two access level options; “LNVUsers” or “Everyone”. The “LNVUsers” is a local user group created during LNVR installation. You can add members to the “LNVUsers” group during the installation or afterwards by clicking Start, then **Programs > Lenel Network Recorder** and running the LNVR Setup. For more information, refer to “Install the LNVR Firmware” in the Digital Video Hardware User Guide.

In addition to setting access levels, you have an option to set a specific Windows account to be used by B.A.S.I.S. to connect to the LNVR. To do this, enter the account’s user credentials (user name and password) on the Connection sub-tab of the Video Recorder form. Alternatively, you can make B.A.S.I.S. use the current interactive user Windows account by leaving the username and password fields blank.

---

**Note:** These credentials will be ignored when B.A.S.I.S. applications or services are running on the same machine as LNVR. Instead the account used by the B.A.S.I.S. application or service running will be used for authentication. The following accounts have access to LNVR: Members of the LNVUsers group, local system account, and accounts which have LNVR services configured to run.

There are two benefits of using the “LNVUsers” group and a specific Windows account combination:

- The specific Windows account is the only one that needs to be added to “LNVUsers” group as compared to adding an interactive user Windows account for every B.A.S.I.S. user.
- Data transferred between LNVR and B.A.S.I.S. is encrypted.
**Video Recorder Form - Connection Sub-tab**

<table>
<thead>
<tr>
<th>Form Element</th>
<th>Comment</th>
</tr>
</thead>
</table>
| Workstation                   | The workstation the video recorder connects to. The Communication Server should run on the workstation you select. This workstation will be referred to as the “B.A.S.I.S. server.”  
**Note:** The workstation name must be the workstation’s NetBIOS name. (The NetBIOS name is specified when Windows networking is installed/configured.) |
| Browse                        | Opens a Browse for Computer window, from which you can select a workstation.                                                        |
| Use IP Address of Video Recorder | Select this radio button if you want to use the IP address of the video recorder.                                                |
| Use Computer Name of Video Recorder | Select this button if you want to use the computer name of the video recorder.                                                     |
| Browse                        | Opens a Browse for Computer window, from which you can select the name of a computer.                                                |
| User Name and Password        | The user name and password for the specific Windows account used by B.A.S.I.S. to connect with the specified video recorder.  
If you leave these fields blank, B.A.S.I.S. will use the interactive user Windows account. For more information, refer to LNVR Security and Passwords on page 27. |
| World Time Zone               | The world time zone for the selected video recorder’s geographical location. The selections in the drop-down are listed sequentially and each include:  
• The world time zone’s clock time relative to Greenwich Mean Time. For example, (GMT+05:00) indicates that the clock time in the selected world time zone is 5 hours ahead of the clock time in Greenwich, England.  
• The name of the countries or cities located in that world time zone. |
| Daylight Savings              | Select this check box if you want to properly convert between various time formats for daylight savings.                             |
| Allow direct connect to cameras | Enables a direct connection to IP cameras for live video display if the LNVR is offline.                                        |
**Video Recorder Form (Recording Sub-tab)**

**Note:** The Recording sub-tab does not display for the LNVR, LNVS, Generic Video, or Loronix recorder.

The following Recording sub-tab displays for LDVR-SP, LDVR-SP30, LDVR-408, LDVR-444 recorders. Note that the **Video Resolution** drop-down does **not** display for the LDVR-SP or LDVR-SP30 recorder.
Video Recorder Form - Recording Sub-tab

### Video Recorder Form - Recording Sub-tab

<table>
<thead>
<tr>
<th>Form Element</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Video Standard</td>
<td>Select a video standard.</td>
</tr>
<tr>
<td>Video Resolution</td>
<td>The resolution every camera associated with the specified video recorder. This field only applies to LDVR-408 and LDVR-444 recorders.</td>
</tr>
<tr>
<td>Enable Time-Lapse Recording</td>
<td>Select this check box if you want the frame rate for the selected video recorder to be lower when no motion is detected. The lower frame rate is called the Non-Motion Frame Rate.</td>
</tr>
<tr>
<td></td>
<td>Time-lapse recording must also be enabled for the camera, on the Record Settings sub-tab of the Camera form.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Motion Detection is always on for cameras configured with LDVR-SP, LDVR-SP30, LDVR-408, or LDVR-444 video recorders. Whenever motion is detected, the camera will switch to continuous recording mode.</td>
</tr>
<tr>
<td>Non-Motion Frame Rate</td>
<td>The frame rate video is recorded at, when no motion is detected. This option is used only when time-lapse recording is enabled for the particular camera.</td>
</tr>
<tr>
<td>Time-Lapse Pre-Roll</td>
<td>The number of seconds you want to cache video prior to the instant motion is detected. This option is used only when time-lapse recording is enabled for the particular camera.</td>
</tr>
<tr>
<td></td>
<td>Pre-roll video is recorded at the full frame rate.</td>
</tr>
</tbody>
</table>
Video Recorder Form (Archiving/Purging Sub-tab)

Note: The Archiving/Purging sub-tab does not display for generic video, Loronix, or LNVS recorders.

Video events are created when a video alarm occurs or when a device with a camera link generates an alarm. These alarms can be configured to lock the video associated with them so that the video is not overwritten on the recorder.

Recording video creates numerous large files. To keep enough drive space free for new video files, you must either purge the locked video files or archive the files. Purging means that after a specified period of time (or specified amount of disk space remains), the old video files are deleted. If you are purging the files, the Archive Server service can be run on any computer on the network. When purging, it is common to run the Archive Server service on the same computer that the Communication Server is run on.

Archiving means that the most recent files are kept on the video recorder (generally just a few days), while older files are stored on tape. B.A.S.I.S. uses Remote Storage Solution, an application that comes with Windows Server 2003, to migrate the video files from disk to tape.

Note: This is not a backup solution, it is a storage solution. You must make a copy of the tape to have a backup!

The following Archiving/Purging sub-tab displays for LDVR-SP, LDVR-SP30, LDVR-408, LDVR-444, and LNVR recorders.
## Video Recorder Form - Archiving/Purging Sub-tab

<table>
<thead>
<tr>
<th>Form Element</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Archive Server</td>
<td>Lists all archive servers in the database that are appropriate for the recorder’s segment. Archive server options are created on the Archive Server form in the Digital Video folder. For more information, refer to Add an Archive Server on page 96. The selected archive server archives and purges video from the recorder. If this field is blank, archiving does not occur for the video recorder.</td>
</tr>
<tr>
<td>Archiving Timezone</td>
<td>A specific time to archive video. For example, many people avoid archiving during business hours and instead archive during the night. This field lists all timezones in the database. Choices include:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Always</strong> - This is the standard way archiving is done. If selected, the archive server archives video from the recorder as soon as the recorder has one block of video.</td>
</tr>
<tr>
<td></td>
<td>• The duration of the video block is configurable on the archive server, and is one hour by default.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Never</strong> - If selected, archiving from the recorder does not occur.</td>
</tr>
<tr>
<td></td>
<td>• <strong>User-defined timezones</strong> - If a specific timezone is selected, the archive server archives new video during the selected timezone. It continues archiving until all the video from the recorder is archived. Archiving resumes when it is in that timezone again (provided the recorder has enough video to archive). Note: Timezones are added on the Timezones form, which opens when you select the Access Control &gt; Timezones menu option and click the Timezones tab.</td>
</tr>
<tr>
<td>Enable Continuous Archiving</td>
<td>Select this check box if you want video continually archived, 24 hours a day. The cameras must also be configured for continuous archiving.</td>
</tr>
<tr>
<td>Delay archiving until video buffer is less than ____%</td>
<td>If selected, the archive server delays archiving until the video buffer (the amount of video on the recorder) is less than the specified amount. The recommended buffer size is 30%. The buffer decreases when the oldest video on the recorder is overwritten and increases when the archive server archives video blocks and therefore moves the archiving point forward. This option is commonly used when the storage on the archive server is not much larger than the storage on the video recorders. Without this option enabled, most of the video would be duplicated on the video recorders and the archive server. With this option enabled, only parts of the oldest video on the recorder are duplicated.</td>
</tr>
<tr>
<td>Automatically Archive Video Events</td>
<td>Select this check box if you want video events to be automatically archived off the video recorder. Note: Event archiving is supported for LDVR-408, LDVR-444, LDVR-SP, LDVR-SP30, and LNVR recorders.</td>
</tr>
<tr>
<td>Automatically Purge Video Events</td>
<td>Select this check box if you want video events to be automatically purged from the video recorder.</td>
</tr>
<tr>
<td>Threshold for Automated Archiving</td>
<td>The percent of video recorder disk space to use for video events, before automatic archiving or purging begins.</td>
</tr>
</tbody>
</table>
Video Recorder Form - Archiving/Purging Sub-tab (Continued)

<table>
<thead>
<tr>
<th>Form Element</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Space to Automatically Free</td>
<td>The percent of video recorder disk space that should be freed up before archiving or purging stops.</td>
</tr>
</tbody>
</table>

**Video Recorder Form (Capacity Sub-tab)**

![Digital Video Software User Guide](image)

**Video Recorder Form - Capacity Sub-tab**

<table>
<thead>
<tr>
<th>Form Element</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Update</td>
<td>Connects to the video recorder to retrieve the current storage statistics.</td>
</tr>
<tr>
<td>Recorder capacity</td>
<td>Displays the amount of storage available on the recorder. This value does not include the amount of space left free as configured in the LNVR Storage configuration.</td>
</tr>
<tr>
<td>Overall</td>
<td>Displays the total average recording bit rate in Mbps. According to this rate, the recorder should be able to store the number of days worth of video listed in the Capacity (days) column.</td>
</tr>
<tr>
<td>Last minute</td>
<td>Displays the average recording bit rate in Mbps for the last minute. According to this rate, the recorder should be able to store the number of days worth of video listed in the Capacity (days) column.</td>
</tr>
<tr>
<td>Last hour</td>
<td>Displays the average recording bit rate in Mbps for the last hour. According to this rate, the recorder should be able to store the number of days worth of video listed in the Capacity (days) column.</td>
</tr>
</tbody>
</table>
Video Recorder Form - Capacity Sub-tab (Continued)

<table>
<thead>
<tr>
<th>Form Element</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Last day</td>
<td>Displays the average recording bit rate in Mbps for the last day. According to this rate, the</td>
</tr>
<tr>
<td></td>
<td>recorder should be able to store the number of days worth of video listed in the Capacity (days)</td>
</tr>
<tr>
<td></td>
<td>column.</td>
</tr>
<tr>
<td>Send alarm if Unable to keep</td>
<td>Select the check box to generate an alarm if the capacity (days) falls below a specific value.</td>
</tr>
<tr>
<td>Automatically delete video older</td>
<td>Select this check box to limit the number of days that video is stored on the recorder. Locked</td>
</tr>
<tr>
<td>than</td>
<td>and unlocked video older than the specified number of days will be automatically deleted twice</td>
</tr>
<tr>
<td></td>
<td>each day. The value can be in the range of 1 to 3650 days.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Locked video that has not been archived will be deleted after the specified number</td>
</tr>
<tr>
<td></td>
<td>of days. Activation of this feature will not delete archived video located on the archive server.</td>
</tr>
</tbody>
</table>

Video Recorder Form (Performance Sub-tab)

Video Recorder Form - Performance Sub-tab

<table>
<thead>
<tr>
<th>Form Element</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Update</td>
<td>Connects to the video recorder to retrieve the current storage statistics.</td>
</tr>
<tr>
<td>CPU</td>
<td>Displays the percent utilization of the CPU for the last minute. To generate an alarm if the</td>
</tr>
<tr>
<td></td>
<td>percentage reaches a certain level, select the timezone in the Send Alarm column, and set the</td>
</tr>
<tr>
<td></td>
<td>level in the Threshold (%) column.</td>
</tr>
</tbody>
</table>
Video Recorder Form - Performance Sub-tab (Continued)

<table>
<thead>
<tr>
<th>Form Element</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network</td>
<td>Displays the percent utilization of the network for the last minute. To generate an alarm if the percentage reaches a certain level, select the timezone in the Send Alarm column, and set the level in the Threshold (%) column.</td>
</tr>
<tr>
<td>Disk Read</td>
<td>Displays the percent utilization of the disk read for the last minute. To generate an alarm if the percentage reaches a certain level, select the timezone in the Send Alarm column, and set the level in the Threshold (%) column.</td>
</tr>
<tr>
<td>Disk Write</td>
<td>Displays the percent utilization of the disk write for the last minute. To generate an alarm if the percentage reaches a certain level, select the timezone in the Send Alarm column, and set the level in the Threshold (%) column.</td>
</tr>
</tbody>
</table>

**Video Recorder Form Procedures**

Refer to the Video Recorder sub-tab tables if you have questions on fields or how to populate them.
Add LNVR Video Recorders

1. From the Video menu, select Digital Video.
2. The Digital Video folder opens. Click [Add].
3. If segmentation is not enabled, skip this step. If segmentation is enabled:
   a. The Segment Membership window opens. Select the segment that this video recorder is assigned to.
   b. Click [OK].
4. In the Name field, enter a unique, descriptive name for the video recorder.
5. Select “LNVR” from the drop-down.
6. On the Connection sub-tab:
   a. Enter the workstation the video recorder connects to. If configuring LNVR for failover, you must be connected to the same Communication Server as the primary LNR.
   b. Do one of the following:
      • Select the Use IP Address of Video Recorder radio button and enter an IP address.
      • Select the Use Computer Name of Video Recorder radio button and enter the computer’s name.
   c. Enter the user name and password if desired. For more information, refer to LNVR Security and Passwords on page 27.
   d. Click [Detect] to connect to the LNVR and verify the recorder type.
   e. Select the world time zone for the selected video recorder’s geographical location.
   f. Select the Daylight Savings check box if you want to properly convert between various time formats for daylight savings.
   g. If desired, select the Automatically delete video older than check box and enter the number of days after which locked and unlocked video should be deleted.
7. On the Archiving/Purging sub-tab:
   a. Select an archive server and a timezone to archive. If you do not want to archive video from the video server, leave the Archive Server field blank and continue to step 8.
   b. Select the Enable Continuous Archiving check box if you want video to be continually archived, 24 hours a day. Each camera must also be configured to archive continuously.
   c. Select the Delay archiving until video buffer is less than ___% check box if you want the archive server to delay archiving until the video buffer is less than the specified amount. The recommended buffer size is 30%.
   d. Select the Automatically Archive Video Events check box if you want video events to be automatically archived or the Automatically Purge
**Video Events** check box if you want video events to be automatically purged from the video recorder.

e. In the **Threshold for Automated Archiving** spin box, choose the percentage of video recorder disk space to be used by video events before automatic archiving begins.

f. Select In the **Space to Automatically Free** spin box, choose the percentage of disk space that should be freed up before the archiving or purging should stop.

8. Click [OK].

9. The Monitor Zone Assignments dialog is displayed. Select the monitor zone(s) you wish to assign the video recorder to and click [OK].

10. Click [Update Capabilities] to obtain an update of camera capabilities from the LNVR for the currently installed firmware. This information is stored in the database and enables you to configure cameras even if the LNVR is offline.

---

**Note:** Before you use this video recorder, download your settings. To do this, right-click the video recorder in the video recorder listing window and select “Download”. Downloading is highly recommended even if the recorder appears to be in working order because it prevents the loss of configuration parameters.

---

**Add LNVR Failover Video Recorders**

B.A.S.I.S. supports failover recorders (secondary recorders) for IP cameras. Failover recorders record and process video only when the primary recorder is offline.

When the primary recorder goes offline, an alarm is generated and the failover recorder begins recording video. Users can view live video from the time the alarm was generated on the failover recorder. The failover recorder uses the same workstation and IntelligentVideo algorithms and channel parameters as the primary recorder. When the primary recorder comes back online, a restored alarm is generated, the primary recorder connects to the IP camera and resumes recording. When both the recorders are online, users can view uninterrupted recorded video.

---

**Notes:** Alarm Monitoring users should log out and log back in to the application when changes are made to the configuration of a failover recorder. It is recommended to have the same version of firmware on the primary and failover recorders.

---

Failover recorders are configured on a per-channel basis. Each channel on the primary recorder may be assigned a different failover recorder. To add an LNVR failover video recorder, complete the **Add LNVR Video Recorders** on page 36. Be sure to mark the failover recorder online and connect it to the Communication Server the primary LNVR connects to.
Add LNVS Video Recorders

1. From the Video menu, select Digital Video.
2. The Digital Video folder opens. Click [Add].
3. If segmentation is not enabled, skip this step. If segmentation is enabled:
   a. The Segment Membership window opens. Select the segment that this video recorder is assigned to.
   b. Click [OK].
4. In the Name field, enter a unique, descriptive name for the video recorder.
5. Select “LNVS” from the drop-down.
6. On the Connection sub-tab:
   a. Enter the workstation the video recorder connects to.
   b. Select the world time zone for the selected video recorder’s geographical location.
   c. Select the Daylight Savings check box if you want to properly convert between various time formats for daylight savings.
7. Click [OK].
8. The Monitor Zone Assignments dialog is displayed. Select the monitor zone(s) you wish to assign the video recorder to and click [OK].

Notes: Before you use this video recorder, download your settings. To do this, right-click the video recorder in the video recorder listing window and select “Download”.

Downloading is highly recommended even if the recorder appears to be in working order because it prevents the loss of configuration parameters.
Add Video Recorders Other Than LNVR/LNVS Recorders

The following procedure applies to all other digital video recorders (*except* an LNVR or LNVS).

1. From the *Video* menu, select *Digital Video*.
2. The Digital Video folder opens. Click [Add].
3. If segmentation is not enabled, skip this step. If segmentation is enabled:
   a. The Segment Membership window opens. Select the segment that this video recorder is assigned to.
   b. Click [OK].
4. In the *Name* field, type a unique, descriptive name for the video recorder.
5. Select a video recorder type from the drop-down.
6. On the Connection sub-tab:
   a. Enter the workstation the video recorder connects to.
   b. Do one of the following:
      • Select the *Use IP Address of Video Recorder* radio button and enter an IP address.
      • Select the *Use Computer Name of Video Recorder* radio button and enter the computer’s name.
   c. Click [Detect] to connect to the video recorder to verify the recorder type.
   d. Select the world time zone for the selected video recorder’s geographical location.
   e. Select the *Daylight Savings* check box if you want to properly convert between various time formats for daylight savings.
7. On the Recording sub-tab:
   a. Select a video standard from the drop-down.
   b. For LDVR-408 and LDVR-444 recorders, select a video resolution from the drop-down.
8. On the Archiving/Purging sub-tab:
   a. Select an archive server and the timezone to archive, or leave the *Archive Server* field blank, if you do not want to archive video from the video recorder.
   b. For LDVR-SP recorders:
1) Select the **Enable Continuous Archiving** check box if you want video to be continually archived, 24 hours a day. Each camera must also be configured to archive continuously.

2) Select the **Delay archiving until video buffer is less than ____%** check box if you want the archive server to delay archiving until the video buffer is less than the specified amount. The recommended buffer size is 30%.

c. For LDVR-SP, LDVR-SP30, LDVR-408, and LDVR-444 recorders:

1) Select the **Automatically Archive Video Events** check box if you want video events to be automatically archived or the **Automatically Purge Video Events** check box if you want video events to be automatically purged from the video recorder.

2) For the **Threshold for Automated Archiving** spin buttons, choose the percentage of the video recorder disk space to be used by video events before automatic archiving begins.

3) For the **Space to Automatically Free** spin buttons, choose the amount of disk space that should be freed up before the archiving or purging should stop.

9. Click [OK].

10. The Monitor Zone Assignments dialog is displayed. Select the monitor zone(s) you wish to assign the video recorder to and click [OK].

---

**Notes:**

Before you use this video recorder, download your settings. To do this, right-click the video recorder in the video recorder listing window and select “Download”.

Downloading is highly recommended even if the recorder appears to be in working order because it prevents the loss of configuration parameters.

---

**Use the Video Recorder Form Right-Click Menu**

When the Video Recorder form is not in add or modify mode, you can right-click any recorder to display the following menu options:

<table>
<thead>
<tr>
<th>Choose this option</th>
<th>To do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add</td>
<td>Create a new video recorder entry.</td>
</tr>
<tr>
<td>Modify</td>
<td>Enable changes to be made to the selected video recorder entry.</td>
</tr>
<tr>
<td>Delete</td>
<td>Delete the selected video recorder entry.</td>
</tr>
<tr>
<td>Copy</td>
<td>Copy the selected video recorder entry.</td>
</tr>
<tr>
<td>Export</td>
<td>Export the LNVR cameras to an XML file for import into the Storage Calculator application.</td>
</tr>
<tr>
<td>Import</td>
<td>Use the IP Camera Wizard to import cameras from a file to the LNVR.</td>
</tr>
<tr>
<td>Select Item</td>
<td>Select a video recorder entry.</td>
</tr>
</tbody>
</table>
Import IP Cameras from the Storage Calculator

1. From the Video menu, select Digital Video.
2. The Digital Video folder opens. On the Video Recorder form, right-click the LNVR recorder you wish to add the cameras to and select Import.
3. Browse for the configuration file (.xml). Select it and click [Open].
4. The IPCamera Wizard is displayed with a list including each of the cameras configured in the file. Change the Name, Input, IP Address, User Name, Password, Number of cameras and Online status as desired by clicking on the field in the listing window.
5. Select (place a check mark beside) each camera that you wish to add to the LNVR.
6. Click [Add] to add the selected cameras.

Add Multiple LDVR Cameras

Multiple LDVR cameras can be added simultaneously using the Camera Wizard from the Video Recorder form.

1. From the Video menu, select Digital Video.
3. The Camera Wizard is displayed. The Unassigned window displays all available camera channels that have not yet been configured in the system.
Select cameras from the Unassigned window with the mouse or by clicking the [Select All] button.

4. Click the [<-->] arrow to add the selected unassigned cameras to the system and move them to the Assigned window. Cameras are named in the format Recorder name - Channel number.

Note: The Camera Wizard can be used to change the assigned name of a single selected camera by renaming it in the Name field and clicking [Modify].

5. When finished adding cameras, close the window.

**Camera Form**

**Analog Cameras**

Analog cameras are video cameras that require a video capture card to convert video to a digital signal, and require a PC to connect to the network.

**IP Cameras**

IP cameras are digital video cameras that connect directly to the network with their own IP address. IP cameras have the ability to transmit images using standard communication protocols such as TCP/IP. These cameras do not need to be connected to a PC or a video capture card. More advanced IP cameras may provide additional functionality such as a built-in web server, motion detection, alarm inputs/outputs, and e-mail and FTP support. IP cameras have a secure mode which can be enabled via the camera web page. With most cameras, this mode can be activated by changing the password for the root account and adding an additional account.
## Camera Form - Common Form Elements

<table>
<thead>
<tr>
<th>Form Element</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Listing window</td>
<td>Lists currently defined cameras.</td>
</tr>
<tr>
<td>Name</td>
<td>A descriptive name for the camera. This is a “friendly” name assigned to each camera to make it easy to identify. Each name must be unique and contain no more than 32 characters.</td>
</tr>
<tr>
<td>Online</td>
<td>For cameras configured with LNVR and LDVR only. Select this check box to place the camera online. If you need to perform maintenance or replace a camera, deselect this check box. When the <strong>Online</strong> check box is deselected:</td>
</tr>
<tr>
<td></td>
<td>• Video recorder stops recording and stops processing images for the specified camera</td>
</tr>
<tr>
<td></td>
<td>• Any requests to connect to the specified camera will receive an offline status</td>
</tr>
<tr>
<td></td>
<td>• Any requests for live video are denied</td>
</tr>
<tr>
<td></td>
<td>• If a failover recorder is configured, it will not record video for the specified camera</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The ability to place a camera offline will be based on user privileges, and for LNVR, username and password.</td>
</tr>
<tr>
<td>Recorder</td>
<td>The video recorder that this camera communicates with.</td>
</tr>
<tr>
<td>Failover Recorder</td>
<td>A failover/secondary LNVR recorder. For the selected channel, the failover recorder creates a virtual channel with the same settings as the original/primary recorder. If the original recorder is offline for a specific amount of time, an alarm is generated and the failover recorder begins recording video. When the primary recorder comes back online, it connects to the IP camera and resumes recording.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The primary and failover recorders must share the same communication server. Only recorders that have the same communication server as the primary will appear in the <strong>Failover Recorder</strong> drop-down.</td>
</tr>
<tr>
<td></td>
<td>For more information, refer to Add LNVR Failover Video Recorders on page 37.</td>
</tr>
<tr>
<td>Video Preview</td>
<td>Displays video from the camera for configuration purposes when the <strong>Display Video</strong> check box is selected.</td>
</tr>
<tr>
<td>Display Video</td>
<td>Select this check box to enable a preview of the camera video.</td>
</tr>
<tr>
<td>Add</td>
<td>Create a new camera entry.</td>
</tr>
<tr>
<td>Modify</td>
<td>Enables changes to be made to the selected camera entry.</td>
</tr>
<tr>
<td>Delete</td>
<td>Removes the selected camera entry.</td>
</tr>
<tr>
<td>Apply</td>
<td>Modifies the selected camera entry without exiting Modify mode.</td>
</tr>
<tr>
<td>Help</td>
<td>Displays online help for this topic.</td>
</tr>
<tr>
<td>Multiple Selection</td>
<td>Select this check box to select multiple entries in the listing window.</td>
</tr>
<tr>
<td>Close</td>
<td>Closes the Digital Video folder.</td>
</tr>
</tbody>
</table>
Camera Form (Communication Sub-tab)

The following Communication sub-tab displays if you configure a camera with an LDVR-SP, LDVR-SP30, LDVR-408, or LDVR-444 recorder. Note that the Generate Blind Camera Alarms drop-down does not display for the LDVR-408 recorder and the Archive Continuous Video drop-down does not display for the LDVR-SP30, LDVR-408, or LDVR-444 recorder.

The following Communication sub-tab displays if you configure a camera with a Generic Video or Loronix recorder.
## Camera Form - Communication Sub-tab

<table>
<thead>
<tr>
<th>Form Element</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Archive Continuous Video</td>
<td>Select the timezone in which video will be continuously archived for this camera. Video will only be archived during the selected timezone. The selected camera’s video recorder must also be configured for continuous archiving.</td>
</tr>
<tr>
<td>Camera ID</td>
<td>An ID number for this camera.</td>
</tr>
<tr>
<td>Camera Type</td>
<td>If you are working with an LNVR or LNVS video recorder, select a camera type. Choices include camera types that the selected video recorder supports.</td>
</tr>
<tr>
<td>Channel</td>
<td>The input channel number the camera connects to. Each camera must have its own unique channel.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> LNVR and LNVS recorders automatically assign the channel number, while other video recorders require user input.</td>
</tr>
<tr>
<td>Display Motion Detection Alarms</td>
<td>Select this check box if you want an alarm displayed in Alarm Monitoring when the camera detects motion.</td>
</tr>
<tr>
<td>Generate Motion Detection Alarms</td>
<td>Select a timezone from the drop-down if you want the camera to generate an alarm when motion is detected, during the selected timezone.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Motion Detection is always on for cameras configured with LDVR recorders. Alarms will be generated only during the selected timezone. If you are using time-lapse mode, recording will jump to continuous mode whenever motion is detected regardless of the selected timezone.</td>
</tr>
<tr>
<td></td>
<td>The motion detection feature applies to cameras configured with LNVS, LNVR, LDVR-SP, LDVR-SP30, LDVR-408, and LDVR-444 recorders.</td>
</tr>
<tr>
<td></td>
<td>• For LNVR, LDVR-SP, LDVR-SP30, LDVR-408, and LDVR-444 recorders, the timezone for motion detection is set using this drop-down. Note that only specific cameras (Axis 2120 and Axis 2420) configured with an LNVS recorder support motion detection.</td>
</tr>
<tr>
<td></td>
<td>• For LNVR recorders, the timezone, frame rate, and threshold for motion detection are configured on the Video Processing form.</td>
</tr>
<tr>
<td>Generate Blind Camera Alarms</td>
<td>Select a timezone from the drop-down if you want the camera to generate an alarm when the blind camera threshold limit is reached, during the selected timezone.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The blind camera feature may work differently for automatic gain control cameras. For more information, refer to Automatic Gain Control on page 105.</td>
</tr>
<tr>
<td></td>
<td>The blind camera feature applies to cameras configured with LNVR, LDVR-SP, LDVR-SP30, and LDVR-444 recorders.</td>
</tr>
<tr>
<td></td>
<td>• For LDVR-SP, LDVR-SP30, and LDVR-444 recorders, the timezone for blind camera detection is set using this drop-down.</td>
</tr>
<tr>
<td></td>
<td>• For LNVR recorders, the timezone, frame rate, and threshold for blind camera detection is configured on the Video Processing form.</td>
</tr>
<tr>
<td>Input Number</td>
<td>Enter an input number (1-4). This field is only available for Axis 2400 (NTSC) and (PAL) camera types associated with an LNVR or LNVS video recorder.</td>
</tr>
</tbody>
</table>
Camera Form - Communication Sub-tab (Continued)

<table>
<thead>
<tr>
<th>Form Element</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Matrix Channel</td>
<td>The matrix input channel number the camera connects to.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Virtual matrix switchers</strong> - When a camera is linked to a virtual matrix switcher in B.A.S.I.S., you should enter the drop-in address instead of a channel number in the <strong>Matrix Channel</strong> field. This address needs to match the address set on the camera via a dip switch.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Multi-drop with virtual matrix switchers</strong> - When multi-drop is used the drop-in address for an RS-232 connection is always 1. Note that only RS-485 and RS-422 standards support multi-drop.</td>
</tr>
<tr>
<td>Motion Detection Configuration</td>
<td>Opens the Motion Detection Configuration window where you set the motion sensitivity and mask motion. For more information, refer to Configure Motion Detection and Apply Motion Mask to a Camera on page 77.</td>
</tr>
<tr>
<td></td>
<td>The motion detection feature applies to cameras configured with LNVR, LDVR-SP, LDVR-SP30, LDVR-408 and LDVR-444 recorders.</td>
</tr>
<tr>
<td></td>
<td>• For LDVR-SP, LDVR-SP30,LDVR-408, and LDVR-444 recorders, click the [Motion Detection Configuration] button.</td>
</tr>
<tr>
<td></td>
<td>• For LNVR recorders, motion detection is configured on the Video Processing form.</td>
</tr>
<tr>
<td>PTZ Controlled by Matrix Switcher</td>
<td>If the selected camera connects to a matrix switcher, choose the switcher from the drop-down.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field does not display when you configure a camera with an LNVR or LNVS video recorder.</td>
</tr>
</tbody>
</table>
Camera Form (Connection Sub-tab)

The following Connection sub-tab displays if you configure a camera with an LNVR recorder. Different fields display depending on the type of camera selected.

The following Connection sub-tab displays if you configure a camera with an LNVS recorder. Different fields display depending on the type of camera selected.
## Camera Form - Connection Sub-tab

<table>
<thead>
<tr>
<th>Form Element</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Camera Type</td>
<td>If you are working with an LNVR or LNVS video recorder, select a camera type. Choices include camera types that the selected video recorder supports.</td>
</tr>
<tr>
<td>Camera Web Page</td>
<td>Opens the selected IP camera’s configuration web page where you can modify camera settings and view a camera’s video output. For configuration procedures using a camera’s web page, refer to the Digital Video Hardware User Guide.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field displays when you configure certain camera types with an LNVS or LNVR recorder.</td>
</tr>
<tr>
<td>Codec</td>
<td>The compression type of the camera.</td>
</tr>
<tr>
<td>Generate Motion Detection Alarms</td>
<td>Select a timezone from the drop-down if you want the camera to generate an alarm when motion is detected, during the selected timezone. The motion detection feature applies to cameras configured with LNVS, LNVR, LDVR-SP, LDVR-SP30, LDVR-408, and LDVR-444 recorders.</td>
</tr>
<tr>
<td></td>
<td>• For LNVS, LDVR-SP, LDVR-SP30, LDVR-408, and LDVR-444 recorders, the timezone for motion detection is set using this drop-down. Note that only specific cameras (Axis 2120 and Axis 2420) configured with an LNVS recorder support motion detection.</td>
</tr>
<tr>
<td></td>
<td>• For LNVR recorders, the timezone, frame rate, and threshold for motion detection are configured on the Video Processing form.</td>
</tr>
<tr>
<td>IP Address</td>
<td>The IP address of the camera.</td>
</tr>
<tr>
<td>Playback Post-Roll</td>
<td>The <em>post-roll</em> is the number of seconds automatically added to the end time of alarms/events, generated by a camera, to ensure that video associated with the event includes footage of the scene after the actual event.</td>
</tr>
<tr>
<td>Playback Pre-Roll</td>
<td>The <em>pre-roll</em> is the number of seconds automatically subtracted from the start time of alarms/events, generated by a camera, to ensure that video associated with the event includes footage prior to the actual event.</td>
</tr>
<tr>
<td></td>
<td>For example, if a criminal disables a camera before executing a crime, the pre-roll greatly increases the odds that a video event includes footage of the criminal disabling that camera.</td>
</tr>
<tr>
<td>Port</td>
<td>A communication pathway from the video recorder to the camera. The default setting is an HTTP port setting, 80.</td>
</tr>
<tr>
<td>Read Camera Settings</td>
<td>Click this button to prevent the camera properties from changing if someone tries to modify them via the camera’s configuration web page. You can change camera properties outside of B.A.S.I.S. by accessing the camera’s configuration web page. When this is done, the properties reset to the values in B.A.S.I.S. when the Communication Server next requests a download. Click this button to prevent this situation (instead, the system reads the camera’s current property values through the camera’s translator and updates the B.A.S.I.S. user-interface).</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field displays when you configure certain camera types with an LNVS video recorder.</td>
</tr>
<tr>
<td>Standard</td>
<td>Select a video standard from the drop-down.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field displays when you configure certain camera types with an LNVR video recorder.</td>
</tr>
</tbody>
</table>
### Camera Form - Connection Sub-tab (Continued)

<table>
<thead>
<tr>
<th>Form Element</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Name/Password</td>
<td>If the camera is configured to require authentication, then enter the valid username/password. Otherwise, leave these fields blank. Note: Cameras are usually configured to require authentication on the camera’s website.</td>
</tr>
</tbody>
</table>
**Camera Form (Record Settings Sub-tab)**

**Note:** The Record Settings sub-tab does not display if you configure a camera with an LNVR or LNVS recorder.

The following Record Settings sub-tab displays if you configure a camera with an LDVR-SP, LDVR-SP30, LDVR-408, or LDVR-444 recorder.
The following Record Settings form displays if you configure a camera with a Generic Video or Loronix recorder.

Camera Form - Record Settings Sub-tab

<table>
<thead>
<tr>
<th>Form Element</th>
<th>Comment</th>
</tr>
</thead>
</table>
| Frame Rate   | For cameras with LDVR-SP, LDVR-SP30, LDVR-408, or LDVR-444 video recorders:  
  • You can choose one of 5 different frame rates. The choices available in the drop-down depend on the recorder’s current video standard (configured on the Video Recorder form).  
  • When there are no cameras defined, the default frame rate for a new camera is 3.7 fps (3.1 for PAL).  
  • When at least one camera is defined, the default frame rate for a new camera will be the frame rate of the camera that was selected just prior to adding the current camera.  
  • For LDVR-SP video recorders only, B.A.S.I.S. regulates the frame rate automatically so that within each group of eight cameras (cameras 1 through 8, cameras 8 through 16, etc.) the sum of the frame rates does not exceed 30 fps (25 for PAL).  
  • If the camera is in time-lapse mode, the frame rate must be 3.75 fps or higher. |
| Compression   | The amount of compression to use while recording an event. Compression effects video quality and is dependent on the video frame rate. |
Enable Time-Lapse Recording

Select this check box if you want the frame rate for the selected video recorder to be lower when no motion is detected. The lower frame rate is called the *Non-Motion Frame Rate*. Time-lapse recording must also be enabled for the recorder, otherwise the state of this check box is ignored and video is constantly recorded at the frame rate configured in the **Frame Rate** drop-down. Time-lapse recording is enabled for the recorder on the Recording sub-tab of the Video Recorder form.

When the camera is in time-lapse mode, the value entered in the **Frame Rate** field must be 3.75 or higher if the recorder is configured for NTSC (3.1 or higher if the recorder is configured for PAL).

**Note:** Motion Detection is always on for cameras configured with LDVR-SP, LDVR-SP30, LDVR-408, or LDVR-444 video recorders. Whenever motion is detected, the camera will switch to continuous recording mode.

Enable Audio Recording

Select this check box if you want to enable audio recording for live and recorded video. Audio recording can be enabled for each camera.

Pre-Roll

The *pre-roll* is the number of seconds automatically subtracted from the start time of alarms/events generated by this camera to ensure that the video associated with the event includes footage prior to the actual event.

For example, if a criminal disables a camera before executing a crime, the pre-roll greatly increases the odds that a video event includes footage of the criminal disabling that camera.

Post Roll

The *post roll* is the number of seconds automatically added to the end time of alarms/events generated by this camera to ensure that the video associated with the event includes footage following the actual event.
Camera Form (Quality Sub-tab)

Note: The Quality sub-tab does not display if you configure a camera with a Generic Video recorder, LNVR, LNVS, or Loronix recorder.

The following Quality tab displays if you configure a camera with an LDVR-SP, LDVR-SP30, LDVR-408, or LDVR-444 recorder.

Camera Form - Quality Sub-tab

<table>
<thead>
<tr>
<th>Form Element</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Brightness</td>
<td>The camera’s brightness level. High values increase the difference between the image’s brightest and darkest elements.</td>
</tr>
<tr>
<td>Contrast</td>
<td>The camera’s contrast level. By adjusting the contrast level you can increase or decrease the range of gray contained in the image, as well as increase or decrease the distinction between the lightest and darkest tones in the image. High contrast values make light areas lighter and dark areas darker.</td>
</tr>
</tbody>
</table>
Camera Form (Video Sub-tab)

The following Video form displays if you configure a camera with a LNVR or LNVS recorder. Different fields are available depending on the type of camera selected.

Camera Form - Video Sub-tab

<table>
<thead>
<tr>
<th>Form Element</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto</td>
<td>Select the check box if you want to accept the default (auto) settings.</td>
</tr>
<tr>
<td>Compression</td>
<td>The amount of compression to use while recording an event. Compression effects video quality and is dependant on the video frame rate.</td>
</tr>
<tr>
<td>Bitrate</td>
<td>The physical space (in bits not bytes) one second of audio or video requires.</td>
</tr>
<tr>
<td>Monochrome</td>
<td>Select this check box if you want to record video in monochrome (black and white). The Monochrome check box does not display for the Sony camera types and the Axis 2100,2120, 2420 (NTSC and PAL) camera types.</td>
</tr>
<tr>
<td>Resolution</td>
<td>The image resolution (number of pixels across and down).</td>
</tr>
<tr>
<td>Rotation (degrees)</td>
<td>The degrees of rotation for the camera view. The image is rotated clockwise as the value increases. For PTZ cameras, see the section on Rotation for PTZ Cameras below.</td>
</tr>
</tbody>
</table>

Rotation for PTZ Cameras

In most cases, PTZ cameras are designed for ceiling mount. The camera web page should be configured to indicate ceiling mount or 0° rotation. If the camera is not designed for ceiling mount, the rotation may need to be adjusted on the camera web page. Any rotation adjustments for the placement of the camera should be configured through the B.A.S.I.S. software. Failure to configure PTZ rotation correctly may cause unpredictable PTZ control.
Camera Form (Video Sensor Sub-tab)

The following Video Sensor form displays if you configure a camera with a LNVR or LNVS recorder. Different fields are available depending on the type of camera selected.

<table>
<thead>
<tr>
<th>Form Element</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto</td>
<td>Select the check box if you want to accept the default (auto) settings.</td>
</tr>
<tr>
<td>Default</td>
<td>Resets all video sensor fields to the default values.</td>
</tr>
<tr>
<td>Brightness</td>
<td>The camera’s brightness level. High values increase the difference between the image’s brightest and darkest elements. Select the check box if you want to accept the default (auto) settings.</td>
</tr>
<tr>
<td>Contrast</td>
<td>The camera’s contrast level. By adjusting the contrast level you can increase or decrease the range of gray contained in the image, as well as increase or decrease the distinction between the lightest and darkest tones in the image. High contrast values make light areas lighter and dark areas darker. Select the check box if you want to accept the default (auto) settings.</td>
</tr>
<tr>
<td>Saturation</td>
<td>The camera’s saturation level. Adjusting the saturation level adjusts the purity of color (the number of colors used to create a particular color). Higher values increase the saturation (purity); lower values decrease saturation. Select the check box if you want to accept the default (auto) settings.</td>
</tr>
<tr>
<td>Sharpness</td>
<td>The camera’s sharpness level (how focused or blurry the image is). Select the check box if you want to accept the default (auto) settings.</td>
</tr>
</tbody>
</table>
**Camera Form - Video Sensor Sub-tab (Continued)**

<table>
<thead>
<tr>
<th>Form Element</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>White Balance</td>
<td>The camera’s white balance level. By adjusting the white balance you redistribute shades of colors. White balance makes the darkest color in the image black and the lightest color in the image white, and adjusts the colors in between. Select the check box if you want to accept the default (auto) settings.</td>
</tr>
<tr>
<td>Exposure</td>
<td>The camera’s exposure level. High levels increase the amount of time light passes through the lens. Select the check box if you want to accept the default (auto) settings.</td>
</tr>
<tr>
<td>Hue</td>
<td>Hue perceptually, corresponds approximately to “color”. Functionally, hue is a phase relationship of the chrominance components. Select the check box if you want to accept the default (auto) settings.</td>
</tr>
<tr>
<td>Gamma</td>
<td>Gamma is a measure of contrast in an image, typically in the midrange grays (mid-tones). Adjusting the gamma allows you to correct mid-tones without noticeable changes in the highlight and shadow areas. Gamma is also the way the brightness of an image is interpreted by computer hardware. Many IP Cameras let you adjust the gamma level to alter the image appearance or to compensate for brightness or color in a room. Select the check box if you want to accept the default (auto) settings.</td>
</tr>
<tr>
<td>Backlight Comp</td>
<td>Backlight compensation adjusts the light level of the background image. This setting is useful in situations when there is a difference in available light between the subject and the background. If the background has too much light, the subject tends to appear dark. In this situation, increase the backlight comp value to compensate. Select the check box if you want to accept the default (auto) settings.</td>
</tr>
<tr>
<td>Iris</td>
<td>The iris adjusts the lens opening on the camera, which regulates the amount of light entering a camera. Select the check box if you want to accept the default (auto) settings.</td>
</tr>
</tbody>
</table>
Camera Form (Normal Mode Sub-tab)

Note: This sub-tab does not display when you configure a camera with a Generic Video, LDVR-SP, LDVR-SP30, LDVR-408, LDVR-444, or Loronix recorder.

The following Normal Mode sub-tab displays if you configure a camera with an LNVR recorder. Different fields display depending on the type of camera selected.
The following Normal Mode sub-tab displays if you configure a camera with an LNVS recorder. Different fields display depending on the type of camera selected.

![Camera Form - Normal Mode Sub-tab](image)

**Camera Form - Normal Mode Sub-tab**

<table>
<thead>
<tr>
<th>Form Element</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Live</td>
<td>The frame rate to view live video in Alarm Monitoring. If the selected value is within the recommended range, the value will be displayed in green, otherwise it will be displayed in red.</td>
</tr>
<tr>
<td></td>
<td>The live recording value limits the options available for continuous recording and event recording. For example, if you select 10 fps for live recording, then the continuous recording and event recording fields display values up to 10 fps. If you select 4 fps for live recording, then the options are limited to values up to 4 fps.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The Live check box must be selected to process video events. When live video capture is disabled, Pre-Roll is also disabled on the Event Mode sub-tab.</td>
</tr>
<tr>
<td>Recording Timezone</td>
<td>If you wish to limit recording to a specific timezone, select it from the drop-down. The default value is Always. If a timezone other than Always is selected, video will only be recorded during the selected timezone.</td>
</tr>
<tr>
<td>Continuous Recording</td>
<td>Select this check box if you want video recorded constantly at the selected frame rate. If the selected value is within the recommended range, the value will be displayed in green, otherwise it will be displayed in red.</td>
</tr>
<tr>
<td></td>
<td>The values available in the drop-down are limited by the live frame rate. See the definition for Live frame rate, for more information.</td>
</tr>
</tbody>
</table>
## Camera Form - Normal Mode Sub-tab

<table>
<thead>
<tr>
<th>Form Element</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time-Lapse Recording</td>
<td>Select this check box if you want the frame rate to be lower when there is no motion detected. When selected, enter a time-lapse recording rate. The range of values is 2 to 30 seconds per frame. This unit of measure (seconds per frame) implies all values are less than 1 frame per second. For example if you enter 2 seconds per frame, that is the equivalent of .5 frames per second. Note: MPEG4 cameras should be configured with a live frame rate of at least 12 fps when enabling time-lapse recording. Lower live frame rates, especially in combination with low seconds per frame time-lapse recording, can cause uneven gaps between frames and blocks of continuous recording between gaps.</td>
</tr>
<tr>
<td>Archive Continuous Video</td>
<td>Select the timezone in which video will be continuously archived for this camera. Video will only be archived during the selected timezone. The selected camera’s video recorder must also be configured for continuous archiving.</td>
</tr>
<tr>
<td>Audio</td>
<td>Select this check box to enable live audio. Note: Audio is only recorded when video is also recording. Note: With the In-Camera Storage feature it is not necessary to select the Recording check box. Recorded video will automatically include audio when the Audio check box is selected.</td>
</tr>
<tr>
<td>Use Camera Time Stamps</td>
<td>Select this check box to enable camera time stamps. The camera time must be synchronized with the LNVR prior to enabling this feature. For more information, refer to Camera Time Stamps on page 59.</td>
</tr>
<tr>
<td>Allow direct connect after ___ Seconds</td>
<td>Select this check box to allow a direct connection to the camera when the connection to the LNVR is lost. Specify the number of seconds before the direct connection is available.</td>
</tr>
<tr>
<td>Display Date</td>
<td>Select this check box if you want to display the date as an overlay. Note: The Display Date check box does not display for the Sony SNC-RZ30 PTZ (NTSC and PAL) camera type.</td>
</tr>
<tr>
<td>Display Time</td>
<td>Select this check box if you want to display the time as an overlay. Note: The Display Time check box does not display for the Sony SNC-RZ30 PTZ (NTSC and PAL) camera type.</td>
</tr>
<tr>
<td>Display Title</td>
<td>Select this check box if you want to display the title as an overlay.</td>
</tr>
</tbody>
</table>

### Camera Time Stamps

By default, time stamps are generated by the LNVR at the time the sample is received. This method may encounter inaccuracies across networks with bandwidth limitations and cause problems for features that require high accuracy such as IntelligentVideo.

A more reliable method uses time stamps generated by the camera. Prior to enabling the use of camera time stamps, the time on the camera and LNVR must be synchronized. The recommended method is through use of an NTP server. A
third-party application, such as “About Time” can be used to synchronize the LNVR, and the camera web page can be configured to connect the camera to the NTP server. Both the camera and the LNVR must use the same NTP server.

**Note:** If the time difference between the camera time stamps and the time on the LNVR is greater than 20 seconds, the recorder time stamps will be used. The Camera Time Stamps feature cannot be used across different world time zones.
Camera Form (Event Mode Sub-tab)

The Event Mode sub-tab displays if you configure a camera with an LNVR recorder.

Event Mode Sub-tab Functions

- Increase frame rate with pre-roll time for B.A.S.I.S. related events
- Enable B.A.S.I.S. specific events to trigger event recording mode

Camera Form - Event Mode Sub-tab

<table>
<thead>
<tr>
<th>Form Element</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event Recording</td>
<td>Select this check box if you want to enable event recording for the selected camera. When selected you can configure the recording frame rate and pre-roll for an event. When the event is complete, non-event recording mode resumes.</td>
</tr>
<tr>
<td>Frame Rate</td>
<td>Select the frame rate for event recording mode. If the selected value is within the recommended range, the value will be displayed in green, otherwise it will be displayed in red. The values available in the drop-down are limited by the live frame rate value on the Normal Mode sub-tab. For example, if you select 10 fps for live recording (on the Normal Mode sub-tab), then the event recording frame rate displays values up to 10 fps. If you select 4 fps for live recording, then the event recording is limited to values up to 4 fps.</td>
</tr>
</tbody>
</table>
### Camera Form - Event Mode Sub-tab (Continued)

<table>
<thead>
<tr>
<th>Form Element</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pre-Roll</td>
<td>The <em>pre-roll</em> is the number of seconds automatically subtracted from the start time of alarms/events, generated by this camera, to ensure that the video associated with the event includes footage prior to the actual event (at the event recording frame rate). For example, if a criminal disables a camera before executing a crime, the pre-roll greatly increases the odds that a video event includes footage of the criminal disabling that camera. <strong>Note:</strong> Typically the playback pre-roll does not need a value greater than 30 seconds, however for special circumstances it can be configured to up to 900 seconds. Pre-roll video is buffered in the system memory, and setting a high value for this field cause a large increase on the amount of system resources used. For more information, refer to Estimate RAM Needed for Pre-roll on page 75.</td>
</tr>
<tr>
<td>Post-Roll</td>
<td>The <em>post roll</em> is the number of seconds automatically added to the end time of alarms/events generated by this camera to ensure that the video associated with the event includes footage following the actual event.</td>
</tr>
<tr>
<td>Timezone</td>
<td>Select the access control timezone during which you wish to activate camera motion detection.</td>
</tr>
<tr>
<td>Send Alarms</td>
<td>Select this check box to send alarms to Alarm Monitoring.</td>
</tr>
<tr>
<td>Trigger Camera Event Mode</td>
<td>Select this check box to activate the camera’s event recording mode upon an event.</td>
</tr>
</tbody>
</table>
Camera Form (Audio Sub-tab)

The following Audio sub-tab displays if you configure a camera with an LNVR recorder.

Camera Form - Audio Sub-tab

<table>
<thead>
<tr>
<th>Form Element</th>
<th>Comment</th>
</tr>
</thead>
</table>
| Source type        | Select the source type from the drop-down. Options available reflect individual camera capabilities. Refer to the camera manufacturer’s manual for information about available audio source types.  
**Note:** This field is not required for some camera types. |
| Volume             | Use the slider or enter a number into the text box to set the volume.   |
| Allow Two-Way Audio| Select this check box to enable Two-Way Audio for the selected camera. If Two-Way Audio is not supported for the camera this check box will be grayed out. |
Camera Form (In-Camera Storage Sub-tab)

The In-Camera Storage feature allows video to be stored in the memory of a remote camera for later retrieval and storage in the LNVR. This feature is designed to facilitate systems that may experience high bandwidth during specific parts of the day, thus delaying the transfer of video to the LNVR until non-peak hours.

Continuous recording is not supported with In-Camera Storage. Due to the limited amount of memory within the camera, motion detection or camera inputs should be employed to only record events. Motion Detection sensitivity should be set such that only meaningful events are recorded.

Live video playback places considerable strain on the camera. The camera will appear offline in Alarm Monitoring. When requesting live video, there is a delay while the server establishes the initial connection to the camera for the transfer. Current IP camera technology, at the time of this release, may experience jumps or choppiness during live video playback.

If recorded video is requested that has not yet been retrieved from the camera, it will be downloaded to the LNVR and temporarily stored for playback. There will be a delay while the video is downloaded to the LNVR. If only a portion of the requested video has been retrieved, only the portion already stored on the LNVR will be played back. An additional request must be made for the video still stored on the camera.

Camera Requirements

Cameras must support the following requirements to be used for this feature:

- Storage of video and audio events must be based on motion detection or external triggers events via camera inputs.
- The storage of video and audio is stored in the memory of the camera and can be retrieved via FTP. The FTP server is required to operate for the appropriate camera memory (internal or external).
- The camera needs to operate in MPEG4 mode with cropping set to off as required from Sony in order to record video.
- [https://customer.lenel.com/?q=var/video-tools](https://customer.lenel.com/?q=var/video-tools)
Camera Configuration

The following steps must be performed via the camera web page to configure In-Camera Storage:

1. Set up the FTP server.
2. Configure the image memory with overwrite set to on.
3. Configure motion detection or external triggers.
4. Clear the camera memory.
5. Enable the Alarm Buffer and set the Alarm Buffer pre- and post-roll to at least 1 second.
6. Synchronize the time for the camera and LNVR.

Considerations for Several Sony Cameras

The following Sony cameras support the option for extended memory storage:

- Sony SNC-RZ25
- Sony SNC-RZ50
- Sony SNC-RX550
- Sony SNC-CS50
- Sony SNC-P5

There are special configuration steps for these cameras:

- Selected root directory should be set to the same source for both the FTP server and image memory.
- Add-on module must be formatted using a PCMCIA adaptor to plug the unit into a laptop.
- PTZ Preset scheduling is not supported with In-Camera Storage.

Note: PTZ control may cause additional choppiness with live video due to the motion created by the camera movement.
Software Configuration

The following In-Camera Storage sub-tab displays if you configure a camera with an LNVR recorder. Different fields display depending on the type of camera selected.

![Digital Video Folder](image)

**Note:** When enabling/disabling In-Camera Storage, any users currently accessing the system must log out then back in to Alarm Monitoring to use the new settings.

---

**Camera Form - In-Camera Storage Sub-tab**

<table>
<thead>
<tr>
<th>Form Element</th>
<th>Comment</th>
</tr>
</thead>
</table>
| Activate     | Select this check box to enable the In-Camera Storage feature.  
**Note:** This feature will deactivate live and continuous recording and audio recording. Prior to enabling In-Camera Storage, the desired fps should be configured in the **Live** drop-down on the **Normal Mode** sub-tab. |
| Timezone     | Select the access control timezone to retrieve recorded video from the camera. During the selected timezone, the LNVR will periodically connect to the camera to download recorded video. |
| FTP Port     | Enter the number of the port on the camera that allows incoming connections to be set. The Sony factory default is 21. |
Camera Form (Capacity Sub-tab)

The following Capacity sub-tab displays if you configure a camera with an LNVR recorder.

<table>
<thead>
<tr>
<th>Form Element</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Update</td>
<td>Connects to the video recorder to retrieve the current storage statistics.</td>
</tr>
<tr>
<td>Overall</td>
<td>Displays the total average recording bit rate in Mbps. According to this rate, the recorder should be able to store the number of days worth of video listed in the Capacity (days) column.</td>
</tr>
<tr>
<td>Last minute</td>
<td>Displays the average recording bit rate in Mbps for the last minute.</td>
</tr>
<tr>
<td>Last hour</td>
<td>Displays the average recording bit rate in Mbps for the last hour.</td>
</tr>
<tr>
<td>Last day</td>
<td>Displays the average recording bit rate in Mbps for the last day.</td>
</tr>
<tr>
<td>Capacity</td>
<td>Displays the amount of video currently stored on the video recorder.</td>
</tr>
</tbody>
</table>
**Camera Form Procedures**

**Configure LNVR Cameras**

**Note:** Before you configure an LVNR camera, you must configure the LNVR recorder. For more information, refer to *Add LNVR Video Recorders* on page 36.

1. From the **Video** menu, select **Digital Video**.
2. The Digital Video folder opens. Click the Camera tab.
3. Click [Add].
4. In the **Name** field, enter a unique, descriptive name for the camera.
5. Select the **Online** check box to place the camera online.
6. From the **Recorder** drop-down, select the recorder that this camera communicates with.
7. Select the failover recorder. For more information, refer to *Add LNVR Failover Video Recorders* on page 37.
8. On the Connection sub-tab:
   a. Select the camera type from the drop-down.
   b. Some camera types require you to select a video standard (NTSC or PAL).
   c. Enter an IP address and port. The camera itself must have the same IP address as what you enter in this field.
   d. Once you enter the camera’s IP address, you can click [Camera Web Page] to open the selected camera’s configuration web page.
   e. If the camera is configured to require authentication, then enter the valid username/password. Otherwise, leave these fields blank.
f. Enter the default playback pre-roll and playback post-roll. Refer to the Camera Form - Connection Sub-tab on page 48 for field definitions.

9. Select the Display Video check box to preview the camera image.

10. On the Video sub-tab:
   a. Select an image resolution (number of pixels across and down).
   b. Select the degrees of rotation. If your camera is a ceiling mount the degrees of rotation should be “0”; desk mounted cameras should be “180”.
   c. Select the Monochrome check box if you want video recorded in black and white. This check box displays for specific camera types.
   d. Enter the compression.
   e. Enter how much physical space (bits not bytes) one second of audio or video requires. Select the Auto check box if you want to accept the default (auto) settings.

11. On the Video Sensor sub-tab, enter the image settings for the camera. Refer to Camera Form - Video Sensor Sub-tab on page 55 for field definitions.

12. On the Audio sub-tab:
   a. Select a source type from the drop-down.
   b. Adjust the volume using the slider.

13. On the Normal Mode sub-tab:
   a. Select the frame rate to display live video in Alarm Monitoring.
   b. Specify when video recording should occur by selecting the Recording Timezone from the drop-down.
   c. Do one of the following:
      • Select the Continuous Recording check box if you want video recorded at a constant frame rate. Enter the frames per second.
      • Select the Time-Lapse Recording check box if you want a slower frame rate when no motion is detected. Enter the seconds per frame.

   Note: The frame rates during an event are configured on the Event Mode sub-tab. If event recording is configured, they will override any settings on the Normal Mode sub-tab when an event occurs.

   d. If you have configured archiving for the LNVR, you may specify a timezone to Archive Continuous Video from the drop-down. For more information, refer to Archive Server Form on page 94.
   e. Select the Audio check box if you wish to enable audio.
      • Select the Recording check box if you wish to record audio.
Notes: Audio is only recorded when video is also recording. With the In-Camera Storage feature it is not necessary to select the **Recording** check box. Recorded video will automatically include audio when the **Audio** check box is selected.

f. Select **Use Camera Time Stamps** to obtain time stamps from the camera.

14. On the Event Mode sub-tab, select the **Event Recording** check box if you want to increase frame rates per second before and during an event. When the event ends, non-event recording mode resumes. Refer to *Increase Frame Rates During Events* on page 75 for additional information.

15. Click [OK].

**Configure LNVS Cameras**

Note: Before you configure an LNVS camera, you must configure the LNVS recorder. For more information, refer to *Add LNVS Video Recorders* on page 38.

1. From the **Video** menu, select **Digital Video**.
2. The Digital Video folder opens. Click the Camera tab.
3. Click [Add].
4. In the **Name** field, enter a unique, descriptive name for the camera.
5. From the **Recorder** drop-down, select the recorder that this camera communicates with.
6. On the Connection sub-tab:
   a. Select the camera type from the drop-down.
   b. Enter an IP address and port. The camera itself must have the same IP address as what you enter in this field.
   c. Once you enter the camera’s IP address, you can click [Camera Web Page] to open the selected camera’s configuration web page.
   d. If the camera is configured to require authentication, then enter the valid username/password. Otherwise, leave these fields blank.
   e. Click [Read Camera Settings] if you want the system to read the camera’s current property values through the camera’s translator and update the B.A.S.I.S. user interface. Clicking this button prevents the
camera’s properties from being changed outside of the B.A.S.I.S. software.

f. Axis 2400 (NTSC and PAL) camera types require you to enter an input number.

g. Select the time zone from the **Generate Motion Detection Alarms** drop-down if you want motion detection alarms generated for Axis 2420, 2120, and 2130PTZ (NTSC and PAL) cameras.

7. Select the **Display Video** check box to preview the camera image.

8. On the Video sub-tab:
   a. Select an image resolution (number of pixels across and down).
   b. Select any display check box (title, date or time) to display that field as an overlay on recorded video.
   c. Select the **Monochrome** check box if you want video recorded in black and white. This check box displays for specific camera types.
   d. Enter the compression.
   e. Enter how much physical space (bits not bytes) one second of audio or video requires. Select the **Auto** check box if you want to accept the default (auto) settings.

9. On the Video Sensor sub-tab, enter the image settings for the camera. Refer to **Camera Form - Video Sensor Sub-tab** on page 55 for field definitions.

10. On the Normal Mode sub-tab:
   a. Select the frame rate for live video.

---

**Note:** The **Continuous Recording**, **Time-Lapse Recording**, **Audio**, and **Use Camera Time Stamps** check boxes apply to LNVR recorders only.

11. Click [OK].

---

**Configure Cameras Other Than LNVR/LNVS Cameras**

---

**Note:** Before you configure a camera, you must configure the recorder. For more information, refer to **Add Video Recorders Other Than LNVR/LNVS Recorders** on page 39.

---

1. From the **Video** menu, select **Digital Video**.
2. The Digital Video folder opens. Click the Camera tab.
3. Click [Add].
4. In the **Name** field, enter a unique, descriptive name for the camera.
5. From the **Recorder** drop-down, select the recorder that this camera communicates with.
6. On the Communications sub-tab, do one of the following:
   - For cameras with a LDVR-SP, LDVR-SP30, LDVR-408, or LDVR-444 recorder:
     a. Enter the channel number that the camera connects to. Each camera must be on its own unique channel.
     b. If you want the selected camera to generate an alarm when motion is detected, select the timezone from the **Generate Motion Detection** drop-down. Click [Motion Detection Configuration] to set the level of motion sensitivity. For more information, refer to **Configure Motion Detection and Apply Motion Mask to a Camera** on page 77.
     c. For cameras with LDVR-SP, LDVR-SP30, LDVR-444 recorders, if you want the selected camera to generate an alarm when the image produced by the camera has the same color throughout the entire image (typically all black or all white), select the timezone from the **Generate Blind Camera Alarms** drop-down.
     d. For LDVR-SP recorders, select a time zone from the **Archive Continuous Video** drop-down if you want continuous archiving to be turned on for this camera. The video recorder must also be configured for continuous archiving.
     e. If the selected camera is connected to a matrix switcher, choose the switcher from the **PTZ Controlled by Matrix Switcher** drop-down. In the **Matrix Channel** field, enter the matrix input channel number the camera connects to. If the camera is linked to a virtual matrix switcher, enter the drop-in address instead of a channel number. This address needs to match the one set on the camera via a dip switch.
   - For cameras with a Generic Video or Loronix recorder:
     a. In the **Camera ID** field, enter a unique ID number for the camera.
     b. Select the **Display Motion Detection Alarms** check box if you want an alarm to be displayed in Alarm Monitoring when this camera detects motion.
     c. If the selected camera is connected to a matrix switcher, choose the switcher from the **PTZ Controlled by Matrix Switcher** drop-down.
     d. In the **Matrix Channel** field, enter the matrix input channel number the camera connects to.

7. On the Record Settings sub-tab do one of the following:
   - For cameras with a Generic Video or Loronix recorder enter the default pre-roll and post roll of an event. Refer to the **Camera Form - Record Settings Sub-tab** on page 51 for field definitions.
   - For cameras with an LDVR-SP, LDVR-SP30, LDVR-408, LDVR-444 video recorder:
a. Select the frame rate to record video.
b. Enter the compression.
c. Select the **Enable Audio Recording** check box if you want to enable audio recording for live and recorded video for the selected camera. Audio recording can be enabled for each camera per recorder.
d. Enter the default pre-roll and post-roll of an event. Refer to the Camera Form - Record Settings Sub-tab on page 51 for field definitions.

8. Select the **Display Video** check box to preview the camera image.

9. On the Quality sub-tab do one of the following:
   - For cameras with a Generic Video or Loronix recorder, skip this step and proceed to the next numeric step.
   - For cameras with any other video recorder, enter image quality settings for the camera. Refer to Camera Form - Quality Sub-tab on page 53 for field definitions.

10. Click [OK].

**Capture Video on Event Only**

Capture Video on Event Only is a feature designed for systems that have limited bandwidth. Devices can be configured to trigger the recording of events, thus eliminating the need for continuous video capture.

---

**Note:** When an event is generated, B.A.S.I.S. sends a message to the LNVR to begin recording and the LNVR must establish connection with the camera. As a result, the first few seconds of the event may not be available. This loss can be minimized by reducing the load to the communication server, linkage server, LNVR, and by setting the camera at a higher frame rate.

---

1. From the Video menu, select **Digital Video**.
2. The Digital Video folder opens. Click the Camera tab.
3. Select a camera with an LNVR recorder.
4. Click [Modify].
5. Click the **Normal Mode** sub-tab.
6. Deselect the **Live** check box.
7. Click the **Event Mode** sub-tab.
8. Select the **Event Recording** check box.
   a. Select the **Frame Rate** from the drop-down.
   b. Enter the post-roll to record after the event occurs.
9. Click [OK].

10. Configure one or more of the following to trigger the camera to enter event mode:

   • **Camera inputs.** Configure a camera input and select the **Trigger Camera Event Mode** check box. For more information, refer to **Camera Inputs Form** on page 79.

   • **Camera motion detection.** Configure camera motion detection on the Event Mode sub-tab by selecting a **Timezone** and the **Trigger Camera Event Mode** check box.

   • **Device-camera link and Alarm-video configuration.**

   Note: The Device-camera link and Alarm-video configuration will cause the camera to appear offline in Alarm Monitoring because there is not a continuous connection to the camera.

   a. Devices can be used to trigger event mode by first setting up a Device-Camera link. For more information, refer to **Add a Device - Camera Link** on page 88.

   b. Next use the Alarm-Video Configuration form to modify the alarm generated by the device. Select the **Begin Event Recording** radio button to trigger event mode on alarm. For more information, refer to **Configure Video and Alarms** on page 92.

### Capture Video on Demand

Capture Video on Demand is a feature designed for systems with limited bandwidth. A connection is made to the camera only when video is requested by a user in the Alarm Monitoring application.

1. From the **Video** menu, select **Digital Video**.
2. The Digital Video folder opens. Click the Camera tab.
3. Select a camera with an LNVR recorder.
4. Click [Modify].
5. Click the **Normal Mode** sub-tab.
6. Select the live frame rate for the on demand video from the drop-down.
7. Deselect the **Live** check box.

   Note: Capture Video on Demand will cause the camera to appear offline in Alarm Monitoring because there is not a continuous connection to the camera.

8. Click [OK].
Increase Frame Rates During Events

Cameras with LNVR recorders can be configured for event recording mode (increased frame rates during events with up to 5 seconds of pre-roll and post-roll time).

Note: This procedure only applies to cameras with LNVR recorders.

1. From the Video menu, select Digital Video.
2. The Digital Video folder opens. Click the Camera tab.
3. Select a camera with an LNVR recorder.
4. Click [Modify].
5. Click the Event Mode sub-tab.
6. Select the Event Recording check box.
7. Select the frame rate from the drop-down.

Note: If the selected frame rate is within the recommended range, the value will be displayed in green, otherwise it will be displayed in red.

8. Enter the pre-roll and post-roll.
9. Any alarm on the Alarm-Video Configuration form that has the Begin Event Recording radio button selected will use these event recording settings.

Estimate RAM Needed for Pre-roll

It is recommended to estimate the amount of RAM needed before setting pre-roll to a value higher than 30 seconds. If the system resources do not meet the estimated value, it is highly recommended to set a lower value. If the value is set too high, it may result in video storage failure or video overflow errors.

1. Select a camera on the Camera form.
2. On the Capacity sub-tab, press [Update].
3. From the table, use Recording Rate (Mbps) with the highest value. (Using the highest recording rate ensures that the amount of RAM is not underestimated.) The recording rate can also be obtained from the Storage Calculator.
4. Divide by 8 to convert to MB/s.
5. Multiply by the number of seconds for pre-roll value.
6. Multiply by the number of cameras with the same configuration, or repeat steps 3 through 5 for each additional camera and add to the total RAM.

\[ \frac{\text{Overall Recording Rate} \times \text{PreRoll} \times \text{NumberCameras}}{8} = \text{RAM (MB)} \]
For example: If the Overall recording rate for a camera was 0.8 Mbps, the desired pre-roll was 30, and there were a total of 10 cameras with that configuration:

\[
\frac{0.8 \times 30 \times 10}{8} = 30
\]

7. If the estimated RAM does not exceed the system resources available, configure the pre-roll according to your calculations. If the system does not have enough RAM to support the calculated configuration, adjust the length of pre-roll or number of cameras and re-calculate the RAM required.

8. Once pre-roll has been configured, monitor the CPU usage to determine whether system resource usage is acceptable.
Configure Motion Detection and Apply Motion Mask to a Camera

Notes: This procedure only applies to cameras with an LDVR-SP, LDVR-SP30, LDVR-408, or LDVR-444 recorder. To configure motion detection for cameras with an LNVR, refer to the Video Processing Form on page 101. Cameras and recorders must be previously configured before completing this procedure. Otherwise, the Motion Detection Configuration button is disabled.

1. From the Video menu, select Digital Video.
2. The Digital Video folder opens. Click the Camera tab.
3. Select the name of a camera.
4. Click the Communication sub-tab.
5. Click [Modify].
6. Click [Motion Detection Configuration]. The Motion Detection Configuration window opens.

7. Set the motion sensitivity to the desired level. The motion sensitivity level is how much motion the camera sees before it switches from a non-motion-detection state to a motion-detection state. The camera will switch to a non-motion-detected state 10 seconds after the last time the amount of motion in front of the camera was at or above the motion sensitivity level.

Note: The red lines in the graph signify motion equal to or greater than the sensitivity level.

8. Select areas that will be masked for motion by clicking your cursor on the left side of the window. A gray box appears. To select several boxes, click...
and drag the mouse. To deselect boxes, right-click a box or right-click and drag the mouse.

9. Click [Save]. Motion will not be detected in masked areas.

**Configure Time-Lapse Recording for LDVR Cameras**

1. Enable time-lapse recording on the Video Recorder.
   a. On the Video Recorder form, select the video recorder from the listing window.
   b. Select the Recording sub-tab and click [Modify].
   c. Select the Enable Time-Lapse Recording check box.
   d. Set the Non-Motion Frame Rate in seconds per frame.
   e. Set the Time Lapse Pre-Roll to specify the amount of video to cache and record prior to an alarm.
   f. Click [OK].

2. Enable time-lapse recording for the individual camera.
   a. On the Camera form, select the camera from the listing window.
   b. Select the Record Settings sub-tab and click [Modify].
   c. Select the Enable Time-Lapse Recording check box.

**Note:** When the camera is in time-lapse mode, the value entered in the Frame Rate field must be 3.75 or higher if the recorder is configured for the NTSC (3.1 or higher for PAL).

3. To filter out unwanted motion, adjust the Motion Detection settings.
   a. Select the Communication sub-tab and click [Motion Detection Configuration].
   b. Set a mask for any areas with excessive motion by highlighting the area with the mouse.

**Note:** To mask all motion, click [Select All]. With this setting, the camera will never leave time-lapse mode.

c. Adjust the slider to change the sensitivity threshold and eliminate false detections of motion.

d. Click [Save] to retain the motion detection configuration changes.

4. Click [OK] to save the modifications to the camera settings.
Configure Time-Lapse Recording with Motion Detection for LNVR Cameras

Note: This configuration is just one example of how an LNVR camera can be configured to trigger time-lapse recording mode. For more information, refer to Time-Lapse Recording on page 24.

To configure time-lapse recording with the Motion Detection video event, complete the following steps:

1. Enable time-lapse recording for the individual camera.
   a. On the Camera form, select the camera from the listing window.
   b. Select the Normal Mode sub-tab and click [Modify].
   c. Select the Time-Lapse Recording check box.
   d. Set the Seconds per frame value for the time-lapse recording rate.
   e. Click [OK] to save the modifications to the camera settings.

2. To trigger normal recording mode when motion is detected, create a Video Processing event.
   a. On the Video Processing form, add a Motion Detection (AI) event. For more information, refer to Add Event Settings on page 109.
   b. Launch the Event Configuration/Search dialog by clicking the button.
   c. Set the Region Of Interest for the area you wish to monitor for motion.
   d. Adjust the Threshold if needed to eliminate false motion detection.
   e. Click [OK] to save the configuration.
   f. Click [OK] to save the Video Processing event.

Camera Inputs Form

Camera inputs allow the configuration, monitoring, and linkage of alarms to other devices. The LNVR monitors the inputs and sends the alarms to Alarm
Monitoring. Refer to the camera manufacturer documentation for connection information.

Camera Inputs Form

<table>
<thead>
<tr>
<th>Form Element</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A descriptive name for the camera input. This is a “friendly” name assigned to each camera input to make it easy to identify. Each name must be unique and contain no more than 32 characters.</td>
</tr>
<tr>
<td>Online</td>
<td>Select this check box to set the camera input online.</td>
</tr>
<tr>
<td>Video Recorder</td>
<td>Select the LNVR for the camera from the drop-down.</td>
</tr>
<tr>
<td>Camera</td>
<td>Select the camera for this input device.</td>
</tr>
<tr>
<td>Input Number</td>
<td>Enter the pin number for the input device.</td>
</tr>
<tr>
<td>Supervision</td>
<td>Select the normally open/closed setting from the drop-down.</td>
</tr>
<tr>
<td>Timezone</td>
<td>Select the access control timezone for monitoring the camera input.</td>
</tr>
<tr>
<td>Send Alarms</td>
<td>Select this check box to enable the sending of alarms generated by the camera input to Alarm Monitoring.</td>
</tr>
<tr>
<td>Trigger Camera Event Mode</td>
<td>Select this check box to force the camera to go to event mode recording upon a change on the input.</td>
</tr>
<tr>
<td>Add</td>
<td>Create a new camera input.</td>
</tr>
<tr>
<td>Modify</td>
<td>Enables changes to be made to the selected camera input.</td>
</tr>
<tr>
<td>Delete</td>
<td>Removes the selected camera input.</td>
</tr>
<tr>
<td>Help</td>
<td>Displays online help for this topic.</td>
</tr>
<tr>
<td>Close</td>
<td>Closes the Digital Video folder.</td>
</tr>
</tbody>
</table>
Camera Inputs Form Procedures

Add a Camera Input

1. From the Video menu, select Digital Video. The Digital Video folder opens.
2. Click the Camera Inputs tab.
3. Click [Add].
4. In the Name field, enter a unique, descriptive name for the camera input.
5. Select the Online check box to place the input online.
6. From the Video Recorder drop-down, select the recorder that this camera communicates with.
7. From the Camera drop-down, select the camera for this input.
8. Enter the number of the input device.
9. From the Supervision drop-down, specify whether the input is Normally Open or Normally Closed.
10. Select the access control timezone during which the input will be monitored.
11. Select the Send Alarms check box if you want to have alarms sent to Alarm Monitoring.
12. Select the Trigger Camera Event Mode check box if you want to force the camera into event mode recording upon a change in the input.
13. Click [OK].

Modify a Camera Input

1. From the Video menu, select Digital Video. The Digital Video folder opens.
2. Click the Camera Inputs tab.
3. In the listing window, select the camera input you want to change.
4. Click [Modify].
5. Make any changes you want to the camera input. You cannot change the video recorder, camera, or input number settings.
6. Click [OK].

Delete a Camera Input

1. From the Video menu, select Digital Video. The Digital Video folder opens.
2. Click the Camera Inputs tab.
3. In the listing window, select the camera input you want to remove.
4. Click [Delete].
5. Click [OK].
Camera Outputs Form

Camera outputs allow the configuration and linkage of alarms to other devices. Camera outputs can be placed in Output Device Groups and selected as devices on the output side of a Global I/O linkage. Refer to the camera manufacturer documentation for connection information.

Camera Outputs Form

<table>
<thead>
<tr>
<th>Form Element</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A descriptive name for the camera output. This is a “friendly” name assigned to each camera output to make it easy to identify. Each name must be unique and contain no more than 32 characters.</td>
</tr>
<tr>
<td>Online</td>
<td>Select this check box to set the camera output online.</td>
</tr>
<tr>
<td>Video Recorder</td>
<td>Select the LNVR for the camera from the drop-down.</td>
</tr>
<tr>
<td>Camera</td>
<td>Select the camera for this output device.</td>
</tr>
<tr>
<td>Output Number</td>
<td>Enter the pin number for the output.</td>
</tr>
<tr>
<td>Duration</td>
<td>Enter the pulse time for the output.</td>
</tr>
<tr>
<td>Add</td>
<td>Create a new camera output.</td>
</tr>
<tr>
<td>Modify</td>
<td>Enables changes to be made to the selected camera output.</td>
</tr>
<tr>
<td>Delete</td>
<td>Removes the selected camera output.</td>
</tr>
<tr>
<td>Help</td>
<td>Displays online help for this topic.</td>
</tr>
<tr>
<td>Close</td>
<td>Closes the Digital Video folder.</td>
</tr>
</tbody>
</table>
Camera Outputs Form Procedures

Add a Camera Output

1. From the Video menu, select Digital Video. The Digital Video folder opens.
2. Click the Camera Outputs tab.
3. Click [Add].
4. In the Name field, enter a unique, descriptive name for the camera output.
5. Select the Online check box to place the output online.
6. From the Video Recorder drop-down, select the recorder that this camera communicates with.
7. From the Camera drop-down, select the camera for this output.
8. Enter the number of the output device.
9. For the Duration field, enter the pulse time for the output.
10. Click [OK].

Modify a Camera Output

1. From the Video menu, select Digital Video. The Digital Video folder opens.
2. Click the Camera Output tab.
3. In the listing window, select the camera output you want to change.
4. Click [Modify].
5. Make any changes you want to the camera output. You cannot change the video recorder, camera, or output number settings.
6. Click [OK].

Delete a Camera Output

1. From the Video menu, select Digital Video. The Digital Video folder opens.
2. Click the Camera Outputs tab.
3. In the listing window, select the camera output you want to remove.
4. Click [Delete].
5. Click [OK].
Remote Monitor

Remote Monitor (RM), also commonly referred to as “camera call-up”, is an application that can be run on any PC without B.A.S.I.S. installed. The RM is installed on a client from the Supplemental Materials disc and configured in System Administration. The RM application behaves as a slave to the Alarm Monitoring application which is used to send video commands.

Special considerations must be made for RM clients connecting an LNVR with security settings configured. For more information, refer to LNVR Security on page 85.

<table>
<thead>
<tr>
<th>Form Element</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A descriptive name for the Remote Monitor.</td>
</tr>
<tr>
<td>Workstation</td>
<td>Enter the name or IP address of the workstation that runs the Communication Server.</td>
</tr>
<tr>
<td>Browse</td>
<td>Click this button to browse for the workstation or RM computer name.</td>
</tr>
<tr>
<td>Computer Name or IP Address of RM</td>
<td>Enter the computer name or IP address of the computer that the RM runs on.</td>
</tr>
<tr>
<td>TCP/IP Port</td>
<td>Enter the connection port for the Remote Monitor. The same port number must also be configured in the Remote Monitor application. For more information, refer to Remote Monitor Application on page 209.</td>
</tr>
<tr>
<td>Add</td>
<td>Create a new Remote Monitor entry.</td>
</tr>
<tr>
<td>Modify</td>
<td>Enables changes to be made to the selected Remote Monitor.</td>
</tr>
<tr>
<td>Delete</td>
<td>Removes the selected Remote Monitor.</td>
</tr>
<tr>
<td>Help</td>
<td>Displays online help for this form.</td>
</tr>
</tbody>
</table>
Currently there is no secure communication between the RM and the B.A.S.I.S. software. The RM must use another method of authentication to an LNVR with security settings because it cannot receive credentials from the B.A.S.I.S. server. To enable authentication with the LNVR, log on to the RM client with a Windows user account that belongs to the LNVUsers group or configure RM to run as a LNVUsers group member.

Note: If anonymous DCOM is disabled on the LNVR, the Windows user logged on to the RM client must be authenticated by the LNVR as Everyone or Administrator.

**Remote Monitor Form Procedures**

**Add a Remote Monitor**

1. From the **Video** menu, select **Digital Video**. The Digital Video folder opens.
2. Click the Remote Monitor tab.
3. Click [Add].
4. In the **Name** field, enter a unique, descriptive name for the remote monitor.
5. In the **Workstation** field, enter the name or IP address of the workstation running the Communication Server, or click [Browse] to search for it.
6. In the **Computer Name or IP Address of Remote Monitor** field, enter the name or IP address of the remote monitor, or click [Browse] to search for it.
7. In the **TCP/IP Port** field, enter the communications port of the remote monitor.
8. Click [OK].
9. The Monitor Zone Assignments window is displayed. Select the monitor zone(s) you wish to assign the remote monitor to and click [OK].
Modify a Remote Monitor

1. From the Video menu, select Digital Video. The Digital Video folder opens.
2. Click the Remote Monitor tab.
3. In the listing window, select the remote monitor you wish to change.
4. Make the changes you want to the remote monitor.
5. Click [OK].

Delete a Remote Monitor

1. From the Video menu, select Digital Video. The Digital Video folder opens.
2. Click the Remote Monitor tab.
3. In the listing window, select the remote monitor you wish to delete.
4. Click [Delete].
5. Click [OK].
Device - Camera Links Form

Devices can be configured to trigger a camera response when alarms are generated by the device. The Device-Camera Links form defines the relationship between the camera and the device. The Alarm-Video Configuration form can then be used to specify the action performed by the camera when an alarm is generated by the device.

Camera to camera links can also be created with the Device - Camera Links form. When viewing video for an alarm with associated video, video for any linked cameras will also be launched with the parent camera. If you also want to view video for the associated cameras when launching the parent camera from the System Status Tree, add the following line to the [DigitalVideo] section of the ACS.INI file: AlwaysIncludeCameraToCameraLinks=1

Digital Video Folder - Device-Camera Links Form

<table>
<thead>
<tr>
<th>Form Element</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Listing window</td>
<td>Lists currently defined device-camera links.</td>
</tr>
<tr>
<td>Add</td>
<td>Launches the device-camera link wizard.</td>
</tr>
<tr>
<td>Modify</td>
<td>Enables changes to be made to the selected device-camera link.</td>
</tr>
<tr>
<td>Delete</td>
<td>Removes the selected device-camera link.</td>
</tr>
<tr>
<td>Help</td>
<td>Displays online help for this topic.</td>
</tr>
<tr>
<td>Close</td>
<td>Closes the Digital Video folder.</td>
</tr>
</tbody>
</table>
Device - Camera Links Form Procedures

Add a Device - Camera Link

1. From the Video menu, select Digital Video. The Digital Video folder opens.
2. Click the Device-Camera Links tab.
3. Click [Add]. The Select Device window opens.

4. Do one of the following:
   - Select the Search Device by Panel Filter radio button, and then select a device type and a panel filter from the drop-downs. The names of the devices that match your search will be displayed in the listing window.
   - Select the Search Device by Name radio button if you know the name of the device you want to link. Type in the name of the device, and then click [Find]. If the name you entered is located in the system, it will be displayed in the device listing window.

5. In the listing window, click on the name of the device you want to link. A red checkmark will appear next to the name of the selected device.
6. Click [Next]. The Select camera(s) window opens.
7. Select a recorder from the Video Recorder drop-down. The names of the corresponding cameras will be displayed in the listing window.
8. In the cameras listing window, select the name of the camera(s) that you want to link. The names of selected cameras will appear in the linked cameras listing window.
Note: Clicking on an already selected camera in the cameras listing window will remove that camera from the linked cameras listing window.

9. Click the View order spin buttons to set the priority of the selected camera in the linked cameras listing window.

10. Click [Save Link(s)]. The Summary window opens.

11. Click [Finish] to complete the wizard, or [Add More] to return to the Select Device window where you can add more device-camera links.

Modify a Device - Camera Link

1. From the Video menu, select Digital Video. The Digital Video folder opens.

2. Click the Device-Camera Links tab.

3. In the listing window, select the device-camera link you wish to change.

4. Click [Modify] to launch the device-camera link wizard. The Select camera(s) window opens.

5. Make the changes you want to the link.

6. Click [Save Link(s)]. The Summary window opens.

7. Click [Finish] to complete the change, or [Add More] to return to the Select camera(s) window where you can modify other device-camera links.

Delete a Device - Camera Link

1. From the Video menu, select Digital Video. The Digital Video folder opens.

2. Click the Device-Camera Links tab.

3. In the listing window, select the device-camera link you wish to delete.

4. Click [Delete].

5. Click [OK].
Alarm-Video Configuration Form

This form is used to configure video commands to be executed when an alarm generated in the system. When an alarm is generated, it is sent to the Communication Server. The Communication Server sends the alarm to the Linkage Server. Based on your alarm-video configurations, the Linkage Server can then tell the video recorder to:

- Start locking a video clip or end locking a video clip
- Start event recording or end event recording
- Automatically launch video
### Alarm-Video Configuration Form Field Table

#### Digital Video Folder - Alarm - Video Configuration Form

<table>
<thead>
<tr>
<th>Form Element</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Listing window</td>
<td>Lists currently defined alarms. The window contains all of the alarms that can have video commands associated with them.</td>
</tr>
<tr>
<td>No Locking</td>
<td>Select this radio button if you do not want video event locking when the selected alarm is generated.</td>
</tr>
<tr>
<td>Begin Locking Video</td>
<td>Select this radio button if you want the video recorder to start locking a video segment when the selected alarm is generated. When this option is selected, a default video event timeout must be set.</td>
</tr>
<tr>
<td></td>
<td>This will ensure that the event ends and does not end up locking all of the video on the video recorder.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If event locking is configured for primary LNVR recorders, then the corresponding secondary recorders will also lock video.</td>
</tr>
<tr>
<td>End Locking Video</td>
<td>Select this radio button if you want the video recorder to end the locking of a video event prior to the specified default video event timeout period when the selected alarm is generated.</td>
</tr>
<tr>
<td></td>
<td>The system ignores this setting if the selected alarm is generated after the specified default timeout period.</td>
</tr>
<tr>
<td>No Configuration Change</td>
<td>Select this radio button if you do not want a event recording configuration change when the selected alarm is generated.</td>
</tr>
<tr>
<td>Begin Event Recording</td>
<td>Select this radio button if you want to switch to the specified event recording configurations (frame rate, resolution, compression, etc.) when the selected alarm is generated. When this option is selected, a default video event timeout must be set.</td>
</tr>
<tr>
<td></td>
<td>This will ensure that the event recording configurations end and revert back to standing recording (or no recording), to avoid filling up the video recorder with unnecessary video.</td>
</tr>
<tr>
<td>End Event Recording</td>
<td>Select this radio button if you want the video recorder to end recording at the specified event recording configurations prior to the specified default video event timeout period when the selected alarm is generated.</td>
</tr>
<tr>
<td></td>
<td>The system ignores this setting if the selected alarm is generated after the specified default timeout period.</td>
</tr>
<tr>
<td>Default Video Event Timeout</td>
<td>A value is required in this field if you selected the Begin Locking Video and/or Begin Event Recording radio buttons.</td>
</tr>
<tr>
<td></td>
<td>Specify the timeout period in which to wait for another alarm to send the begin locking video or begin event recording command. If the timeout period expires before this happens, then the alarm will also send a end locking video, or end event recording command, thus completing the automatic video event creation process.</td>
</tr>
<tr>
<td>Automatically Launch Video Player on Alarm</td>
<td>If selected, Alarm Monitoring will automatically launch a video window displaying the alarming device's associated cameras.</td>
</tr>
<tr>
<td>Start in matrix mode for multiple cameras</td>
<td>Select this check box to launch video for multiple cameras in matrix mode.</td>
</tr>
<tr>
<td>Close player on acknowledgment</td>
<td>Select this check box to have video windows closed on alarm acknowledgment.</td>
</tr>
<tr>
<td>Add</td>
<td>This button is not used.</td>
</tr>
<tr>
<td>Modify</td>
<td>Enables changes to be made to alarm-video configurations.</td>
</tr>
</tbody>
</table>
Digital Video Folder - Alarm -Video Configuration Form (Continued)

<table>
<thead>
<tr>
<th>Form Element</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete</td>
<td>Removes a video command from a selected alarm.</td>
</tr>
<tr>
<td>Help</td>
<td>Displays online help for this topic.</td>
</tr>
<tr>
<td>Close</td>
<td>Closes the Digital Video folder.</td>
</tr>
</tbody>
</table>

**Alarm-Video Configuration Form Procedures**

**Configure Video and Alarms**

1. From the Video menu, select Digital Video. The Digital Video folder opens.
2. Click the Alarm-Video Configuration tab.
3. Select an alarm from the listing window.
4. Click [Modify].
5. In the Video Event Locking section, do one of the following:
   - Select the No Locking radio button if you do not want video event locking when the selected alarm is generated.
   - Select the Begin Locking Video radio button if you want the video recorder to start locking a video segment when the selected alarm is generated. When this option is selected, a default video event timeout must be set. This will ensure that the event ends and does not end up locking all of the video on the video recorder.
   - Select the End Locking Video radio button if you want the video recorder to end the locking of a video event prior to the specified default video event timeout period when the selected alarm is generated. The system ignores this setting if the selected alarm is generated after the specified default timeout period.
6. In the Use Event Recording Configuration section, do one of the following:
   - Select the No Configuration Change radio button if you do not want a event recording configuration change when the selected alarm is generated.
   - Select the Begin Event Recording radio button if you want to switch to the specified event recording configurations (frame rate, resolution, compression, etc.) when the selected alarm is generated. When this option is selected, a default video event timeout must be set. This will ensure that the event recording configurations end and revert back to standing recording (or no recording), to avoid filling up the video recorder with unnecessary video.
   - Select the End Event Recording radio button if you want the video recorder to end recording at the specified event recording configurations.
prior to the specified default video event timeout period when the
selected alarm is generated. The system ignores this setting if the
selected alarm is generated after the specified default timeout period.

7. If you selected the Begin Locking Video and/or Begin Event Recording
radio buttons, in the Default Video Event Timeout field, specify the
timeout period in which to wait for another alarm to send the begin locking
video or begin event recording command. If the timeout period expires
before this happens, then the alarm will also send an end locking video, or end
event recording command, thus completing the automatic video event
creation process.

8. Select the Automatically Launch Video Player on Alarm check box if you
want Alarm Monitoring to automatically launch a view window displaying
the alarming device’s associated cameras.

9. Click [OK].

**Video Event Text Form**

The Video Event Text form is used to enter text that can be used when a user
manually creates a video event in Alarm Monitoring. Each entry on the Video
Event Text form will appear in a drop-down for the user to select when manually
generating a video event.

<table>
<thead>
<tr>
<th>Form Element</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Listing window</td>
<td>Displays currently available video event text.</td>
</tr>
<tr>
<td>Text</td>
<td>Enter the text that you wish to have available to a user when manually creating a video event.</td>
</tr>
</tbody>
</table>
Archive Server Form

Digital Video Folder - Archive Server Form

<table>
<thead>
<tr>
<th>Form Element</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Archive Servers</td>
<td>Lists currently defined archive servers. For any archive server that has video recorders associated with it, the video recorders will be listed beneath the archive server. Video recorders are associated with an archive server by selecting the archive server in the Archive Server field on the Archiving/Purging sub-tab of the Video Recorder form for a selected video recorder.</td>
</tr>
<tr>
<td>Workstation</td>
<td>Select the name of the workstation that will be running the archive server. The archive server is responsible for communicating with the video recorder during archive operations. Note: You are required to enter the workstation’s NetBIOS name. (The NetBIOS name is specified when Windows networking is installed/configured.)</td>
</tr>
<tr>
<td>Browse</td>
<td>Opens a Browse for Computer window, from which you can click on the name of a workstation.</td>
</tr>
<tr>
<td>Segment</td>
<td>Displays the segment that the archive server is a member of.</td>
</tr>
<tr>
<td>Online</td>
<td>If selected, the archive server will be online. Online indicates that the archive server is ready for use, that the Stanley communications server will attempt to communicate with it, and archiving will occur. If not selected, the Stanley communications server will not attempt to communicate with the archive server. This is useful when performing some maintenance tasks.</td>
</tr>
</tbody>
</table>
### Digital Video Folder - Archive Server Form (Continued)

<table>
<thead>
<tr>
<th>Form Element</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control Remote Storage Services</td>
<td>This check box determines whether the archive server controls the Microsoft Remote Storage Services. The Services are used to move archived data to the tape library.</td>
</tr>
<tr>
<td></td>
<td>If selected, the archive server will activate the Microsoft Remote Storage Services when it fills the archiving locations. It will not archive any more data to the archiving locations until the Services move the data from the archiving locations to tapes, thereby creating more free space in the archiving location.</td>
</tr>
<tr>
<td></td>
<td>If not selected, when the archiving locations fill up, the administrator will have to manually move data from the archiving locations to tape to create more free space. Alternatively, you can choose to use the Automatically free archive space for new continuous archived video setting.</td>
</tr>
<tr>
<td></td>
<td>An archive server can use the Control Remote Storage Services setting or the Automatically free archive space for continuous archived video setting, but not both.</td>
</tr>
<tr>
<td>Automatically free archive space for new continuous archived video</td>
<td>This check box determines whether the archive server will delete the oldest archived video when there is no room for new archived video. This option is only for archiving to a disk array.</td>
</tr>
<tr>
<td></td>
<td>If selected, the archive server will delete the oldest archived continuous video blocks until there is enough free space to resume archiving.</td>
</tr>
<tr>
<td></td>
<td>If not selected, the archive server will never delete any archived continuous video. Instead, it will send an alarm to Alarm Monitoring saying that all archiving locations are full, and the administrator must free some space in the archiving location(s) before the archive server can resume archiving. As soon as the archive server detects that there is enough free space in the archiving location(s) to archive the next video blocks, it will automatically resume archiving.</td>
</tr>
<tr>
<td>Shared folders listing window</td>
<td>Lists all folders on the archive server workstation that are shared, but are not being used for archiving yet.</td>
</tr>
<tr>
<td></td>
<td>If this field is blank and you have selected a Workstation, click [Refresh]. If the field is still blank, click [Browse] and select the shared folder you wish to use as an archiving location.</td>
</tr>
<tr>
<td>Right arrow</td>
<td>When clicked, moves a location that is selected in the Shared folders display to the Archiving locations display, effectively specifying it as an archiving location.</td>
</tr>
<tr>
<td>Left arrow</td>
<td>Enabled only in modify mode. When clicked, moves a location that is selected in the Archiving locations display to the Shared folders display, effectively removing it from the list of locations to archive to.</td>
</tr>
<tr>
<td>Refresh</td>
<td>Refreshes or reloads the list of shared folders. Click this button when you think shared folders on the archive server workstation have been changed or added.</td>
</tr>
<tr>
<td>Archiving locations listing window</td>
<td>Choose the locations where video will be put as it is archived. Each location should be in a UNC format such as \ArchiveServer\Directory where the ArchiveServer is the name of the archive server you are configuring and Directory is the name of the directory to put the files in. Continuous archiving writes a new archive file to this directory every 5 minutes.</td>
</tr>
<tr>
<td></td>
<td>There is no limit to the number of archiving locations you can specify. The order in which the archiving locations are listed is not important because the archiving location with the most available space is always the location that will be written to first. When that location’s drive fills, the system will automatically write archived files to the location in this list that has the largest amount of free space.</td>
</tr>
</tbody>
</table>
Digital Video Folder - Archive Server Form (Continued)

<table>
<thead>
<tr>
<th>Form Element</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Browse</td>
<td>Opens a Browse for Folder window, from which you can click on a location of where the video events should be archived. Selecting an archiving location using the [Browse] button is the functionally the same as selecting an archiving location in the Shared folders and using the right arrow button to move the location to the Archiving locations. Some networks may be configured in such a way that the Shared folders cannot be found. If this is the case, use the [Browse] button to locate the Archiving locations.</td>
</tr>
<tr>
<td>Add</td>
<td>Create a new archive server record.</td>
</tr>
<tr>
<td>Modify</td>
<td>Enables changes to be made to the selected archive server record.</td>
</tr>
<tr>
<td>Delete</td>
<td>Removes the selected archive server record.</td>
</tr>
<tr>
<td>Help</td>
<td>Displays online help for this topic.</td>
</tr>
<tr>
<td>Close</td>
<td>Closes the Digital Video folder.</td>
</tr>
</tbody>
</table>

**Archive Server Form Procedures**

**Add an Archive Server**

1. From the Video menu, select Digital Video. The Digital Video folder opens.
2. Click the Archive Server tab.
3. Click [Add].
4. If segmentation is not enabled, skip this step. If segmentation is enabled:
   a. The Segment Membership window will open. Select the segment that this archive server will be assigned to.
   b. Click [OK].
5. In the Workstation field enter the name of the workstation the archive server will be connected to.
6. If the archive server will be online, select the Online check box. Online indicates that the archive server is ready for use, that the Stanley communications server will attempt to communicate with it, and archiving will occur.
7. Select how the system will behave when the archiving locations run out of free space. Here are the options:
   - If the Control Remote Storage Services and Automatically free archive space for new continuous archived video check boxes are NOT selected, when the archive server fills the archiving locations, a message will be sent to Alarm Monitoring, and the administrator will have to make free space in the archiving locations.
   - If the Control Remote Storage Services check box is selected, the archive server will activate the Microsoft Remote Storage Services...
when it fills the archiving locations. It will not archive any more data to the archiving locations until the Services move the data from the archiving locations to tapes, thereby creating more free space in the archiving locations.

- If the **Automatically free archive space for new continuous archived video** check box is selected, the archive server will delete the oldest archived continuous video blocks until there is enough free space to resume archiving.

8. Click [Refresh]. The shared folders on the specified workstation should be displayed in the Shared folders listing window.

**Note:** Some networks may be configured in such a way that shared folders will not display when the [Refresh] button is clicked. If this is the case, refer to the second procedure in step 9 to specify the archiving locations.

9. The system will write archived files in the order they are listed in the Archiving locations listing window. When the first location is full, the system will automatically write archived files to the second location, and so on. There is no limit to the number of archiving locations that can be specified. There are two ways a shared folder can be specified as an archiving location.

- The first way is:
  a. In the Shared folders listing window, click on the shared folder that you want to be an archiving location.
  b. Click the right arrow button. The shared folder will be removed from the Shared folders listing window, and will be listed in the Archiving locations listing window.
  c. Repeat steps a and b for each shared folder that you wish to become an archiving location.

- The second way is:
  a. Click the [Browse] button that is below the Archiving locations listing window.
  b. In the Browse for Folder window, navigate to the shared folder you wish to become an archiving location.
  c. Click [OK]. The location you selected will be listed in the Archiving locations listing window.
  d. Click [Refresh]. If the location you selected using the [Browse] button was listed in the Shared folders listing window, it will be removed.
  e. Repeat steps a-d for each shared location that you wish to become an archiving location.

10. Click [OK].
2: Digital Video Folder

Modify an Archive Server

1. From the Video menu, select Digital Video. The Digital Video folder opens.
2. Click the Archive Server tab.
3. In the Archive servers listing window, select the archive server you wish to change.
4. Click [Modify].
5. Make any changes you want to the archive server. The workstation is the only setting that you cannot change.
6. Click [OK].

Delete an Archive Server

1. From the Video menu, select Digital Video. The Digital Video folder opens.
2. Click the Archive Server tab.
3. In the Archive servers listing window, select the archive server you want to remove.
4. Click [Delete].
5. Click [OK].
Security Form

LNVR video devices can be configured to require user authentication. If this occurs, valid user credentials (user name and password) must also be entered in the B.A.S.I.S. system.

When you modify user credentials using a device specific configuration tool, you also need to make changes in the B.A.S.I.S. system. For video recorders, the configuration tool would be a standard Windows administration tool. For cameras, the configuration tool would usually be the camera’s web page, which can be launched from the Camera form.

A simpler method to change the password for the current user is via the Security form. There are two benefits to using this form. First, the task is completed in one step. B.A.S.I.S. automatically communicates the new password to the device and updates the database. Second, you can modify passwords for more than one device at a time.

**Note:** Password changes must conform to the password policies and standards configured by your system administrator.

**Note:** Before you modify the current user’s password, B.A.S.I.S. must be connected to the associated video device and the device must be online. The **Live** check box must be also selected in the Normal Mode sub-tab of the Camera folder. IP cameras must also be in secure mode. For more information, refer to IP Cameras on page 42.
Digital Video Folder - Security Form

**Form Element** | **Comment**
---|---
Listing window | Lists currently defined LNVR recorders and cameras associated with them. Select the recorders and/or cameras you want to modify.
Current User | The name of the user account. This field automatically populates if a user name was initially populated on the Video Recorder/Camera forms and multiple devices are not selected in the Security form. If this field is blank, the password can not be changed.
Reset to this password | Enter the new password for the selected devices. The following restrictions apply:
  - Axis cameras all up to 10 character passwords using A through Z, a through z, 0 - 9, !, #', - , ^, _, ~,
  - Sony cameras allow up to 16 character passwords using A through Z, a through z, 0 - 9
  - LNVR recorder password length is limited by the LNVR’s computer password policy, which is set by the System Administrator. Valid characters are ! - ~
  Note: In addition to these restrictions, strong password rules apply if the strong password feature is enforced. For more information refer to chapter 1.
  Note: If the Current User field is blank, the password can not be changed.
Confirm password | Enter the new password a second time for verification.
Multiple Selection | Allows you to select more than one entry in the listing window.
Add | Does not apply to this form.
Modify | Enables changes to be made to the password for the selected devices.
Delete | Does not apply to this form.
Help | Displays online help for this topic.
Close | Closes the Digital Video folder.
Security Form Procedures

Change Network Video Password

LNVR passwords can be modified for previously configured LNVR video recorders and the cameras associated with them.

1. From the Video menu, select Digital Video. The Digital Video folder opens.
2. Click the Security tab.
3. Select one or several LNVR recorders and/or cameras. Use the Multiple Selection check box to select several entries.
4. Click [Modify].
5. Enter and confirm the new password.
6. Click [OK].

Notes: You can also modify previously configured passwords by:
Using the Change Network Video Password action type in the Scheduler folder. Devices do not have to be online when you configure the action. However, in order for the action to succeed, the devices need to be online when the action is executed. For more information refer to the Scheduler folder.
or
Using the Global I/O folder to configure an output action to change the password. Devices do not have to be online when you configure the output action. However, in order for the output action to succeed, the devices need to be online when the input event occurs. For more information refer to the Global I/O folder in the System Administration User Guide.

Video Processing Form

LNVR supports motion detection, blind camera, and brightness change events. B.A.S.I.S. provides video configuration of these events through the Video Processing form. No additional licensing is required.

In addition to configuring multiple events for a specific camera, you can configure event properties on the Video Processing form. The Video Processing form includes a button that displays the Event Configuration/Search dialog.
where you can define event configuration parameters. For more information, refer to Configure Event Properties on page 181.

Digital Video Folder - Video Processing Form

<table>
<thead>
<tr>
<th>Form Element</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Listing window</td>
<td>Lists currently defined IP cameras on all LNVR recorders as well as the channel, camera type, video standard, camera IP address, camera resolution and frame rates.</td>
</tr>
<tr>
<td>Status</td>
<td>Displays the status of the selected recorder.</td>
</tr>
<tr>
<td>Event Type</td>
<td>Displays the name of the configured event.</td>
</tr>
<tr>
<td>Name</td>
<td>A descriptive name for the event that will display in Alarm Monitoring. The name can be 21 characters long. Since B.A.S.I.S. supports two events of the same type for the same camera, the name should be descriptive enough for Alarm Monitoring operators to recognize where the event occurred.</td>
</tr>
<tr>
<td>Timezone</td>
<td>The timezone during which the specified setting is active. Timezones are created in the Timezones folder, which is located by selecting Timezone from the Access Control menu.</td>
</tr>
<tr>
<td>Recording</td>
<td>The type of recording that will be used. Choices include:</td>
</tr>
<tr>
<td>- Event</td>
<td>increased frame rate with pre-roll for B.A.S.I.S. specific events. Event recording settings are configured on the Event Mode sub-tab of the Camera form.</td>
</tr>
<tr>
<td>- Normal</td>
<td>continuous or time-lapsed recording. Normal recording settings are configured on the Normal Mode sub-tab of the Camera form.</td>
</tr>
<tr>
<td>Alarm</td>
<td>Determines whether an alarm displays in Alarm Monitoring.</td>
</tr>
<tr>
<td>- On</td>
<td>If the threshold is reached during the selected timezone, an alarm is sent from the recorder to B.A.S.I.S. and an alarm displays in Alarm Monitoring.</td>
</tr>
<tr>
<td>- Off</td>
<td>If the threshold is reached during the selected timezone an alarm will not be active (sent to B.A.S.I.S.) nor will it display in Alarm Monitoring.</td>
</tr>
</tbody>
</table>
Blind Camera (AI)

Blind camera detection generates an alarm when the camera cannot capture the surrounding scenery, but instead captures a solid color image. For example, if an intruder covers all or part of camera’s lens, a blind camera alarm may be generated.

Note: LNVR with firmware version 1.31 and greater support motion detection and blind camera image processing.

Blind camera detection applies to cameras configured with LDVR or LNVR recorders. However, there are subtle differences in the user’s ability to configure blind camera settings, as well as differences when a recorder generates a blind camera alarm.

- **LDVR-SP, LDVR-SP30, and LDVR-444 recorders** - the blind camera feature is configured on the Communication sub-tab of the Camera form. Only the timezone when the blind camera detection applies is user-configurable.

- **LNVR recorders** - the blind camera feature is configured on the Video Processing form. The timezone, recording frame rate, whether an alarm displays in Alarm Monitoring, and the blind camera threshold are user-configurable.

<table>
<thead>
<tr>
<th>Form Element</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threshold</td>
<td>The level (percentage) that must be reached for an event to occur. This column displays only when the recorder is offline. When the recorder is online, the threshold value is configured on the Event Configuration/Search Dialog. For more information, refer to Chapter 5: Event Configuration/Search Dialog on page 175.</td>
</tr>
<tr>
<td>Add</td>
<td>Displays the Event Configuration/Search dialog where you can configure event-specific parameters. For more information, refer to Chapter 5: Event Configuration/Search Dialog on page 175.</td>
</tr>
<tr>
<td>Modify</td>
<td>Does not apply to this form.</td>
</tr>
<tr>
<td>Delete</td>
<td>Enables changes to be made to the settings for the selected camera.</td>
</tr>
<tr>
<td>Help</td>
<td>Deletes all configured events for the selected camera. Only the [Delete] button can be used with the <strong>Multiple Selection</strong> check box.</td>
</tr>
<tr>
<td>Multiple Selection</td>
<td>Displays online help for this topic.</td>
</tr>
<tr>
<td>Close</td>
<td>Select this check box to select multiple entries in the listing window. Multiple selection only applies to the delete option.</td>
</tr>
<tr>
<td></td>
<td>Closes the Digital Video folder.</td>
</tr>
</tbody>
</table>
Event Configuration/Search Dialog

The Event Configuration/Search dialog allows the user to configure video processing events on IP cameras. The Event Configuration/Search dialog is opened from the Video Processing form by pressing the button during Blind Camera (AI) event configuration.

For more information, refer to Event Configuration/Search Dialog on page 124.

<table>
<thead>
<tr>
<th>Property</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Region of Interest</td>
<td>Region of Interest (ROI) identifies the area of video to be processed.</td>
</tr>
<tr>
<td></td>
<td>Click the Create Region of Interest button and then click on the video to mark the area you wish to define.</td>
</tr>
<tr>
<td></td>
<td>Once the ROI has been created, use the mouse to drag and drop any of the green vertices or the entire ROI if adjustments are necessary.</td>
</tr>
<tr>
<td></td>
<td>To remove an ROI, click the Delete Last Region of Interest button.</td>
</tr>
<tr>
<td>Threshold</td>
<td>Level of change required to generate an alarm.</td>
</tr>
</tbody>
</table>
Automatic Gain Control

A recorder generates blind camera detection/restored alarms under different circumstances, depending on the type of camera configured with it.

- **Cameras without automatic gain control:**
  - Generate blind camera detection alarms when the camera is covered and the recorder receives a solid color image.
  - Generate blind camera restored alarms when the camera is uncovered and the recorder receives images of the scene.

- **Cameras with automatic gain control** generate blind camera detection/restored alarms depending on the blind camera threshold as well as the camera’s frame rate and speed of adjustment to changes in light conditions.

Cameras with automatic gain control automatically adjust their sensitivity level to obtain the best image quality for the current environment. If a camera is covered, its ability to adjust to its new environment and see something, as well as its frame rate determines whether a blind camera section/restored alarm occurs.

The following situations trigger blind camera detection alarms with automatic gain control cameras:

- **If a camera is covered such that the automatic gain control cannot adjust to distinguish (see) the cover.** This situation would occur if the cover was made of a material such that the amount of light that filters through the lens is not enough for the camera to see the cover and therefore the recorder receives at least one solid color image.

- **If a camera is covered and the automatic gain control cannot adjust to distinguish (see) the cover in a timely manner (it is too slow).** This situation would occur if the frame rate is fast enough that at least one solid color image is received by the recorder.

- **If a camera is uncovered and it slowly adjusts the sensitivity level such that a time period occurs where the camera sees a solid color image instead of the scene.** A blind camera detection alarm would be generated until the camera finishes adjusting the sensitivity. This situation would occur if the camera’s speed of automatic gain control is slow enough that at least one solid image is received by the recorder. This situation would also occur if the camera has a high frame rate.

Cameras with automatic gain control may generate anywhere from zero to two blind camera detection/restored pairs of alarms during any one incidence of covering/uncovering a camera. The frame rate and speed that the camera is able
to adjust itself, if at all, determines the number of pairs of alarms that occur in one incidence. Refer to the following sequence of events:

1. A camera is covered.
2. Depending on the camera’s frame rate/speed, the recorder may send a blind camera alarm.
   - If an alarm was issued and the camera was able to readjust itself to see something between the lens and the cover, the recorder generates a blind camera restored alarm.
   - Otherwise, the blind camera restored alarm will not be generated until the cover is removed.

When the cover is removed, regardless of what happened in the previous step, the recorder might send a blind camera alarm, depending on the adjustment speed and frame rate of the camera, if it sees white.

If the recorder sent a blind camera alarm, it will send a blind camera restored alarm when the camera readjusts itself to the surrounding light conditions.

**Brightness Change**

Brightness change detection generates an alarm when there is a change in the lighting in a scene.

**Event Configuration/Search Dialog**

The Event Configuration/Search dialog allows the user to configure video processing events on IP cameras. The Event Configuration/Search dialog is opened from the Video Processing form by pressing the button during Brightness Change event configuration.

For more information, refer to Event Configuration/Search Dialog on page 124.
Motion Detection (AI)

The motion detection feature applies to cameras configured with LNVS, LNVR, LDVR-SP, LDVR-SP30, LDVR-408, and LDVR-444 recorders.

- For LNVS, LDVR-SP, LDVR-SP30, LDVR-408, and LDVR-444 recorders, the timezone for motion detection is set using options on the Communication sub-tab of the Camera form.

<table>
<thead>
<tr>
<th>Property</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Region of Interest</td>
<td>Region of Interest (ROI) identifies the area of video to be processed.</td>
</tr>
<tr>
<td></td>
<td>Click the Create Region of Interest button and then click on the video to mark the area you wish to define.</td>
</tr>
<tr>
<td></td>
<td>Once the ROI has been created, use the mouse to drag and drop any of the green vertices or the entire ROI if adjustments are necessary.</td>
</tr>
<tr>
<td></td>
<td>To remove an ROI, click the Delete Last Region of Interest button.</td>
</tr>
<tr>
<td>Direction</td>
<td>Set the type of brightness changes that will generate an alarm. Options are brightness increased, brightness decreased, or both.</td>
</tr>
<tr>
<td>Duration</td>
<td>Length of time (in seconds) that the alarm will remain active after detecting a change in brightness. If the event is not restored within this time, the new brightness level will become the base level from which future alarms are generated.</td>
</tr>
<tr>
<td>Threshold</td>
<td>Level of change required to generate an alarm.</td>
</tr>
</tbody>
</table>
• For LNVR recorders, the timezone, frame rate, and threshold for motion detection are configured on this form.

Event Configuration/Search Dialog

The Event Configuration/Search dialog allows the user to configure video processing events on IP cameras. The Event Configuration/Search dialog is opened from the Video Processing form by pressing the button during Motion Detection (AI) event configuration.

<table>
<thead>
<tr>
<th>Property</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Region of Interest</td>
<td>Region of Interest (ROI) identifies the area of video to be processed.</td>
</tr>
<tr>
<td></td>
<td>Click the Create Region of Interest button and then click on the video to mark the area you wish to define.</td>
</tr>
<tr>
<td></td>
<td>Once the ROI has been created, use the mouse to drag and drop any of the green vertices or the entire ROI if adjustments are necessary.</td>
</tr>
<tr>
<td></td>
<td>To remove an ROI, click the Delete Last Region of Interest button.</td>
</tr>
<tr>
<td>Threshold</td>
<td>Level of change required to generate an alarm.</td>
</tr>
</tbody>
</table>
Video Processing Form Procedures

Add Event Settings

Complete the following procedure to configure motion detection, blind camera or brightness changes for cameras with LNVR recorders.

1. From the Video menu, select Digital Video. The Digital Video folder opens.
2. Click the Video Processing tab.
3. Select (place a checkmark beside) the appropriate camera.
4. Click [Modify].
5. With your cursor in the Event Type column, right-click and select “Add”.

<table>
<thead>
<tr>
<th>Event Type</th>
<th>Name</th>
<th>Timezone</th>
<th>Recording</th>
<th>Alarm</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

6. Select the event type from the drop-down.

<table>
<thead>
<tr>
<th>Event Type</th>
<th>Name</th>
<th>Timezone</th>
<th>Recording</th>
<th>Alarm</th>
</tr>
</thead>
<tbody>
<tr>
<td>Motion Detection (All)</td>
<td>Type name here</td>
<td>Always</td>
<td>Normal</td>
<td>On</td>
</tr>
</tbody>
</table>

7. Select the field that displays under the Name column. Enter a descriptive name that will be appended to the alarm description in Alarm Monitoring (when this event occurs).

<table>
<thead>
<tr>
<th>Event Type</th>
<th>Name</th>
<th>Timezone</th>
<th>Recording</th>
<th>Alarm</th>
</tr>
</thead>
<tbody>
<tr>
<td>Motion Detection (All)</td>
<td>Type name here</td>
<td>Always</td>
<td>Normal</td>
<td>On</td>
</tr>
</tbody>
</table>

8. Select the field in the Timezone column. A drop-down displays. Select the timezone during which the settings apply.

<table>
<thead>
<tr>
<th>Event Type</th>
<th>Name</th>
<th>Timezone</th>
<th>Recording</th>
<th>Alarm</th>
</tr>
</thead>
<tbody>
<tr>
<td>Motion Detection (All)</td>
<td>Motion Detected CEO Hallway</td>
<td>Always</td>
<td>Normal</td>
<td>On</td>
</tr>
</tbody>
</table>

9. Select the field in the Recording column. A drop-down displays. Select the type of recording settings to use.

10. Select the field in the Alarm column. A drop-down displays. Select whether an alarm will display in Alarm Monitoring or not.

11. To configure event specific parameters, click the camera icon to the right of the Alarm column. For more information, refer to Event Configuration/
12. Repeat steps 5 through 11 for each new event you want for the specified camera.

13. Click [OK].

**PTZ Tour Server Form**

The PTZ Tour Server form is used to indicate a server running the PTZ Tour Server service. This service allows PTZ tours to run continuously in the background for recording purposes. PTZ tour servers may be utilized by the Run PTZ Tour action type and when running a PTZ tour from Alarm Monitoring.

Background PTZ tours can only be interrupted by a user with a higher priority or by the user that started the tour. The PTZ timeout value is not utilized with background PTZ tours.

**Note:** The PTZ Tour Server service can be run as a service in the background or as an application from the Windows Start menu.

<table>
<thead>
<tr>
<th>Form Element</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Listing window</td>
<td>Lists currently defined PTZ tour servers.</td>
</tr>
<tr>
<td>Name</td>
<td>A descriptive name for the PTZ tour server.</td>
</tr>
<tr>
<td>Workstation</td>
<td>Select the name of the workstation that will be running the PTZ Tour Server service.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>You are required to enter the workstation’s NetBIOS name. (The NetBIOS name is specified when Windows networking is installed/configured.)</td>
</tr>
<tr>
<td>Form Element</td>
<td>Comment</td>
</tr>
<tr>
<td>--------------</td>
<td>---------</td>
</tr>
<tr>
<td>Browse</td>
<td>Opens a Browse for Computer window, from which you can click on the name of a workstation.</td>
</tr>
</tbody>
</table>
Chapter 3: IntelligentVideo Folder

To configure Lenel IntelligentVideo, you must configure the IntelligentVideo Server (IVS) as well as the events. The IVS is configured on the IntelligentVideo Server form in System Administration. Events are configured on the Event Configuration/Search dialog, which is opened through the IntelligentVideo Event form or the Video Player in System Administration.

In addition to events, you can configure channel parameters for the video channel itself. Channel parameters are configured on the Video Channel Configuration dialog.

The recommended configuration sequence in the B.A.S.I.S. software is:

1. Configure an IntelligentVideo Server. For more information, refer to Configure an IntelligentVideo Server on page 116.
2. Configure a video recorder. For more information, refer to Add LNVR Video Recorders on page 36.
3. Configure cameras. For more information, refer to Configure LNVR Cameras on page 68.
4. Configure IntelligentVideo event settings. For more information, refer to IntelligentVideo Events Form Procedures on page 120.

The folder contains the following forms: the IntelligentVideo Server form, the IntelligentVideo Events form, the IntelligentVideo Application form, and the IntelligentAudio form.

You can display the IntelligentVideo folder by selecting IntelligentVideo from the Video menu. or by selecting the IntelligentVideo toolbar button.

For detailed IntelligentVideo Event configuration information, refer to the IntelligentVideo User Guide.
### IntelligentVideo Server Form

The IntelligentVideo Server (IVS) is a server designed to run complex video algorithms for video processing of events. You can configure events from any video recorder to be processed using the IVS. After events are detected and processed, the IVS sends alarms to Alarm Monitoring.

For detailed IntelligentVideo Event configuration information, refer to the IntelligentVideo User Guide.

![IntelligentVideo Server Form](image)

### IntelligentVideo Folder - IntelligentVideo Server Form

<table>
<thead>
<tr>
<th>Form Element</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Listing window</td>
<td>Lists currently defined IntelligentVideo Servers (IVS) and the total number of events configured on each server.</td>
</tr>
<tr>
<td>Name</td>
<td>A descriptive name for the IVS server.</td>
</tr>
<tr>
<td>Online</td>
<td>If selected, the IVS will be online and the Communication Server will attempt to communicate with it.</td>
</tr>
<tr>
<td>IntelligentVideo Server Type</td>
<td>Select the server type from the drop-down list.</td>
</tr>
<tr>
<td>Workstation</td>
<td>The name of the workstation the IVS connects to.</td>
</tr>
<tr>
<td>Use IP Address</td>
<td>Select this radio button if you want to use the IP address of the IVS. This is the address B.A.S.I.S. will use to communicate with the IVS.</td>
</tr>
<tr>
<td>Use Computer Name</td>
<td>Select this radio button if you want to use the computer name of the IVS. This is the name B.A.S.I.S. will use to communicate with the IVS.</td>
</tr>
<tr>
<td>Browse</td>
<td>Click this button to browse for the IVS computer name or workstation.</td>
</tr>
</tbody>
</table>
Performing a Download to the IntelligentVideo Server

A download to the IntelligentVideo Server should be performed after each of the following circumstances has occurred:

- The IVS has been marked offline, and has been brought online again.
- Whenever a new IVS is added to the system.
- Whenever the IVS is upgraded.
- The system has been converted to a segmented system.
- When failover settings have been changed on a camera channel that has IntelligentVideo events configured.

To perform a download, right-click the IVS and select Download.
IntelligentVideo Server Form Procedures

Configure an IntelligentVideo Server

1. From the Video menu, select IntelligentVideo. The IntelligentVideo folder opens.
2. Click the IntelligentVideo Server tab.
3. Click [Add].
4. Enter a name for the IVS.
5. Select IntelligentVideo Server or IntelligentVideo Application Server from the IntelligentVideo Server Type drop-down list.
6. Identify how the IVS will communicate with the recorder, by entering the workstation, and IP address or computer name of the IVS.
7. Enter the user name and password for the specific Windows account used by B.A.S.I.S. to connect with the IVS, or use the default values.
8. Select the world time zone for the geographical location of the selected IVS.
9. Select the Daylight Savings check box if you want to properly convert between various time formats for daylight savings.
10. Click [OK].
11. The Monitor Zone Assignments window is displayed. Select the monitor zone(s) you wish to assign the server to and click [OK].
**IntelligentVideo Events Form**

The IntelligentVideo Events form applies to cameras configured with any video recorder. This form allows you to configure multiple events or one solution for a camera to be processed on a specified IVS server only. Additional licensing (Maximum Number of IntelligentVideo Streams) is required to use IntelligentVideo processing.

In addition to events, you can configure channel parameters for the video channel itself. The IntelligentVideo form includes a [Channel Configuration] button which allows you to configure channel parameters. For more information, refer to Video Channel Configuration Dialog on page 135.

For detailed IntelligentVideo Event configuration information, refer to the IntelligentVideo User Guide. For detailed IntelligentVideo Solution configuration information, refer to the IntelligentVideo Solutions User Guide.

**IntelligentVideo Folder - IntelligentVideo Events Form**

<table>
<thead>
<tr>
<th>Form Element</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Camera listing window</td>
<td>Lists currently defined IP cameras and the recorders they are associated with, as well as the channel, camera type, video standard, camera IP address, camera resolution, and IVS that will process data for specific events.</td>
</tr>
<tr>
<td>IntelligentVideo Server</td>
<td>Select the name of the IVS server for the selected camera.</td>
</tr>
<tr>
<td>IntelligentVideo Solution</td>
<td>Lists the name of the IVS solution loaded on the camera.</td>
</tr>
<tr>
<td>Status</td>
<td>Displays the status of the selected IVS.</td>
</tr>
</tbody>
</table>
### Form Element

<table>
<thead>
<tr>
<th>Form Element</th>
<th>Comment</th>
</tr>
</thead>
</table>
| Channel Configuration | Channel parameters are based on video characteristics. Channel parameters and are different than event parameters which are based on image processing algorithms. For example, if a video has a lot of motion, such as an active hallway, the background learning time (channel parameter) may have to be increased so the motion detection algorithm (event parameter) picks out static scene elements more accurately.  
The [Channel Configuration] button activates when System Administration successfully connects to the selected IVS. Click this button to display the Video Channel Configuration dialog.  
**Note:** You can also display the Video Channel Configuration dialog through a [Channel Configuration] button on the Event Configuration/Search dialog. For more information, refer to Video Channel Configuration Dialog on page 135. |
| Solution Configuration | Click this button to access the Solution Configuration menu. Use this menu to **Add**, **Modify**, **Delete**, or **Convert Separate Events**. The **Add** and **Modify** menu options launch the Solution Configuration wizard. To stop using a solution while retaining configured events, select the **Convert Separate Events** menu option. This option allows the user control over parameters that are pre-configured as part of the solution. |
| Event Type | Displays the name of the configured event. For more information, refer to the IntelligentVideo Event chapters in the IntelligentVideo User Guide |
| Name | A descriptive name for the event that will display in Alarm Monitoring. The name can be 21 characters long. Since B.A.S.I.S. supports two events of the same type, for the same camera, the name should be descriptive enough for Alarm Monitoring operators to recognize where the event occurred. |
| Timezone | The timezone during which the specified IntelligentVideo setting is active. Timezones are created on the Timezones folder, which is located by selecting Timezone from the Access Control menu. |
| Recording | The type of recording that will be used. Choices include:  
- **Event** - increased frame rate with pre-roll for B.A.S.I.S. specific events. Event recording settings are configured on the Event Mode sub-tab of the Camera form.  
- **Normal** - continuous or time-lapsed recording. Normal recording settings are configured on the Normal Mode sub-tab of the Camera form.  
**Alarm** | Determines whether an alarm displays in Alarm Monitoring.  
- **On** - If the threshold is reached during the selected timezone, an alarm is sent from the recorder to B.A.S.I.S. and an alarm displays in Alarm Monitoring.  
- **Off** - If the threshold is reached during the selected timezone an alarm will not be active (sent to B.A.S.I.S.) nor will it display in Alarm Monitoring.  
| Displays the Event Configuration/Search Dialog where you can configure event-specific parameters. For more information, refer to Event Configuration/Search Dialog on page 124. |
| Modify | Changes the IntelligentVideo settings for the selected camera. |
| Delete | Deletes all configured events for the selected camera. Only the [Delete] button can be used with the **Multiple Selection** check box. |
| Help | Displays online help for this topic. |
## IntelligentVideo Folder - IntelligentVideo Events Form (Continued)

<table>
<thead>
<tr>
<th>Form Element</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Multiple Selection</td>
<td>Select this check box to select multiple entries in the listing window. Multiple selection only applies to the delete option.</td>
</tr>
<tr>
<td>Close</td>
<td>Closes the IntelligentVideo folder.</td>
</tr>
</tbody>
</table>
IntelligentVideo Events Form Procedures

Add IntelligentVideo Event Settings

1. From the Video menu, select IntelligentVideo. The IntelligentVideo folder opens.
2. Click the IntelligentVideo Events tab.
3. Select (place a checkmark beside) the appropriate camera.
4. Click [Modify].
5. Select the IVS that will process images for the events.
6. With your cursor in the Event Type column, right-click and select “Add”.

### Event Type | Name | Timezone | Recording | Alarm
---|---|---|---|---

7. Select the event type from the drop-down list.

![Event Type Drop-Down List](image)

8. Select the field that displays under the Name column. Enter a descriptive name that will be appended to the alarm description in Alarm Monitoring (when this event occurs).

### Event Type | Name | Timezone | Recording | Alarm
---|---|---|---|---
Congestion | Type name here | Always | Named | On

9. Select the field in the Timezone column. A drop-down list displays. Select the timezone during which the IntelligentVideo settings apply.

### Event Type | Name | Timezone | Recording | Alarm
---|---|---|---|---
Congestion | Congestion in Room | Always | Named | On
Weekend | Weekday | Always | Never |

10. Select the field in the Recording column. A drop-down list displays. Select the type of recording settings to use.

11. Select the field in the Alarm column. A drop-down list displays. Select whether an alarm will display in Alarm Monitoring or not.

12. To configure event specific parameters, click the camera icon to the right of
the Alarm column. For more information, refer to Event Configuration/Search Dialog on page 124.

13. To configure channel parameters for the video channel itself, click [Channel Configuration]. For more information, refer to Video Channel Configuration Dialog on page 135.

14. Repeat steps 5 through 12 for each new event you want for the specified camera.

15. Click [OK].

Modify IntelligentVideo Settings

1. From the Video menu, select IntelligentVideo. The IntelligentVideo folder opens.

2. Click the IntelligentVideo Events tab.

3. Select (place a checkmark beside) the appropriate camera.

4. Click [Modify].

5. Select a field in any of the columns.

6. Change the settings.

7. Click [OK].

Delete IntelligentVideo Settings

1. From the Video menu, select IntelligentVideo. The IntelligentVideo folder opens.

2. Click the IntelligentVideo Events tab.

3. Select (place a checkmark beside) the appropriate camera.

4. Click [Delete].

5. Click [OK].

Copy and Paste Event Settings

1. From the Video menu, select IntelligentVideo. The IntelligentVideo folder opens.

2. Click the IntelligentVideo Events tab.

3. Right-click the camera with the event settings you wish to copy and select Copy Event(s).

4. Select (place a checkmark beside) the camera you wish to paste the event settings to.
Note: To paste the event settings to multiple cameras, select the **Multiple Selection** check box, then select the additional cameras.

5. Right-click one of the selected cameras and select **Paste Event(s)** to paste all of the event settings or **Paste Special** to choose which events to paste and whether to include the channel configuration.

**Import Event Settings**

1. From the **Video** menu, select **IntelligentVideo**. The IntelligentVideo folder opens.
2. Click the IntelligentVideo Events tab.
3. Select (place a checkmark beside) the camera you wish to import event settings to.
4. Click [Modify].
5. Select the **IntelligentVideo Server** from the drop-down list.
6. Right-click in the camera list view and select **Import event(s)**.
7. Browse for the configuration file (*.xml) and click [Open].

**Export Event Settings**

1. From the **Video** menu, select **IntelligentVideo**. The IntelligentVideo folder opens.
2. Click the IntelligentVideo Events tab.
3. Select (place a checkmark beside) the camera you wish to export event settings from.
4. Right-click the camera in the list view and select **Export event(s)**.
5. Save the configuration file (*.xml).
Add an IntelligentVideo Solution

For more information, refer to the IntelligentVideo Solutions User Guide.

1. From the Video menu, select IntelligentVideo. The IntelligentVideo folder opens.
2. Click the IntelligentVideo Events tab.
3. Select (place a checkmark beside) the appropriate camera.
4. Click [Modify].
5. Select the IVS that will process images for the solution.
6. Click [Solution Configuration] and select and select Add Solution from the pop-up menu.
7. The Solution Configuration wizard is displayed. Select the desired solution from the IntelligentVideo Solution Type drop-down list and click [Next >].
8. Select the Configuration Type corresponding to the scene from the drop-down list.
9. An instance of the solution is created in the list view. The list view is used to configure a name for the alarm, set the timezone for alarm generation, and optionally configure the Out of Focus or Out of Home Position settings.
10. Click [Finish] to create the IntelligentVideo Solution Configuration.
11. Click [OK] to save the configuration.

Open the Event Configuration/Search Dialog

The Event Configuration/Search dialog can be opened using the Video Processing form or IntelligentVideo Events form (in System Administration) or using the Video Search menu option (in Video Player).
Using the Video Processing or IntelligentVideo Events form

1. Open System Administration.
2. From the Video menu, select IntelligentVideo. The IntelligentVideo folder opens.
3. Click the IntelligentVideo Events tab.
4. Select (place a check mark beside) the appropriate camera.
5. Click [Modify].
6. Click the camera icon located in the lower right side of the Event Type listing window. The Event Configuration/Search dialog opens.

Using the Video Player

1. Launch video from a camera using the Video Player.
2. Verify the recorded video is playing.
3. Click the Video Search toolbar button or from the Control menu select Video Search. The Event Configuration/Search dialog displays.

Event Configuration/Search Dialog

The Event Configuration/Search dialog is used to:

- Configure event parameters for real-time LNVR video processing and alarm generation. This includes motion detection, blind camera and brightness changes as well as events for IntelligentVideo and IntelligentAudio processing.
- Display alerts when events occur. Alerts display in three areas of the dialog:
  — In the video window, alerts display as a highlighted area.
  — In the Event Feedback pane, alerts display as a spike in the alert status graph.
  — In the alarm history pane, alerts display as thumbnails or text.
- Search LNVR recorded/archived video for the occurrence of specific events.
- View search results as a detailed list or thumbnail images.
- Play recorded video search results in the Video Player pane.
• Play live video in the Video Player pane.

The Event Configuration/Search dialog can be used with the following video sources:
• Live video
• Recorded video, accessed through a video recorder
• Exported video files

Note: When playing exported video over a network, the Windows account that the LpsSearchSvc service runs under must have permission to access the files.

Note: Different fields, buttons and event options are available, depending on how you open the Event Configuration/Search dialog.
# Event Configuration/Search Dialog Menu Options

The following table describes the menu and sub-menu options available from the Event Configuration/Search dialog.

## Event Configuration/Search Dialog - Menus

<table>
<thead>
<tr>
<th>Menu Name</th>
<th>Menu Options</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event Menu</td>
<td>Select Event</td>
<td>Enables you to select the event for which the current video source will be analyzed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> The Select Event sub-menu option is available only if you open the Event Configuration/Search dialog using the Video Player. In System Administration, you have to select an event before you can open the Event Configuration/Search dialog. Therefore, if you selected an event to open the dialog this the Select Event sub-menu option will not display.</td>
</tr>
<tr>
<td>Screen Output</td>
<td></td>
<td>Some event feedback and configuration parameters display directly on the video to help you visualize what is being (or what has been) configured. If you wish to enable this output, verify a checkmark displays beside this sub-menu option.</td>
</tr>
<tr>
<td>Load/Save Configuration</td>
<td></td>
<td>Allows you to save the current configuration and load it at a later time for the same type of event.</td>
</tr>
<tr>
<td>Copy/Paste Configuration</td>
<td></td>
<td>It is possible to copy a configuration from one event and paste it to a different event. In this case, all parameters that apply to the new event will be used. For example, the configuration for a motion detection event can be copied/pasted to an abandoned object event. In this example, the “Region of interest” parameter exists in both events, so that parameter will be saved. But the abandoned object event does not use “Threshold”, so that parameter will be ignored. Lastly, motion detection did not use the “Duration” parameter, so the original duration value for the abandoned object event will be used.</td>
</tr>
<tr>
<td>Show Advanced Configuration</td>
<td></td>
<td>Select this sub-menu item to view additional properties used for troubleshooting and diagnostics. These advanced properties are used for advanced calibration of events and should rarely be used.</td>
</tr>
</tbody>
</table>
### Event Configuration/Search Dialog - Menus (Continued)

<table>
<thead>
<tr>
<th>Menu Name</th>
<th>Menu Options</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Player Menu</td>
<td>Switch to Recorded/Live</td>
<td>Enables you to switch to and from recorded and live video.</td>
</tr>
<tr>
<td></td>
<td>Select Start/End Times</td>
<td>Displays a dialog where you can select the start and end times of a recorded video search.</td>
</tr>
<tr>
<td></td>
<td>Export Frame</td>
<td>Allows you to export the current frame into a picture file. Supported image formats are BMP, JPEG, GIF, TIFF, and PNG.</td>
</tr>
<tr>
<td></td>
<td>Play</td>
<td>Starts/resumes video playback. This command is not visible when video is playing.</td>
</tr>
<tr>
<td></td>
<td>Pause</td>
<td>Pauses playback. When video play is resumed, it continues from where it was temporarily stopped. This command is visible only when video is playing.</td>
</tr>
<tr>
<td></td>
<td>Stop</td>
<td>Stops playback and rewinds the video to the beginning.</td>
</tr>
<tr>
<td></td>
<td>Search</td>
<td>Fast-forwards through video while continuing to analyze it. This allows you to search through video faster than real-time and look for events of interest, using the Event Output and Event History panes.</td>
</tr>
<tr>
<td></td>
<td>Zoom</td>
<td>Enables you to set pre-defined (50%, 100%, and 200%) zoom levels for the video player.</td>
</tr>
<tr>
<td></td>
<td>Frame Rate</td>
<td>Sets the frame rate at which video is fed to the client side. By default, this value is set to 10 frames per second (fps). If the source video is set at a higher fps, video will be analyzed at the higher frame rate, but some frames will not be sent to the client display. This option is available when the client display is on a computer separate from the video analysis service and the network connection between client and the service is less than ideal. Reducing the frame rate will speed up processing because the server side will not have to wait for the client to consume the video frames it has sent.</td>
</tr>
</tbody>
</table>
# Event Configuration/Search Dialog Fields

The following table describes some of the configuration parameters available in the Event Configuration/Search dialog.

## Event Configuration/Search Dialog - Fields

<table>
<thead>
<tr>
<th>Pane</th>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Video Player Pane</td>
<td>Video window</td>
<td>Video playback window.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> If configuration or event feedback controls have any additional information, you may choose to draw in this window or on top of the video.</td>
</tr>
<tr>
<td>Command buttons and Status</td>
<td>Buttons at the bottom</td>
<td>Buttons at the bottom of the pane allow you to execute the same commands that are available through the menus. In addition to the menu options, the command buttons allow you to:</td>
</tr>
<tr>
<td>indicator</td>
<td>of the pane allow you</td>
<td>• Set an arbitrary zoom level for the entire video search window</td>
</tr>
<tr>
<td></td>
<td>to execute the same</td>
<td>• Search video by using the position indicator/seek bar control</td>
</tr>
<tr>
<td></td>
<td>commands that are</td>
<td>• Play, pause, and stop recorded video</td>
</tr>
<tr>
<td></td>
<td>available through the</td>
<td>• Play the video at an accelerated rate by using the search button</td>
</tr>
<tr>
<td></td>
<td>menus. In addition to</td>
<td></td>
</tr>
<tr>
<td></td>
<td>the menu options, the</td>
<td></td>
</tr>
<tr>
<td></td>
<td>command buttons allow</td>
<td></td>
</tr>
<tr>
<td></td>
<td>you to:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Set an arbitrary</td>
<td></td>
</tr>
<tr>
<td></td>
<td>zoom level for the</td>
<td></td>
</tr>
<tr>
<td></td>
<td>entire video search</td>
<td></td>
</tr>
<tr>
<td></td>
<td>window</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Search video by using</td>
<td></td>
</tr>
<tr>
<td></td>
<td>the position indicator</td>
<td></td>
</tr>
<tr>
<td></td>
<td>/seek bar control</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Play, pause, and stop</td>
<td></td>
</tr>
<tr>
<td></td>
<td>recorded video</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Play the video at an</td>
<td></td>
</tr>
<tr>
<td></td>
<td>accelerated rate by</td>
<td></td>
</tr>
<tr>
<td></td>
<td>using the search button</td>
<td></td>
</tr>
</tbody>
</table>

Indicates the current status of the IntelligentVideo engine or video processing engine. If there are problems connecting to the search server component, the status indicator will indicate the connection state and any error values encountered.

**Note:** In live video mode, most of these controls are absent since live video cannot be paused, stopped, or searched. The only option available with live video is to change the zoom level.
## Event Configuration/Search Dialog - Fields (Continued)

<table>
<thead>
<tr>
<th>Pane</th>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration Pane</td>
<td>The fields that display in the Configuration pane depend on the event selected. An event must be selected to populate the Configuration pane. For more information, refer to the IntelligentVideo User Guide.</td>
<td></td>
</tr>
<tr>
<td><strong>Region of Interest (ROI)</strong></td>
<td>The ROI identifies the area of video to be processed.</td>
<td>Click the Create a Region of Interest button and then click on the video to mark the area you wish to define.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Once the ROI has been created, use the mouse to drag and drop any of the green vertices or the entire ROI if adjustments are necessary.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Click the Delete Region Of Interest button to remove an existing ROI.</td>
</tr>
<tr>
<td><strong>Mask</strong></td>
<td>The ROI mask identifies an area of video to ignore.</td>
<td>Click on the Create a Mask button and then click on the video to mark the area you wish to ignore.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Once the mask has been created, use the mouse to drag and drop any of the green vertices or the entire mask if adjustments are necessary.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Click the Delete Mask button to remove an existing mask.</td>
</tr>
</tbody>
</table>
Event Configuration/Search Dialog - Fields (Continued)

<table>
<thead>
<tr>
<th>Pane</th>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event Feedback Pane</td>
<td>Alert status graph</td>
<td>A color-coded graphical representation of alerts. An alert is created only if the last detected event occurred more than 8 seconds ago.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> For recorded video, you can click on any part of the graph to view the corresponding video. The video search must first be stopped.</td>
</tr>
<tr>
<td>Time Range</td>
<td></td>
<td>Select the duration of time used by the graph.</td>
</tr>
<tr>
<td>Level</td>
<td></td>
<td>The current level of change. Levels range from 0 to 100. The first and last frames of an event must have a value greater than or equal to the specified level, to be included in the search results.</td>
</tr>
</tbody>
</table>
| Status Message Pane   | [17:19:25] Events Disabled: Engine Initializing | Displays messages regarding the status of the background. Statuses that can be generated include:  
  - “Events disabled: engine initializing”: Notifies that the initial background has not been acquired yet, therefore the events that require background are disabled.  
  - “New Background Image Acquired”: Notifies that a new background model was acquired [the background model is constantly learned, and it is updated every “Background learning” (the parameter) seconds]. |
| History               |                        | Displays the history of the status messages.                              |
Event Configuration/Search Dialog Procedures

Configure Event Properties

When you configure event properties, you define the parameters that make up an event. For example, duration time and object size are event properties for the “Object Left Behind” event.

Event properties are defined per event, not per channel. Therefore, you can define several unique event properties for the same event on the same video channel.

For detailed IntelligentVideo Event configuration information, refer to the IntelligentVideo User Guide.

1. Open the Event Configuration/Search dialog. For more information, refer to Open the Event Configuration/Search Dialog on page 123.
2. If you opened the Event Configuration/Search dialog using the Video Player, select the event type from the Event menu.
3. In the Event Configuration/Search dialog, the Configuration pane displays optional and required event parameters. Some parameters require you to select a check box to enable the parameter and adjust a slider to set the value of the parameter. Other parameters display as a drop-down menu from which
you select a parameter. If a button displays in the Configuration pane, then
click the button to enable the feature and adjust the values of the parameter
in the Video player pane. Advanced properties are displayed by selecting
Show Advanced Configuration from the Event menu. For more
information, refer to the IntelligentVideo User Guide.

4. Be sure to set the region of interest. For more information, refer to Set
Region of Interest on page 132.

5. If necessary, configure event parameters that apply to the video channel
itself. For more information, refer to Video Channel Configuration Dialog
on page 135.

6. Click [OK].

Set Region of Interest

The Event Configuration/Search dialog has a region of interest (ROI) button.
Although this setting is optional, it is highly recommended that ROI is used
whenever possible to reduce computation time and the probability of false
alarms. If the ROI is not set, the entire frame is considered the region of interest.

All the events except “Object Crosses a Region” and “People Counting” support
the use of ROI.

1. Open the Event Configuration/Search dialog. For more information, refer to
Event Configuration/Search Dialog on page 124.

2. If you opened the Event Configuration/Search dialog using the Video Player,
select the event type from the Event menu.
3. Click the Create Region of Interest button.

4. In the Video Player pane left-click to create a starting point for the area you want to highlight. A green dot displays.

5. Click another point in the area you want to highlight. A red line connecting the two points displays.

6. Continue clicking points to expand the highlighted area.

7. Use the mouse to drag and drop any of the green vertices or the entire ROI if adjustments are necessary.

Note: If at any time you want to remove a highlighted area, select it and click the Delete Region of Interest toolbar button.

8. Only the highlighted area is recorded or searched.
Configure Perspective Correction

The Perspective Correction mechanism is used to adjust the perceived size of an object for the 2-D image plane. It is configured on a per channel basis; once it is configured on a channel it will be used for each event on that channel that enables Perspective Size Correction. It is available for the Object Detection, Object Left Behind, Object Removed, and Loitering events.

1. Physically place a quadrangle object in the camera view. The quadrangle should have the following properties:
   • It must be parallel to the top and bottom of the video frame.
   • It should be a rectangle where the top and bottom lines represent the same real-world length.
   • It should be as large as possible.
2. Open the Event Configuration/Search dialog for the event.
3. From the Event menu, select **Show Advanced Configuration**.
4. Click the **Perspective Correction for Size** button.
5. Using the mouse, right-click each of the four corners of the rectangle located on the image plane. The area selected will be displayed as a green quadrangle.

---

**Note:**
When using the object size properties with the Perspective Correction mechanism, the Minimum and Maximum Object Sizes configured reflect the size of the object as it appears in the center of the ROI. If there is no ROI defined, the entire video frame is the ROI.

---

6. Select “Enable” from the **Use Perspective Size Correction** drop-down for each event configured on the channel that supports Perspective Size Correction.

---

**Note:**
Diagnostic modes are available to assist in the configuration of Perspective Correction for Size. For more information, refer to the IntelligentVideo User Guide.

---

Open the Video Channel Configuration Dialog

The Video Channel Configuration dialog can be opened using the IntelligentVideo Events form (System Administration) or using the Event Configuration/Search dialog available through the Video Player.
Using the IntelligentVideo Events form

1. Open System Administration.
2. From the Video menu, select IntelligentVideo. The IntelligentVideo folder opens.
3. Click the IntelligentVideo Events tab.
4. Select (place a check mark beside) the appropriate camera.
5. Click [Modify].
6. Select an IntelligentVideo Server from the drop-down list.
7. Click [Channel Configuration] (located below the camera listing window on the right side). The Video Channel Configuration dialog opens.

Using the Event Configuration/Search Dialog

1. Open the Event Configuration/Search dialog. For more information, refer to Open the Event Configuration/Search Dialog on page 123.
2. Click [Channel Configuration] (located on the lower right side of the window). The Video Channel Configuration dialog opens.

Video Channel Configuration Dialog

Video channel configuration parameters can be applied to real-time IntelligentVideo processing and to recorded video searches. The Video Channel Configuration dialog is used to configure event parameters that apply to the video channel itself and not the video processing algorithms. For example, if the source video has a lot of motion, background learning time may need to be increases so the video processing engine picks out static scene elements more accurately.
For detailed IntelligentVideo Event configuration information, refer to the IntelligentVideo User Guide.

**Video Channel Configuration Dialog**

<table>
<thead>
<tr>
<th>Form Element</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Video Channel Configuration listing window</td>
<td>Displays the video channel processing properties and user-configured values. Parameters are sorted into types. Values are modified directly in the listing window. A new value may be entered or selected from the drop-down list. Values that have been modified from the default appear in bold. Click [Explain] to read a detailed description of the selected property.</td>
</tr>
<tr>
<td>OK</td>
<td>Accepts the video channel configuration changes and closes the dialog.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Rejects the video channel configuration changes and closes the dialog.</td>
</tr>
<tr>
<td>Load Configuration</td>
<td>Displays an Open window from which you can select the “.XML” configuration file you want to load.</td>
</tr>
<tr>
<td>Save Configuration</td>
<td>Saves the set of video channel configuration parameters for reuse.</td>
</tr>
<tr>
<td>Reset to Defaults</td>
<td>Resets all parameter settings to their original default settings.</td>
</tr>
<tr>
<td>Show Parameters Only For</td>
<td>Select this check box to display only parameters which are relevant to the selected event. Only events configured for the current channel are available in the drop-down list.</td>
</tr>
<tr>
<td>Show Advanced Parameters</td>
<td>Select this check box to view additional parameters used for troubleshooting and diagnostics. The default setting hides the advanced parameters.</td>
</tr>
<tr>
<td>Explain</td>
<td>Click this button to read a detailed description of the selected property.</td>
</tr>
</tbody>
</table>
Video Channel Configuration Dialog Procedures

Configure Video Channel Parameters

Two types of parameters are available: basic and advanced. Parameters are defined per channel and for each event there is a unique set of parameters. You can set parameters by pressing the [Channel Configuration] button in the Event Configuration/Search dialog. By default, only basic parameters display. If you want to set an advanced parameter, click the Show Advanced Parameters check box. Advanced parameters should only be set by expert level administrators.

A parameter can be set by entering or selecting a value from the drop-down list in the listing window.

1. Display the Video Configuration dialog. For more information, refer to Open the Video Channel Configuration Dialog on page 134.
2. It is recommended that you select the Show Parameters Only For check box.
3. Select (highlight) a property name.
4. Select or enter the property value.
5. Repeat steps 3 and 4 for each property.
6. Click [Save Configuration] if you would like to be able to load these configurations at another time.
7. Click [OK].

IntelligentVideo Application Form

The IntelligentVideo Application Server (IV App Server) is a service whose main purpose is to provide a host environment for individual IntelligentVideo applications. The IV App Server performs the following functions:

- Provides a means to dynamically add and remove IntelligentVideo applications.
- Provides functionality common to all application such as error login, data, and configuration persistence and communications.
• Provides a base on which any number and wide range of applications can be supported in the future.

Note: Detailed configuration options appear after an application type has been selected from the drop-down list. For more information, refer to the IntelligentVideo Application Server User Guide.

### IntelligentVideo Application Server Form

<table>
<thead>
<tr>
<th>Form Element</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Listing window</td>
<td>Lists currently defined applications with the type and server name.</td>
</tr>
<tr>
<td>Name</td>
<td>A descriptive name for the application.</td>
</tr>
<tr>
<td>Online</td>
<td>If selected, the application will be online and the Communication Server will attempt to communicate with the application.</td>
</tr>
<tr>
<td>Server</td>
<td>Select the IntelligentVideo Application Server from the drop-down list.</td>
</tr>
<tr>
<td>Application Type</td>
<td>Select the type of application from the drop-down list.</td>
</tr>
<tr>
<td>Add</td>
<td>Adds an application to the system.</td>
</tr>
<tr>
<td>Modify</td>
<td>Changes the configuration of the application.</td>
</tr>
<tr>
<td>Delete</td>
<td>Removes the application from the system.</td>
</tr>
<tr>
<td>Help</td>
<td>Displays online help for this topic.</td>
</tr>
<tr>
<td>Close</td>
<td>Closes the IntelligentVideo folder.</td>
</tr>
</tbody>
</table>
**IntelligentAudio Events Form**

The IntelligentAudio Events form is used to configure events to trigger alarms in Alarm Monitoring. Currently only the Audio Level event is supported for generating alarms. Additional audio events can be used for forensic processing. For more information, refer to IntelligentAudio on page 231.

**IntelligentVideo Folder - IntelligentAudio Events Form**

<table>
<thead>
<tr>
<th>Form Element</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Camera listing window</td>
<td>Lists currently defined IP cameras and the recorders they are associated with, as well as the channel, camera type, video standard, camera IP address, camera resolution, and IVS that will process data for specific events.</td>
</tr>
<tr>
<td>IntelligentVideo Server</td>
<td>Select the name of the IVS server for the selected camera.</td>
</tr>
<tr>
<td>Status</td>
<td>Displays the status of the selected IVS.</td>
</tr>
<tr>
<td>Event Type</td>
<td>Displays the name of the configured event.</td>
</tr>
<tr>
<td>Name</td>
<td>A descriptive name for the event that will display in Alarm Monitoring. The name can be 21 characters long. Since B.A.S.I.S. supports two events of the same type, for the same camera, the name should be descriptive enough for Alarm Monitoring operators to recognize where the event occurred.</td>
</tr>
<tr>
<td>Timezone</td>
<td>The timezone during which the specified event is active. Timezones are created on the Timezones folder, which is located by selecting Timezone from the Access Control menu.</td>
</tr>
<tr>
<td>Recording</td>
<td>The type of recording that will be used. Choices include:</td>
</tr>
</tbody>
</table>

  - **Event** - increased frame rate with pre-roll for B.A.S.I.S. specific events. Event recording settings are configured on the Event Mode sub-tab of the Camera form.
  - **Normal** - continuous or time-lapsed recording. Normal recording settings are configured on the Normal Mode sub-tab of the Camera form.
Audio Level Event

The Audio Level event identifies sound events crossing a volume threshold.

Event Properties

The event properties are defined from the Event Configuration/Search dialog which is launched with the camera icon on the IntelligentAudio Events form during event configuration. For more information, refer to Event Configuration/Search Dialog on page 124.

Note: IntelligentAudio events do not have a region of interest or channel parameters.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threshold</td>
<td>Volume threshold for detection. Use the level displayed on the Event Feedback pane to determine a value appropriate to the scene.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Form Element</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarm</td>
<td>Determines whether an alarm displays in Alarm Monitoring.</td>
</tr>
<tr>
<td></td>
<td>• On - If the threshold is reached during the selected timezone, an alarm is sent from the recorder to B.A.S.I.S. and an alarm displays in Alarm Monitoring.</td>
</tr>
<tr>
<td></td>
<td>• Off - If the threshold is reached during the selected timezone an alarm will not be active (sent to B.A.S.I.S.) nor will it display in Alarm Monitoring.</td>
</tr>
<tr>
<td>Modify</td>
<td>Changes the event settings for the selected camera.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes all configured events for the selected camera. Only the [Delete] button can be used with the Multiple Selection check box.</td>
</tr>
<tr>
<td>Help</td>
<td>Displays online help for this topic.</td>
</tr>
<tr>
<td>Multiple Selection</td>
<td>Select this check box to select multiple entries in the listing window. Multiple selection only applies to the delete option.</td>
</tr>
<tr>
<td>Close</td>
<td>Closes the IntelligentVideo folder.</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Minimal Duration</td>
<td>Length of time that sound should continue before an event is detected. The</td>
</tr>
<tr>
<td>(seconds)</td>
<td>range of values is 0.010 to 10.000 seconds.</td>
</tr>
</tbody>
</table>
Add IntelligentAudio Event Settings

1. From the Video menu, select IntelligentVideo. The IntelligentVideo folder opens.
2. Click the IntelligentAudio Events tab.
3. Select (place a checkmark beside) the appropriate camera.
4. Click [Modify].
5. Select the IVS that will process images for the events.
6. With your cursor in the Event Type column, right-click and select “Add”.

<table>
<thead>
<tr>
<th>Event Type</th>
<th>Name</th>
<th>Timezone</th>
<th>Recording</th>
<th>Alarm</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

7. Select the event type from the drop-down list.

<table>
<thead>
<tr>
<th>Event Type</th>
<th>Name</th>
<th>Timezone</th>
<th>Recording</th>
<th>Alarm</th>
</tr>
</thead>
<tbody>
<tr>
<td>AudioLevel</td>
<td>Type name here</td>
<td>Always</td>
<td>Named</td>
<td>On</td>
</tr>
</tbody>
</table>

8. Select the field that displays under the Name column. Enter a descriptive name that will be appended to the alarm description in Alarm Monitoring (when this event occurs).

<table>
<thead>
<tr>
<th>Event Type</th>
<th>Name</th>
<th>Timezone</th>
<th>Recording</th>
<th>Alarm</th>
</tr>
</thead>
<tbody>
<tr>
<td>AudioLevel</td>
<td>Type name here</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

9. Select the field in the Timezone column. A drop-down list displays. Select the timezone during which the IntelligentAudio settings apply.

<table>
<thead>
<tr>
<th>Event Type</th>
<th>Name</th>
<th>Timezone</th>
<th>Recording</th>
<th>Alarm</th>
</tr>
</thead>
<tbody>
<tr>
<td>AudioLevel</td>
<td>Front lobby camera</td>
<td>Always</td>
<td>Named</td>
<td>On</td>
</tr>
</tbody>
</table>

10. Select the field in the Recording column. A drop-down list displays. Select the type of recording settings to use.

<table>
<thead>
<tr>
<th>Event Type</th>
<th>Name</th>
<th>Timezone</th>
<th>Recording</th>
<th>Alarm</th>
</tr>
</thead>
<tbody>
<tr>
<td>AudioLevel</td>
<td>Front lobby camera</td>
<td>Always</td>
<td>Named</td>
<td>On</td>
</tr>
</tbody>
</table>

11. Select the field in the Alarm column. A drop-down list displays. Select
whether an alarm will display in Alarm Monitoring or not.

12. To configure event specific parameters, click the camera icon to the right of the Alarm column. For more information, refer to Event Configuration/Search Dialog on page 124.

13. Click [OK].

**Modify IntelligentAudio Settings**

1. From the **Video** menu, select **IntelligentVideo**. The IntelligentVideo folder opens.

2. Click the IntelligentAudio Events tab.

3. Select (place a checkmark beside) the appropriate camera.

4. Click [Modify].

5. Select a field in any of the columns.

6. Change the settings.

7. Click [OK].

**Delete IntelligentAudio Settings**

1. From the **Video** menu, select **IntelligentVideo**. The IntelligentVideo folder opens.

2. Click the IntelligentAudio Events tab.

3. Select (place a checkmark beside) the appropriate camera.

4. Click [Delete].

5. Click [OK].
Chapter 4: Matrix Switcher Folder

The folder contains two forms: the Matrix Switcher form and the Matrix Switcher Type form.

**Toolbar Shortcut**

The Matrix Switcher folder is displayed by selecting **Matrix Switcher** from the **Video** menu, or by selecting the Matrix Switchers toolbar button.

**Matrix Switcher Overview**

Matrix switchers enable Pan, Tilt, and Zoom (PTZ) control for LDVR recorders. Other Lenel video recorders do not require matrix switchers for PTZ control.

The Matrix Switcher folder contains forms with which you can configure real and virtual matrix switchers, as well as matrix switcher types. Real matrix switchers can be used with any B.A.S.I.S. supported camera or PTZ housing unit. Virtual matrix switchers can be used with Pelco Spectra Dome III cameras. Virtual matrix switchers are configured just like the real matrix switchers.

**Matrix Switcher Form**
Matrix Switcher Form Field Table

Matrix Switcher Folder - Matrix Switcher Form

<table>
<thead>
<tr>
<th>Form Element</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Listing window</td>
<td>Lists currently defined matrix switchers, the name of the workstation connected to each, and the segment each is in (if segmentation is enabled).</td>
</tr>
<tr>
<td>Name</td>
<td>Enter a descriptive name for the matrix switcher. This is a “friendly” name assigned to each switcher to make it easy to identify. Each name must be unique and can contain no more than 32 characters.</td>
</tr>
<tr>
<td>Online</td>
<td>If selected, the matrix switcher will be online. Online indicates that the switcher is ready for use, and that the Communication Server will attempt to communicate with it. If the switcher is not marked as online, the Communication Server will not attempt to communicate with it.</td>
</tr>
<tr>
<td>Matrix Switcher Type</td>
<td>Select the matrix switcher type from the drop-down list. Choices in the list depend on what types were configured on the Matrix Switcher Type form.</td>
</tr>
<tr>
<td>Communication Parameters</td>
<td>Includes the [Browse] button, as well as the Workstation, COM Port, Baud Rate, Byte Size, Parity, and Stop Bits fields.</td>
</tr>
<tr>
<td>Workstation</td>
<td>Select the workstation or server to which the matrix switcher is connected in order to transfer information. This is the workstation on which the Communication Server will run. You can either type the name in the field or use the [Browse] button to view a list of available workstations. Note: You are required to enter the workstation’s NetBIOS name. (The NetBIOS name is specified when Windows networking is installed/configured.)</td>
</tr>
<tr>
<td>Browse</td>
<td>Opens a Browse for Computer window, from which you can click on the name of a workstation.</td>
</tr>
<tr>
<td>Direct (COM)</td>
<td>Select this radio button if the workstation will be directly connected to the matrix switcher. If selected, specify the COM Port, Baud Rate, Byte Size, Parity, and Stop Bits.</td>
</tr>
<tr>
<td>COM Port</td>
<td>This field is only available for selection when the Direct (COM) radio button is selected. Specify the port that’s on the serial expansion unit or the back of the workstation. To each port you can assign only one matrix switcher. Choose a value in the range of 1 through 255.</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>This field is only available for selection when the Direct (COM) radio button is selected. Select the rate, in bits per second (bps), at which data is transferred via the communication port.</td>
</tr>
<tr>
<td>Byte Size</td>
<td>This field is only available for selection when the Direct (COM) radio button is selected. Select the byte size of data transferred via the communication port. You can choose a value in the range of 4 through 8.</td>
</tr>
<tr>
<td>Parity</td>
<td>This field is only available for selection when the Direct (COM) radio button is selected. Select the parity of data transferred via the communication port.</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>This field is only available for selection when the Direct (COM) radio button is selected. Select the number of stop bits used in data transmission via the communication port.</td>
</tr>
<tr>
<td>LAN</td>
<td>Select this radio button if the workstation will communicate with the matrix switcher over a Local Area Network. You must also specify the workstation’s IP Address.</td>
</tr>
</tbody>
</table>
Matrix Switcher Folder - Matrix Switcher Form (Continued)

<table>
<thead>
<tr>
<th>Form Element</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>IP address</td>
<td>If you selected the LAN radio button, enter here the Internet Protocol (TCP/IP) address for the matrix switcher, as provided by your LAN Network Administrator. An IP address consists of four numbers, each in the range of 0 through 255. A period separates each number.</td>
</tr>
<tr>
<td>Add</td>
<td>Adds a matrix switcher record.</td>
</tr>
<tr>
<td>Modify</td>
<td>Changes a matrix switcher record.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes a matrix switcher record.</td>
</tr>
<tr>
<td>Help</td>
<td>Displays online help for this form.</td>
</tr>
<tr>
<td>Mode</td>
<td>In view mode, indicates the record/selection count (such as “1 of 42 selected”). In modify mode, indicates the current operation, such as “Modify Mode.”</td>
</tr>
<tr>
<td>Close</td>
<td>Closes the Matrix Switcher folder.</td>
</tr>
</tbody>
</table>

Matrix Switcher Form Procedures

Add a Matrix Switcher (Real and Virtual)

Complete this procedure for either virtual or real matrix switchers.

Note: You may need to add or modify an existing matrix switcher type before adding a matrix switcher. For more information, refer to Add a Matrix Switcher Type on page 150.

1. From the Video menu, select Matrix Switchers.
2. On the Matrix Switcher tab, click [Add].
3. If segmentation is not enabled, skip this step. If segmentation is enabled:
   a. The Segment Membership window will open. Select the segment that this permission group will be assigned to.
   b. Click [OK].
4. In the Name field, type a unique, descriptive name for the matrix switcher.
5. Select a type from the Matrix Switcher Type drop-down list. If using a virtual matrix switcher select the pre-defined Pelco “D” protocol.
6. If you want to place the matrix switcher online immediately, select the Online check box. Typically, you wouldn’t check this box when configuring
the system or defining switchers, but instead would wait until you’re ready to put the switcher into service.

7. Complete the **Communication Parameters** section with respect to the workstation and camera connected to the matrix switcher.

8. Click [OK].

9. Link the camera(s) to the matrix switcher in the Digital Video folder > Camera form > Communication sub-tab. For more information, refer to Camera Form (Communication Sub-tab) on page 44.

**Note:** For more information regarding virtual matrix switchers refer to the Digital Video Hardware User Guide.

---

**Modify a Matrix Switcher (Real and Virtual)**

1. In the listing window, select the matrix switcher entry you wish to change.
2. Click [Modify].
3. Make the changes you want to the fields.
4. Click [OK] to save the changes, or [Cancel] to revert to the previously saved values.
5. Click [OK] to confirm the modification.

**Delete a Matrix Switcher (Real and Virtual)**

1. In the listing window, select the matrix switcher entry you wish to delete.
2. Click [Delete].
3. Click [OK].
4. Click [OK] to confirm the deletion.
Matrix Switcher Type Form

The Matrix Switcher Type form contains five pre-defined sets of protocols. Users can add new protocols or customize existing ones.

- **American Dynamics Protocol** - Binary based protocol, used for virtual matrix switchers
- **Bosch Protocol** - Binary based protocol, used for virtual matrix switchers
- **Pelco** - ASCII character based protocol, used for real matrix switchers
- **Vicon** - ASCII character based protocol, used for real matrix switchers
- **Pelco “D” Protocol** - Binary based protocol, used for virtual matrix switchers

Matrix Switcher Folder - Matrix Switcher Type Form

<table>
<thead>
<tr>
<th>Form Element</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Listing window</td>
<td>Lists currently defined matrix switcher types.</td>
</tr>
<tr>
<td>Name</td>
<td>Enter a descriptive name for the matrix switcher type. This is a “friendly” name assigned to each matrix switcher type to make it easy to identify. Each name must be unique and can contain no more than 32 characters.</td>
</tr>
<tr>
<td>Command fields</td>
<td>The input in these fields allow you to control a camera connected to the matrix switcher. B.A.S.I.S. databases created by the Database Setup application default to commands entered into the command fields for Pelco and Vicon switchers. For more information, refer to Custom Command Grammar for Matrix-based Systems on page 151.</td>
</tr>
<tr>
<td>Add</td>
<td>Adds a matrix switcher type record.</td>
</tr>
<tr>
<td>Modify</td>
<td>Changes a matrix switcher type record.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes a matrix switcher type record.</td>
</tr>
<tr>
<td>Help</td>
<td>Displays online help for this form.</td>
</tr>
<tr>
<td>Close</td>
<td>Closes the Matrix Switcher folder.</td>
</tr>
</tbody>
</table>
Matrix Switcher Type Form Procedures

Add a Matrix Switcher Type

1. From the Video menu, select Matrix Switchers.
2. On the Matrix Switcher Type tab, click [Add].
3. In the Name field, type a unique, descriptive name for the matrix switcher type.
4. B.A.S.I.S. databases created by the Database Setup application default to commands entered into the command fields for matrix switchers. For more information, refer to Custom Command Grammar for Matrix-based Systems on page 151.
5. Click [OK].
6. Now you are ready to add a matrix switcher. For more information, refer to Add a Matrix Switcher (Real and Virtual) on page 147.

Modify a Matrix Switcher Type

1. In the listing window, select the matrix switcher type entry you wish to change.
2. Click [Modify].
3. Make the changes you want to the fields.
4. Click [OK] to save the changes, or [Cancel] to revert to the previously saved values.
5. Click [OK] to confirm the modification.

Delete a Matrix Switcher Type

1. In the listing window, select the matrix switcher type entry you wish to delete.
2. Click [Delete].
3. Click [OK].
4. Click [OK] to confirm the deletion.
Custom Command Grammar for Matrix-based Systems

B.A.S.I.S. includes two default real matrix switcher types: Vicon and Pelco. If you wish to customize the commands, refer to your matrix switcher’s documentation and to the ASCII Character Chart. For more information, refer to Appendix F: ASCII Character Chart on page 1613.

Matrix-based systems use ASCII commands. These commands are converted to the correct protocol required by the camera at the matrix switcher, and are then used to control PTZ cameras. On a very simple level, this is the path a command takes when a matrix-based system is used with B.A.S.I.S. to control a PTZ camera:

Unfortunately, not all matrix switcher protocols send ASCII only commands. Many protocols need to send carriage returns, escape sequences, non-printable characters, or line feeds at the end of a control sequence. Below is a list of variables used within the commands to allow the commands to control the camera at the proper speed, operate the proper preset, etc. from within Alarm Monitoring:

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;%c&gt;</code></td>
<td>Escape sequence representing the replacement of the <code>&lt;%c&gt;</code> with the channel number of the camera the command should act on.</td>
</tr>
<tr>
<td><code>&lt;%m&gt;</code></td>
<td>Escape sequence representing the replacement of the <code>&lt;%m&gt;</code> with the monitor number (used in the switch camera x to monitor y command).</td>
</tr>
<tr>
<td><code>&lt;%p&gt;</code></td>
<td>Escape sequence representing the replacement of the <code>&lt;%p&gt;</code> with the preset number to go to.</td>
</tr>
<tr>
<td><code>&lt;%s&gt;</code></td>
<td>Escape sequence representing the replacement of the <code>&lt;%s&gt;</code> with the speed number.</td>
</tr>
<tr>
<td><code>&lt;\nnn&gt;</code></td>
<td><code>&lt;\nnn&gt;</code> is an ASCII decimal representation of an ASCII character code. During transmission, this is converted to an ASCII character. The “nnn” should be in the form of “0” - “255.” For example, <code>&lt;\013&gt;</code> is converted to a carriage return.</td>
</tr>
<tr>
<td>All other characters</td>
<td>All other characters are to be treated as literal characters and sent as is out the RS-232 COM port.</td>
</tr>
<tr>
<td><code>&lt;min=nn&gt;</code></td>
<td>Lower range for speed if command takes a speed parameter. Note that this value is used internally by the system and is not sent down as part of the command. If the switcher you are connecting to supports a speed range from 1 to 100, this parameter is not required. This command only applies to PTZ controls. It does not apply for Iris or Focus commands.</td>
</tr>
<tr>
<td><code>&lt;max=nn&gt;</code></td>
<td>Upper range for speed if command takes a speed parameter. Note that this value is used internally by the system and is not sent down as part of the command. If the switcher you are connecting to supports a speed range from 1 to 100, this parameter is not required. This command only applies to PTZ controls. It does not apply for Iris or Focus commands.</td>
</tr>
</tbody>
</table>
Examples:

The command to tell a Pelco switcher to pan camera 1 left at a speed of 10, would be:

<%c>#a<%s>La<min=1><max=64>

The min and max values are added because the Pelco matrix switcher only allows speeds in the range of 1-64. The video player will send speeds in a percentage from 1-100, based on the distance of the mouse from the center when the command was sent. The Communication Server will interpolate the percentage into the allowable range.

Note: Some matrix switchers require a mandatory character length for their channel, monitor, preset, and speed numbers. In these cases, commands are sent to the switcher with the total number of mandatory characters. When the number of characters in the channel, monitor, preset, or speed number does not amount to the mandatory character length (represented by “n” in the escape sequence), the number is padded with one or more zeros. When required, escape sequences can be padded with up to 10 pad characters (zeros).

If “n” represents the number “2” in the escape sequence <%sn>, then 2 is the total number of characters that are sent to the matrix switcher. Therefore, if the speed number is 1-9, then that number is preceded (padded) by a “0”.

- When the speed number is 4: <%s2> = 04
- When the speed number is 12: <%s2> = 12

If “n” represents the number “3” in the escape sequence <%mn>, then 3 is the total number of characters that are sent to the matrix switcher. Therefore, monitor numbers 1-9 are preceded (padded) by “00”. Monitor numbers 10-99 are preceded (padded) by “0”.

- When the monitor number is 6: <%m3> = 006
- When the monitor number is 58: <%m3> = 058
- When the monitor number is 105: <%m3> = 105

Custom Command Grammar for Direct PTZ Systems

Note: Custom command programming for direct PTZ systems is very complex and may not work with all devices. Configuration of these systems is not recommended without the involvement of Lenel’s software engineers.
Direct PTZ systems do not use an actual physical matrix switcher. Instead, binary commands may be used to directly control a PTZ camera. On a very simple level, this is the path a command takes when a direct PTZ system is used with B.A.S.I.S. to control a PTZ camera:

![Direct PTZ Systems](image)

“D” Protocol

“D” protocol is used between matrix switching systems and receivers (cameras). The default Pelco “D” Protocol matrix switcher type uses this protocol.

“D” Protocol Message Format

The format for a message is:

<table>
<thead>
<tr>
<th>Byte 1</th>
<th>Byte 2</th>
<th>Byte 3</th>
<th>Byte 4</th>
<th>Byte 5</th>
<th>Byte 6</th>
<th>Byte 7</th>
</tr>
</thead>
<tbody>
<tr>
<td>Synch Byte</td>
<td>Address</td>
<td>Command 1</td>
<td>Command 2</td>
<td>Data 1</td>
<td>Data 2</td>
<td>Check Sum</td>
</tr>
</tbody>
</table>

All values below are shown in hexadecimal (base 16).

The synchronization byte is always $FF$.

The address is the logical address of the receiver/driver being controlled.

The check sum is the 8 bit (modulo 256) sum of the payload bytes (bytes 2 through 6) in the message. This is generated by the B.A.S.I.S. system.

“D” Protocol Standard Command Set

Command 1 and 2 are as follows:

<table>
<thead>
<tr>
<th>Command</th>
<th>Byte 7</th>
<th>Byte 6</th>
<th>Byte 5</th>
<th>Byte 4</th>
<th>Byte 3</th>
<th>Byte 2</th>
<th>Byte 1</th>
<th>Byte 0</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Sense</td>
<td>Reserved</td>
<td>Reserved</td>
<td>Auto/ Manual Scan</td>
<td>Camera On/Off</td>
<td>Iris Close</td>
<td>Iris Open</td>
<td>Focus Near</td>
</tr>
<tr>
<td>2</td>
<td>Focus</td>
<td>Far</td>
<td>Zoom Wide</td>
<td>Zoom Tele</td>
<td>Down</td>
<td>Up</td>
<td>Left</td>
<td>Right</td>
</tr>
</tbody>
</table>

The sense bit (command 1 bit 7) indicates the meaning of bits 4 and 3. If the sense bit is on, and bits 4 and 3 are on, the command will enable auto-scan and turn the camera on. If the sense bit is off and bits 4 and 3 are on the command will enable manual scan and turn the camera off. Of course, if either bit 4 or bit 3 are off then no action will be taken for those features.

The reserved bits (6 and 5) should be set to 0.
Word 5 contains the pan speed. Pan speed is in the range $00$ (stop) to $3F$ (high speed) and $FF$ for “turbo” speed. Turbo speed is the maximum speed the device can obtain and is considered separately because it is not generally a smooth step from high speed to turbo. That is, going from one speed to the next usually looks smooth and will provide for smooth motion with the exception of going into and out of turbo speed.

Word 6 contains the tilt speed. Tilt speed is in the range $00$ (stop) to $3F$ (maximum speed).

Word 7 is the check sum. The check sum is the sum of bytes (excluding the synchronization byte) modulo 256.
## Matrix Switcher Variable Designations

<table>
<thead>
<tr>
<th>Control Variable</th>
<th>Standard (Hardware) Commands (Vicon shown)</th>
<th>ASCII Variables</th>
<th>Protocol D commands</th>
<th>Binary Variables</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Camera</strong></td>
<td>%c</td>
<td></td>
<td></td>
<td>%b</td>
</tr>
<tr>
<td><strong>Initialization</strong></td>
<td>&lt;\1&gt;A001&lt;\13&gt;</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Pan left</strong></td>
<td>&lt;\1&gt;B-%c&lt;\13&gt;&lt;1&gt;-%s&lt;\13&gt;&lt;min=1&gt;&lt;max =100&gt;</td>
<td>&lt;255&gt;%b&lt;000&gt;&lt;004&gt;&lt;%v&gt;&lt;000&gt;&lt;%a&gt;&lt;000&gt;&lt;max=63&gt;</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Pan right</strong></td>
<td>&lt;\1&gt;B-%c&lt;\13&gt;&lt;1&gt;-J&lt;%s&gt;&lt;\13&gt;&lt;min=1&gt;&lt;max =100&gt;</td>
<td>&lt;255&gt;%b&lt;000&gt;&lt;002&gt;&lt;%v&gt;&lt;000&gt;&lt;%a&gt;&lt;000&gt;&lt;max=63&gt;</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Tilt up</strong></td>
<td>&lt;\1&gt;B-%c&lt;\13&gt;&lt;1&gt;-M&lt;%s&gt;&lt;\13&gt;&lt;min=1&gt;&lt;max =100&gt;</td>
<td>&lt;255&gt;%b&lt;000&gt;&lt;008&gt;&lt;%v&gt;&lt;%a&gt;&lt;000&gt;&lt;max=63&gt;</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Tilt down</strong></td>
<td>&lt;\1&gt;B-%c&lt;\13&gt;&lt;1&gt;-L&lt;%s&gt;&lt;\13&gt;&lt;min=1&gt;&lt;max =100&gt;</td>
<td>&lt;255&gt;%b&lt;000&gt;&lt;016&gt;&lt;%v&gt;&lt;%a&gt;&lt;000&gt;&lt;max=63&gt;</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Zoom in</strong></td>
<td>&lt;\1&gt;B-%c&lt;\13&gt;&lt;1&gt;-O&lt;\13&gt;</td>
<td>&lt;255&gt;%b&lt;000&gt;&lt;032&gt;&lt;%a&gt;&lt;000&gt;&lt;000&gt;</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Zoom out</strong></td>
<td>&lt;\1&gt;B-%c&lt;\13&gt;&lt;1&gt;-N&lt;\13&gt;</td>
<td>&lt;255&gt;%b&lt;000&gt;&lt;064&gt;&lt;%a&gt;&lt;000&gt;&lt;000&gt;</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Focus near</strong></td>
<td>&lt;\1&gt;B-%c&lt;\13&gt;&lt;1&gt;-P&lt;\13&gt;</td>
<td>&lt;255&gt;%b&lt;001&gt;&lt;%a&gt;&lt;000&gt;&lt;000&gt;</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Focus far</strong></td>
<td>&lt;\1&gt;B-%c&lt;\13&gt;&lt;1&gt;-Q&lt;\13&gt;</td>
<td>&lt;255&gt;%b&lt;000&gt;&lt;128&gt;&lt;%a&gt;&lt;000&gt;&lt;000&gt;</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Iris open</strong></td>
<td>&lt;\1&gt;B-%c&lt;\13&gt;&lt;1&gt;-S&lt;\13&gt;</td>
<td>&lt;255&gt;%b&lt;002&gt;&lt;%a&gt;&lt;000&gt;&lt;000&gt;</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Iris close</strong></td>
<td>&lt;\1&gt;B-%c&lt;\13&gt;&lt;1&gt;-R&lt;\13&gt;</td>
<td>&lt;255&gt;%b&lt;004&gt;&lt;%a&gt;&lt;000&gt;&lt;000&gt;</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Preset</strong></td>
<td>&lt;\1&gt;B-%c&lt;\13&gt;&lt;1&gt;-G&lt;%p&gt;&lt;\13&gt;</td>
<td>%p</td>
<td>&lt;255&gt;%b&lt;000&gt;&lt;007&gt;&lt;%st&gt;&lt;%a&gt;&lt;000&gt;</td>
<td>%t</td>
</tr>
<tr>
<td><strong>Stop PTZ</strong></td>
<td>&lt;\1&gt;B-%c&lt;\13&gt;&lt;1&gt;-13&gt;</td>
<td>&lt;255&gt;%b&lt;000&gt;&lt;000&gt;&lt;%x&gt;&lt;000&gt;</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Speed</strong></td>
<td>%s</td>
<td></td>
<td></td>
<td>%v</td>
</tr>
<tr>
<td><strong>Switch Camera to Monitor</strong></td>
<td>&lt;\1&gt;A-%m&lt;\13&gt;&lt;1&gt;B-%c&gt;&lt;\13&gt;</td>
<td>%m</td>
<td>N/A</td>
<td></td>
</tr>
<tr>
<td><strong>Checksum for Protocol D</strong></td>
<td>&lt;\1&gt;B-%c&gt;&lt;\13&gt;</td>
<td></td>
<td></td>
<td>%x</td>
</tr>
</tbody>
</table>
ASCII Protocol Example: Pan Left

Select camera  \(<1>B<%c><13>\)
Pan left (I)  \(<1>I<%s><13>\)
At speed (1-100)  \(<\text{min}=1><\text{max}=100>\)

Binary ("D" Protocol) Example: Pan Left

Sync byte  \(<255>\)
Logical cam address  \(<%b>\)
Command 1 (dec)  \(<000>\)
Command 2 (dec)  \(<004>\)
Data 1  \(<%v>\)
Data 2  \(<000>\)
Check sum  \(<%x>\)
At speed (0-63)  \(<\text{min}=0><\text{max}=63>\)

For more information, refer to the Pelco "D" Protocol Manual.
Alarm Monitoring
Chapter 5: Video Monitoring

CCTV is an acronym for Closed Circuit TeleVision. Video monitoring is the process of viewing “live” (as it is happening) video or previously recorded video using CCTV cameras and monitors. You can monitor video through the Alarm Monitoring and VideoViewer applications. This chapter describes the windows available in both of these applications and the procedures you can perform.

The Video Monitoring window is available in the Alarm Monitoring application and displays live video only.

The Video Monitoring window performs the following function:
- Displays live video from one camera at any given time.

**Toolbar Shortcut**

The Video Monitoring window is displayed by:
- Selecting the Video Monitoring toolbar button.
- Selecting View > Video Monitoring from the menu.

### Video Monitoring Window

- **Device Groups listing**
  - Lists the available video device groups. A device group can contain devices from more than one access panel.
  - Device groups can also be segmented and belong either to one segment or all segments. If a device group belongs to only one segment, the group will contain only devices associated with the access panel defined for that segment.

- **Display area**
  - Displays a specific camera view - live.
Video Monitoring Window Procedures

Set up an Alarm Monitoring Station to View Video

Alarm monitoring stations can be set up so that if available, you can view video associated with an event/alarm. Use the following checklist as a guide to setting up an existing Alarm Monitoring workstation to receive and view video associated with alarms.

Note: This checklist assumes that System, Cardholder User, and Monitoring permissions have already been configured in System Administration or ID CredentialCenter. Permissions are configured via the Administration > Users menu.

- **Add a workstation.** To establish an IP address for your Alarm Monitoring workstation refer to the “Video Recorder Form Procedures” in the Digital Video Folder chapter.

- **Add a camera.** To add a camera or a group of cameras to a recorder refer to the “Camera Form Procedures” in the Digital Video Folder chapter.

⚠️ **Warning**

When adding a surveillance-only camera be sure to enter a valid administrator user name and password, and select the correct camera type. No error message displays in System Administration if an invalid or non-administrator user name, password or camera type is given. The camera will be marked offline in Alarm Monitoring and a message will display in the Communication Server window.

- **Link hardware devices to a camera.** To link hardware devices (readers, motion detectors etc.) with a camera please refer to the “Add a Device - Camera Link on page 88” in the Digital Video Folder chapter in the System Administration or Digital Video Software User Guide.

- **Alarm -Video configuration.** To associate an alarm with video please refer to the “Configure Video and Alarms on page 92”.

If you have monitoring zones established:

- **Add a video recorder to a monitoring zone.** To add a video recorder to a monitoring zone please refer to the “Add a Monitor Zone” in the Monitor Zone Folder chapter in the System Administration User Guide.

- **Enable monitoring zone access from a workstation.** To enable access to a monitoring zone please refer to the “Add a Monitoring Assignment” in the Monitor Zone Folder chapter in the System Administration User Guide.

View the Video Tour

The Video Tour is available in Alarm Monitoring and used to view a group of cameras successively. These cameras are defined as a device group in the Groups
folder of System Administration. (Select the **Access Control > Groups** menu option from System Administration. Click the Device Groups tab and create a device group containing the desired cameras). The Video Tour feature is only available for online cameras/recorders.

*Toolbar Shortcut*

1. Launch the Video Monitoring window by either selecting the Video Monitoring toolbar button or choosing **Video Monitoring** from the **View** menu.
2. Verify the cameras/recorders are online. If the device icon does not have a red “X” through it the device is online.
3. Right-click a camera device group and select **Configure Video**. The Video Tour window displays.

4. Select the desired View time and click [OK]. This is the amount of time each camera is displayed in the tour.
5. Right-click the camera device group again and select **Start Tour**. The right side of the window displays the camera views.

*Video Player*

The Video Player is available in the Alarm Monitoring and VideoViewer applications, although its features in these applications is slightly different.

The Video Player performs the following functions in the Alarm Monitoring and VideoViewer applications:

- Displays live or recorded video from one camera
- Displays live or recorded video from a group of cameras successively
- Displays video from a group of cameras or a recorder simultaneously.
- Displays recorded video associated with a video search
- Enables you to pan, tilt and zoom recorded and live video
- Plays video clips with a time stamp on any computer (VideoViewer application only)

The Video Player (in Alarm Monitoring) is displayed by right-clicking an alarm, device, camera or camera device group and selecting **Launch Video**. The Video Player (in VideoViewer) is displayed by selecting **As Player** from the **View** menu.
**Video Player in Alarm Monitoring**

![Diagram of Video Player in Alarm Monitoring](image1)

**Video Player in VideoViewer**

![Diagram of Video Player in VideoViewer](image2)
Note: Refer to the Video Player Status Bar Table on page 164 for the descriptions of the status bar components, A-F.

### Video Player Menu and Toolbar Buttons Table

<table>
<thead>
<tr>
<th>Field</th>
<th>Toolbar button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Play menu</td>
<td></td>
<td>Contains the following menu options:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Live: Plays live video from one or several cameras depending on the view settings.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Recorded: Plays recorded video for the selected camera(s).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>File: Plays video clips from a file.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> A checkmark displays beside the option that is active.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Load Layout:</strong> Restore a previously saved video matrix layout.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Save Layout:</strong> Save the current video matrix view as a new layout.</td>
</tr>
<tr>
<td>Control menu</td>
<td></td>
<td>Contains several options to play, pause and stop video as well as advance video, adjust playback speed, search video, mute audio and remove cameras from the Video Player window.</td>
</tr>
<tr>
<td>Options menu</td>
<td></td>
<td>Contains options to load video files, set start/end times to view recorded video, export video to a file, capture images from video, create video events, modify video performance (frame rate, quality, and video acceleration), and configure PTZ tours and presets.</td>
</tr>
<tr>
<td>View menu</td>
<td></td>
<td>Contains options to change how cameras views are displayed.</td>
</tr>
<tr>
<td>Play button</td>
<td><img src="image" alt="Play button" /></td>
<td>Plays recorded video.</td>
</tr>
<tr>
<td>Pause button</td>
<td><img src="image" alt="Pause button" /></td>
<td>Pauses or temporarily stops playing recorded video. The video will continue from where it temporarily stopped when the play button is clicked.</td>
</tr>
<tr>
<td>Stop button</td>
<td><img src="image" alt="Stop button" /></td>
<td>Stops playing recorded video and resets the player to the beginning of the video.</td>
</tr>
<tr>
<td>Frame Advance button</td>
<td><img src="image" alt="Frame Advance button" /></td>
<td>Advances video one frame at a time.</td>
</tr>
<tr>
<td>Fast Forward End button</td>
<td><img src="image" alt="Fast Forward End button" /></td>
<td>Advances (fast forwards) video to the last frame.</td>
</tr>
<tr>
<td>Search Video button</td>
<td><img src="image" alt="Search Video button" /></td>
<td>Displays the Event Configuration/Search dialog. This option is only available when the Video Player is playing recorded video. For more information, refer to Video Player on page 161.</td>
</tr>
<tr>
<td>Remove</td>
<td><img src="image" alt="Remove button" /></td>
<td>Deletes the selected camera view(s) from the display window. The camera is NOT deleted from the Tree, List or Group listing.</td>
</tr>
<tr>
<td>Previous Camera</td>
<td><img src="image" alt="Previous Camera" /></td>
<td>Displays the previous camera view. This feature only applies when you have opened multiple images and the Video Player is in single view mode.</td>
</tr>
</tbody>
</table>
5: Video Monitoring

Video Player Menu and Toolbar Buttons (Continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Toolbar button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Next Camera</td>
<td>![next-camera-icon]</td>
<td>Displays the next view. This feature only applies when you have opened the Video Player so that you can view multiple images and you are currently in single view.</td>
</tr>
<tr>
<td>Video Layout</td>
<td>![video-layout-icon]</td>
<td>Displays the selected visual matrix of video cells. Options include single view, matrix view, and static templates (1x1, 2x2, 3x3, 4x4, 13+1, 1+5, and 5+1).</td>
</tr>
<tr>
<td>Activate PTZ</td>
<td>![ptz-icon]</td>
<td>Enables PTZ commands for supported cameras. For more information, refer to Pan, Tilt, and Zoom on page 192.</td>
</tr>
<tr>
<td>Display window</td>
<td>![display-window-icon]</td>
<td>Displays live or previously recorded video.</td>
</tr>
<tr>
<td>Status bar</td>
<td></td>
<td>For information on the status bar please refer to Video Player Status Bar Table on page 164.</td>
</tr>
</tbody>
</table>

Video Player Status Bar Table

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>When live video is playing the status bar displays the camera name.</td>
</tr>
<tr>
<td></td>
<td>If an LNVR is offline, the video player can connect directly to an IP camera to display live video. A direction connection to the IP camera is indicated in the video player status bar by a ![direction-icon] icon.</td>
</tr>
<tr>
<td></td>
<td>When recorded video is playing the status bar contains two arrow heads ![arrow-heads-icon]. You can click the arrow heads to change the information displayed to any of the following:</td>
</tr>
<tr>
<td></td>
<td>• Camera name</td>
</tr>
<tr>
<td></td>
<td>• Video start date and time</td>
</tr>
<tr>
<td></td>
<td>• Video start date/time and end date/time</td>
</tr>
<tr>
<td>B</td>
<td>Move the slider back and forth to view video at different dates/times. You do not need to pause or stop video to use the video display slider.</td>
</tr>
<tr>
<td></td>
<td>Note: Cameras configured with an LNVR recorder display different colors in the slider for different types of recorded video.</td>
</tr>
<tr>
<td></td>
<td>• Red - video is not available (e.g. a download was performed, LNVR was disconnected or restarted)</td>
</tr>
<tr>
<td></td>
<td>• White - video is not being recorded (e.g. time lapse recording)</td>
</tr>
<tr>
<td></td>
<td>• Green - video is being recorded (e.g. continuous recording or time lapse recording)</td>
</tr>
<tr>
<td></td>
<td>• Black - time synchronization (e.g. a third-party application has updated the time on the LNVR)</td>
</tr>
<tr>
<td></td>
<td>• Gray - video has not been cached on the client yet</td>
</tr>
<tr>
<td>C</td>
<td>Video start time. Use this feature to adjust your video search.</td>
</tr>
</tbody>
</table>
Daylight Saving Time

To search video that was recorded the hour before or after the Daylight Saving Time changeover, you must perform two searches instead of one. For example, in the Eastern Standard Timezone the Daylight Saving Time changeover occurs at 2:00 a.m. To view video that was recorded between 1:00 a.m. and 3:30 a.m., perform two searches. For the first search, specify 1:00 a.m. for the start time and 1:59:59 for the end time. For the second search, specify 3:00:01 a.m. for the start time and 3:30 a.m. for the end time. Use this same technique when exporting video recorded during the changeover time.

Attempting to play or export a continuous video clip with a start time before 2:00 a.m. to an end time after 3:00 a.m. is not recommended and may result in undesired playback behavior. For this reason, search and/or export recorded video before the Daylight Saving Time changeover separate from video after the changeover.

Troubleshooting

If you receive the message: “The end time must not be before the start time.” set the End time to 1:59:59 a.m. not 2:00:00 a.m.

If you receive the message: “The time requested is not available on the Video Recorder, and could not be located on the Video Archive Server.” set the Start time to 3:00:01 a.m. not 3:00:00 a.m.

Performance Dialog

Adjustments to the Video Player can be made to enhance performance by limiting the frame rate, decompression, video acceleration, and edge enhancement. The Performance dialog is displayed by selecting Options > Performance from the Video Player window. Settings are configured and stored for the monitoring station and apply to both live and recorded video. Any changes to performance settings take effect after the Video Player is restarted.
### Video Player - Performance dialog

<table>
<thead>
<tr>
<th>Field</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frame rate limit (LNVR only)</td>
<td>Limit the frame rate displayed by the Video Player. Useful for remote clients that have limited bandwidth.</td>
</tr>
</tbody>
</table>
| Video Acceleration                         | Used for troubleshooting problems displaying video related to the video card or device drivers. Full acceleration utilizes the video card, thus freeing the computer CPU and memory for other tasks. Additionally, Windows Display Properties has a Hardware Acceleration setting on the Troubleshoot tab of Advanced Settings that may be used for troubleshooting.  
**Note:** Some video cards and device drivers may produce varying results. Adjust the value to each level to find the one that generates the desired effects. |
| OK                                         | Save settings and return to the Video Player window.                                                                                                                                                      |
| **Note:**                                  | You must close the Video Player for the changes to take effect.                                                                                                                                         |
| Cancel                                     | Close the Performance dialog without saving changes.                                                                                                                                                      |
| Help                                       | View help for this topic.                                                                                                                                                                               |
**Video Monitoring Features**

**Buffering Streaming Video**

Buffering of live and recorded video reduces the amount of network bandwidth used by buffering the video on the client machine for playback. Video may be viewed multiple times from the client rather than requesting the video from the video recorder repeatedly.

This feature enhances live video mode by allowing the user to review live video that has been cached without switching to recorded video. The live video toolbar now displays a slider which can be used to navigate the cached video. The current time of the video is displayed in the toolbar. The live video cache retains a maximum of 10 minutes. The maximum size per cached video stream is 50 MB of RAM. Live video can be paused, resumed, slowed, or accelerated. Live video play will resume if video is paused or slowed down until it reaches the beginning of the cache or if video is accelerated to the current time.

Buffering of recorded video occurs during playback. During video playback, recorded video is cached in 10 minute increments.

To turn off the buffering of live and/or recorded video on a per workstation basis, add the following lines to the `[DigitalVideo]` section of the `ACS.INI` file:

- To turn off live: `BufReader0=0`
- To turn off recorded: `BufReader2=0`

To turn buffering back on, remove the line(s) above or set the value equal to 1.

**Browser-based VideoViewer**

An alternative to using the video player is to use the browser-based VideoViewer. The browser-based VideoViewer has some enhanced feature capabilities that are not available in Alarm Monitoring. Some of these features include:

- More flexible recorded video viewing options
- Robust layout manipulation
- Better joystick control with the use of buttons

For more information about these features, refer to the VideoViewer (Browser-based) User Guide.

The browser-based VideoViewer can be launched from Alarm Monitoring. The **Use browser-based VideoViewer** option located in the right-click menus of supported video devices can be used to enable this feature on a per workstation basis. A check mark next to the menu option indicates that the feature has been enabled. Once the **Use browser-based VideoViewer** option has been enabled, all manual requests for live and recorded video will be displayed in VideoViewer.

To use the browser-based VideoViewer, the Web Application Server must be fully installed and configured. For more information, refer to the Installation Guide.
Camera Lookup

Camera lookup is used to locate a specific camera or multiple cameras by name. The search permissions can be configured to include only the current monitor zone or the entire system. To perform a camera lookup, right-click the monitor zone or camera device group in Alarm Monitoring and select “Camera lookup...” Searches initiated from the monitor zone will have the results highlighted in the System Hardware Tree and searches initiated from a camera device group will have the results highlighted in the Device Groups window. Searches that return results outside of the current monitor zone or device group will be added to the monitor zone or device group.

The extent of the search is limited by a user permission on the Users > Monitor Permission Groups > Video sub-tab. To enable a user group to search for cameras across the entire system, select the Camera lookup includes all monitor zones check box. In segmented systems, users must have segment access to the segment in which the cameras video recorder resides for it to appear in the search results.

When a search is performed, the Camera Lookup dialog is displayed. The Camera Lookup dialog message indicates whether the search will be performed in the current monitor zone or across the entire system. The search is performed by entering a portion of the camera name, wildcard characters (*) are not used. For example, a search for “hall” would return cameras named “Hallway”, “Main hall”, and “Hall stairwell” if they existed in the system.

If a single camera is found it is highlighted in the System Hardware Tree or Device Groups window. If multiple cameras are found that match the string entered, they are displayed in the Select Cameras dialog. Multiple cameras can be selected for addition to the monitor zone by placing a check mark beside each camera. The first selected camera will be highlighted and additional selected cameras will be added to the monitor zone if they are not already included. This addition to the monitor zone is temporary and restricted to the current Alarm Monitoring session, camera additions are not saved per user or workstation.

Two-way Audio

Two-way audio enables communication between a monitoring workstation and a camera equipped with a microphone and speakers. A workstation can communicate with a single device or multiple devices simultaneously. A microphone or a pre-recorded file can be used to send audio to the device.

Audio quality is dependent on the quality of the hardware. The two-way audio streams are retrieved by the client directly from the camera. Audio sent to the camera from the client is not captured by the video recorder and cannot be recorded.

Two-way audio is enabled on the Audio tab of the Camera form in System Administration. If the selected camera does not support two-way audio, the Allow Two-Way Audio check box will be grayed out. Two-way audio devices may support full or half-duplex. Full duplex allows simultaneous two-way communication, while half-duplex allows communication in one direction at a
time. The Two-Way Audio check box on the Users > Monitor Permission Groups > Video sub-tab determines user permissions for the feature.

Two-way audio is controlled by the Two-Way Audio Communication dialog. This dialog can be launched from the right-click menu of a supported camera in the System Status Tree in Alarm Monitoring or from the Play menu in the video player or VideoViewer. If the camera is either not configured or not supported for two-way audio, the option will be grayed out. All devices are controlled from the same Two-Way Audio Communication dialog. Each device can be controlled individually or multiple devices can be controlled simultaneously by selecting the check boxes of the devices and using the Multiple Selection Controls portion of the dialog.

**Note:** Two-way audio is not available if the camera is in MPEG4 mode.

---

**Two-way Audio Communication Dialog**

<table>
<thead>
<tr>
<th>Field(s)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device name and status</td>
<td>The name of the device is displayed with each control with the status of the device in parenthesis. Statuses include:</td>
</tr>
<tr>
<td></td>
<td>• Active - The device is currently being controlled.</td>
</tr>
<tr>
<td></td>
<td>• Inactive - There is a connection to the device, but the controls are not currently in use.</td>
</tr>
<tr>
<td></td>
<td>• Connecting - An attempt is being made to connect to the device.</td>
</tr>
<tr>
<td></td>
<td>• Communication error - There is a problem connecting to the device.</td>
</tr>
<tr>
<td>Talk/End Talk</td>
<td>This button begins and ends transmission from the monitoring workstation to the camera using a microphone. The [Talk] button changes to [End Talk] while the connection is active.</td>
</tr>
<tr>
<td></td>
<td>This button is disabled under the following conditions:</td>
</tr>
<tr>
<td></td>
<td>• A file is currently being sent.</td>
</tr>
<tr>
<td></td>
<td>• A connection is being established to the device.</td>
</tr>
<tr>
<td></td>
<td>• The camera supports only half-duplex mode and [End Listen] is currently active.</td>
</tr>
</tbody>
</table>
Two-way Audio Communication Dialog

<table>
<thead>
<tr>
<th>Field(s)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Listen/End Listen</td>
<td>This button begins and ends transmission from the camera to the monitoring workstation. The [Listen] button changes to [End Listen] while the connection is active.</td>
</tr>
<tr>
<td></td>
<td>This button is disabled under the following conditions:</td>
</tr>
<tr>
<td></td>
<td>• A connection is being established to the device.</td>
</tr>
<tr>
<td></td>
<td>• The camera supports only half-duplex mode and [End Talk] or [End Send File] is currently active.</td>
</tr>
<tr>
<td>Send File/End Send File</td>
<td>This button begins and ends transmission from the monitoring workstation to the camera using an audio file. The [Send File] button changes to [End Send File] while the file is being transmitted.</td>
</tr>
<tr>
<td></td>
<td>When [Send File] is pressed, a dialog allows you to browse for an audio file. Only the .WAV 8kHz 16-bit PCM file format is supported. To cancel the file before it is complete, press [End Send File].</td>
</tr>
<tr>
<td></td>
<td>This button is disabled under the following conditions:</td>
</tr>
<tr>
<td></td>
<td>• [End Talk] is currently active.</td>
</tr>
<tr>
<td></td>
<td>• A connection is being established to the device.</td>
</tr>
<tr>
<td></td>
<td>• The camera supports only half-duplex mode and [End Listen] is currently active.</td>
</tr>
<tr>
<td>Reconnect</td>
<td>This button is displayed when the connection to the camera is lost or cannot be established. When clicked, an attempt will be made to reconnect to the camera.</td>
</tr>
<tr>
<td>Device check boxes</td>
<td>Select the check box for each device that you wish to control using the Multiple Selection Controls portion of the dialog.</td>
</tr>
<tr>
<td>Close button (Red X)</td>
<td>Each device control includes a close button (red X). Pressing this button closes the connection to the device and removes the control from the dialog. If the dialog contains only one control, the dialog is closed.</td>
</tr>
<tr>
<td>Multiple Selection Controls</td>
<td>These buttons are used in conjunction with the device check boxes to control multiple devices simultaneously from one set of controls.</td>
</tr>
<tr>
<td>Select all</td>
<td>Select this check box to select all devices for use with the Multiple Selection Controls. Deselect this check box to clear the check boxes for all devices.</td>
</tr>
</tbody>
</table>

Video Monitoring Procedures

Launch Video (Live/Recorded) From a Camera

1. To launch video in the VideoViewer complete one of the following:
   • Double-click a camera.
   • Drag and drop a camera, camera device group or recorder into the display window or Video Player. If you drag and drop a device group or
recorder into the Video Player, the first camera in the group that was added to the database displays.

2. To launch video in Alarm Monitoring complete one of the following:
   - In an alarm window right-click an alarm with associated video and select Launch Video. Recorded video will be launched with the start time of the active alarm, including pre-roll if configured.
   - In a map or System Status window right-click a device icon and select Launch Video.
   - In the Device Group window right-click a camera icon and select Launch Video.
   - In the Video Monitoring window double-click an online camera or right-click a camera icon and select Launch Video.
   - Drag and drop a camera, camera device group or recorder into the Video Player. This launches ALL of the video cameras in that particular group or recorder (up to 32 cameras at once).

3. To view live video select Live from the Play menu.
4. To view recorded video select Recorded from the Play menu.

Export Video to a File

Video can be exported to a file using the Video Export dialog from the Video Player. For more information, refer to Export Video to a File on page 227.

Load and View a Video File

1. Display the Video Player. For more information, refer to Video Player on page 161.
2. Select Load File from the Options menu.
3. The Open window displays. Select the correct “.info” file, and click [Open]. The recorded video automatically plays.
4. To replay the video file click the Stop toolbar button and then click the Play toolbar button.

Monitor Video of a Specific Camera

To monitor video of a specific camera in Alarm Monitoring complete one of the following:
   - In the Video Monitoring window double-click an online camera to view live video.
   - In an alarm window, map or System Status window right-click a device icon and select Launch Video to view live or recorded video.
   - In the Device Group window right-click a camera icon and select Launch Video to view live or recorded video.
   - In the Video Monitoring window double-click an online camera or right-click a camera icon and select Launch Video.
Drag and drop a camera into the Video Player.

To monitor video of a specific camera, complete one of the following:

- Double-click a camera.
- Drag and drop a camera into the video viewing area or Video Player.

**Toolbar Shortcut**

- If the Video Player is in matrix view, select Single View from the Video Layout toolbar button. Click the Previous Camera or Next Camera toolbar buttons to view a specific camera.
- In the Video Player select Camera from the View menu. A sub-menu lists the currently displayed cameras. Select the camera of your choice.

**About Surveillance-Only Cameras**

Surveillance-only cameras support live video only, they cannot record or playback video, whereas IP (Internet Protocol) cameras can. IP cameras are directly connected to the network with their own IP address. They do not need to be connected to a computer or a video capture card. More advanced IP cameras may provide additional functionality such as a built-in web server, motion detection, alarm inputs/outputs and e-mail and FTP support.

**Switch Camera Views Displayed in Video Player**

Cameras and device groups can be dragged and dropped from the camera list into the Video Player for viewing.

**Monitor Video of Multiple Cameras (Successively)**

You can use the Video Player or the Video Monitoring window to monitor video of multiple cameras successively. To monitor video using the Video Monitoring window, refer to View the Video Tour on page 160. To monitor video of multiple cameras in matrix mode, refer to Matrix View on page 187.

To monitor video of multiple cameras successively using the Video Player:

1. Follow the procedures to Launch Video (Live/Recorded) From a Camera on page 170 in the Video Player.
2. Click and drag every camera or camera group, you will want to view, into the Video Player.
3. From the View menu select Camera. A sub-menu displays. Select the desired camera view.
4. Repeat step 3 to view different cameras successively or click the Previous Camera and the Next Camera toolbar buttons.
Capture an Image

You can capture images from live and recorded video. Images are saved as “JPG” files.

1. Follow the procedures to Launch Video (Live/Recorded) From a Camera on page 170 in the Video Player.
2. Verify one camera view is selected; the status bar for a selected camera is blue - not gray.
3. From the Options menu select Capture Image.
4. The Multimedia Capture window is displayed.
5. Click [Export]. The Save As window is displayed.
6. Enter a file name and click [Save]. If the photo is bitmapped and the crop window is used, the portion of the image within the cropped area is saved. Otherwise, the whole photo is saved.
7. Click [OK].

Create a Video Event

Video events are automatically created in Alarm Monitoring if a camera is correctly added to a video recorder, hardware is linked to the camera and an alarm-video configuration is established. For more information, refer to Set up an Alarm Monitoring Station to View Video on page 160.

You can also manually create a video event to lock/mark video at the exact start and stop times you desired. For example, if the B.A.S.I.S. system automatically creates an event for a door forced open, but you want the event to include 5 seconds after the event occurred, you can review the video and manually create an event at the desired times.

1. Follow the procedures to Launch Video (Live/Recorded) From a Camera on page 170. Verify the recorded video is playing in the Video Player.
2. If necessary use the toolbar settings and the start and stop time fields to identify the portion of video to be marked as an event.
3. From the Options menu select Create Video Event.
4. The Create Video Event dialog is displayed. Select the appropriate Event text from the drop-down list or enter new text to append to the User Generated Video Event alarm.
5. Click [OK].
6. The Alarm Monitoring window displays a User Generated Video Event alarm.
Automatically Launch both Live and Recorded Video on Alarm

If an alarm is configured to automatically launch the Video Player, you can configure it to launch recorded video in addition to live video. This feature must be configured on each Alarm Monitoring workstation.

It is highly recommended to set the playback pre-roll for the camera to at least 10 seconds when using this feature. For more information, refer to Camera Form (Connection Sub-tab) on page 47.

To configure this feature, add the following settings in the [DigitalVideo] section of the ACS.INI file.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>DoubleVideoOnAlarm=1</td>
<td>Use this line to enable the launch of both live and recorded video when an alarm is configured to automatically launch video on alarm.</td>
</tr>
<tr>
<td>AlarmDurationMax=60</td>
<td>Use this line to configure the length of the recorded video clip that will be launched. The default value is 60 seconds.</td>
</tr>
<tr>
<td>PauseOnDoubleVideoOnAlarm</td>
<td>• A value of 1 pauses the video at the time of the alarm (the end of the recorded video clip).</td>
</tr>
<tr>
<td></td>
<td>• A value of 0 begins playing the recorded video including pre-roll (if configured).</td>
</tr>
</tbody>
</table>

The default behavior with this feature is to launch recorded and live video in matrix mode. Additional configuration may be necessary if multiple cameras are linked in a video event to display the each camera channel as a pair of video cells (recorded and live).

By adding lines to the [DigitalVideo] section of the ACS.INI file, you can configure the layout of cameras in the matrix view. Each pair of live and recorded video streams for a camera has a width of 500 and a height of 200. You can configure different displays that depend on the total number of video streams. The number located after PlayerWidth and PlayerHeight represents the number of video streams. For example:

To display 2 camera channels (4 video streams) with one camera (one pair of live and recorded video) on each of two rows you would add the following lines:

```plaintext
PlayerWidth4=500
PlayerHeight4=400
```

To display 4 camera channels (8 video streams) with two cameras (2 pairs of live and recorded video) on each of two rows you would add the following lines:

```plaintext
PlayerWidth8=1000
PlayerHeight8=400
```
Event Configuration/Search Dialog

The Event Configuration/Search dialog is used to:

- Configure event parameters for real-time LNVR video processing and alarm generation. For detailed IntelligentVideo Event information, refer to the IntelligentVideo User Guide.

- Display alerts when events occur. Alerts display in three areas of the dialog:
  - In the video window, alerts display as a highlighted area.
  - In the Event Feedback pane, alerts display as a spike in the alert status graph.
  - In the alarm history pane, alerts display as thumbnails or text.

- Search LNVR or LDVR recorded/archived video for the occurrence of specific events.

- View search results as a detailed list or thumbnail images.

- Play recorded video search results in the Video Player pane.

- Play live video in the Video Player pane.

Note: Different fields, buttons and event options are available, depending on how you open the Event Configuration/Search dialog.
## Event Configuration/Search Dialog Menu Options

The following table describes the menu and sub-menu options available from the Event Configuration/Search dialog.

### Event Configuration/Search Dialog - Menus

<table>
<thead>
<tr>
<th>Menu Name</th>
<th>Menu Options</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event Menu</td>
<td>Select Event</td>
<td>Enables you to select the event for which the current video source will be analyzed.</td>
</tr>
<tr>
<td><strong>Note:</strong> The <strong>Select Event</strong> sub-menu option is available only if you open the Event Configuration/Search dialog using the Video Player. In System Administration, you have to select an event before you can open the Event Configuration/Search dialog. Therefore, if you selected an event to open the dialog the Select Event sub-menu option will not display.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Screen Output</td>
<td></td>
<td>Some event feedback and configuration parameters display directly on the video to help you visualize what is being (or what has been) configured. If you wish to enable this output, verify that a checkmark displays beside this sub-menu option.</td>
</tr>
<tr>
<td>Load/Save Configuration</td>
<td></td>
<td>Allows you to save the current configuration and load it at a later time for the same type of event.</td>
</tr>
<tr>
<td>Copy/Paste Configuration</td>
<td></td>
<td>It is possible to copy a configuration from one event and paste it to a different event. In this case, all parameters that apply to the new event will be used. For example, the configuration for a motion detection event can be copied/pasted to an abandoned object event. In this example, the “Region of interest” parameter exists in both events, so that parameter will be saved. But the abandoned object event does not use “Threshold”, so that parameter will be ignored. Lastly, motion detection did not use the “Duration” parameter, so the original duration value for the abandoned object event will be used.</td>
</tr>
</tbody>
</table>
## Event Configuration/Search Dialog - Menus (Continued)

<table>
<thead>
<tr>
<th>Menu Name</th>
<th>Menu Options</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Player Menu</td>
<td>Switch to Recorded/Live</td>
<td>Enables you to switch to and from recorded and live video.</td>
</tr>
<tr>
<td></td>
<td>Select Start/End Times</td>
<td>Displays a dialog where you can select the start and end times of a recorded video search.</td>
</tr>
<tr>
<td></td>
<td>Export Frame</td>
<td>Allows you to export the current frame into a picture file. Supported image formats are BMP, JPEG, GIF, TIFF, and PNG.</td>
</tr>
<tr>
<td></td>
<td>Play</td>
<td>Starts/resumes video playback. This command is not visible when video is playing.</td>
</tr>
<tr>
<td></td>
<td>Pause</td>
<td>Pauses playback. When video play is resumed, it continues from where it was temporarily stopped. This command is visible only when video is playing.</td>
</tr>
<tr>
<td></td>
<td>Stop</td>
<td>Stops playback and rewinds the video to the beginning.</td>
</tr>
<tr>
<td></td>
<td>Search</td>
<td>Fast-forwards through video while continuing to analyze it. This allows you to search through video faster than real-time and look for events of interest, using the Event Output and Event History panes.</td>
</tr>
<tr>
<td></td>
<td>Zoom</td>
<td>Enables you to set pre-defined (50%, 100%, and 200%) zoom levels for the video player.</td>
</tr>
<tr>
<td></td>
<td>Frame Rate</td>
<td>Sets the frame rate at which video is fed to the client side. By default, this value is set to 10 frames per second (fps). If the source video is set at a higher fps, video will be analyzed at the higher frame rate, but some frames will not be sent to the client display. This option is available when the client display is on a computer separate from the video analysis service and the network connection between client and the service is less than ideal. Reducing the frame rate will speed up processing because the server side will not have to wait for the client to consume the video frames it has sent.</td>
</tr>
</tbody>
</table>
Event Configuration/Search Dialog Fields

The following table describes some of the configuration parameters available in the Event Configuration/Search dialog.

### Event Configuration/Search Dialog - Fields

<table>
<thead>
<tr>
<th>Pane</th>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Video Player Pane</td>
<td>Video window</td>
<td>Video playback window.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> If configuration or event feedback controls have any additional information, you may choose to draw in this window or on top of the video.</td>
</tr>
<tr>
<td>Command buttons and Status indicator</td>
<td>Buttons at the bottom of the pane allow you to execute the same commands that are available through the menus. In addition to the menu options, the command buttons allow you to:</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Set an arbitrary zoom level for the entire video search window</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Search video by using the position indicator/seek bar control</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Play, pause, and stop recorded video</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Play the video at an accelerated rate by using the search button</td>
</tr>
</tbody>
</table>

Indicates the current status of the IntelligentVideo engine or video processing engine. If there are problems connecting to the search server component, the status indicator will indicate the connection state and any error values encountered.

**Note:** In live video mode, most of these controls are absent since live video cannot be paused, stopped, or searched. The only option available with live video is to change the zoom level.
### Event Configuration/Search Dialog - Fields (Continued)

<table>
<thead>
<tr>
<th>Pane</th>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration Pane</td>
<td>Region of Interest (ROI)</td>
<td>The ROI identifies the area of video to be processed. Click the Create a Region of Interest button and then click on the video to mark the area you wish to define. Once the ROI has been created, use the mouse to drag and drop any of the green vertices or the entire ROI if adjustments are necessary. Click the Delete Region Of Interest button to remove an existing ROI.</td>
</tr>
<tr>
<td></td>
<td>Mask</td>
<td>The ROI mask identifies an area of video to ignore. Click on the Create a Mask button and then click on the video to mark the area you wish to ignore. Once the mask has been created, use the mouse to drag and drop any of the green vertices or the entire mask if adjustments are necessary. Click the Delete Mask button to remove an existing mask.</td>
</tr>
<tr>
<td>Event Feedback Pane</td>
<td>Alert status graph</td>
<td>A color-coded graphical representation of alerts. An alert is created only if the last detected event occurred more than 8 seconds ago. Note: For recorded video, you can click on any part of the graph to view the corresponding video. The video search must first be stopped.</td>
</tr>
<tr>
<td></td>
<td>Time Range</td>
<td>Select the duration of time used by the graph.</td>
</tr>
<tr>
<td></td>
<td>Level</td>
<td>The current level of change. Levels range from 0 to 100. The first and last frames of an event must have a value equal to or greater than the specified level, to be included in the search results.</td>
</tr>
<tr>
<td></td>
<td>History</td>
<td>Displays the history of the level of change.</td>
</tr>
</tbody>
</table>
### Event Configuration/Search Dialog - Fields (Continued)

<table>
<thead>
<tr>
<th>Pane</th>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarm History</td>
<td>Event Thumbnail View</td>
<td>Displays a scaled-down image of the video frame for each detected event. You can double-click a thumbnail to view the recorded video for that event (in the Video Player pane). The video search must first be stopped. The Event Thumbnail View does not apply to live video.</td>
</tr>
<tr>
<td></td>
<td>Event Detail View</td>
<td>Displays information (start time, end time and duration) about each event that was detected. You can double-click an event to view the recorded video for that event (in the Video Player pane). The video search must first be stopped. The Event Thumbnail View does not apply to live video.</td>
</tr>
<tr>
<td>Help</td>
<td>Push button</td>
<td>Displays online help for this topic.</td>
</tr>
<tr>
<td>Close</td>
<td>Push button</td>
<td>Closes the Event Configuration/Search dialog.</td>
</tr>
<tr>
<td>Refresh</td>
<td>Push button</td>
<td>Once event configuration is modified, this button will be enabled and allow the user to apply configuration changes to the IntelligentVideo engine.</td>
</tr>
</tbody>
</table>

---

### Event Configuration/Search Dialog Procedures

#### Open the Event Configuration/Search Dialog

The Event Configuration/Search dialog can be opened using the Video Processing form or IntelligentVideo form (in System Administration) or using the Video Search menu option (in Video Player).

#### Using the Video Processing or IntelligentVideo Form

1. Open the Video Processing or IntelligentVideo form from System Administration:
   - For IntelligentVideo events:
     a. From the Video menu, select IntelligentVideo. The IntelligentVideo folder opens.
     b. Click the IntelligentVideo Events tab.
   - For Video Processing events:
     a. From the Video menu, select Digital Video. The Digital Video folder opens.
b. Click the Video Processing tab.

2. Select (place a checkmark beside) the appropriate camera.

3. Click [Modify].

4. Click the camera icon located in the lower right side of the Event Type listing window. The Event Configuration/Search dialog opens.

Using the Video Player

1. Follow the procedures to Launch Video (Live/Recorded) From a Camera on page 170. Verify the recorded video is playing in the Video Player.

   Toolbar Shortcut

   2. Click the Video Search toolbar button or from the Control menu select Video Search. The Event Configuration/Search dialog displays.

Configure Event Properties

When you configure event properties, you define the parameters that make up an event. For example, duration time and object size are event properties for the “Left Object” event.

Event properties are defined per event, not per channel. Therefore, you can define several unique event properties for the same event on the same video channel.

For detailed IntelligentVideo Event configuration information, refer to the IntelligentVideo User Guide.

1. Open the Event Configuration/Search dialog. For more information, refer to Open the Event Configuration/Search Dialog on page 180.

2. If you opened the Event Configuration/Search dialog using the Video Player, select the event type from the Event menu.

3. Set the region of interest. For more information, refer to Set Region of Interest on page 182.

4. Set the event properties. For more information, refer to the IntelligentVideo Events chapter in the IntelligentVideo User Guide.

5. If necessary, configure event parameters that apply to the video channel itself. For more information, refer to Video Channel Configuration Dialog on page 185.

6. Click [OK].
Set Region of Interest

The Event Configuration/Search dialog has a region of interest (ROI) button. Although this setting is optional, it is highly recommended that ROI is used whenever possible to reduce computation time and the probability of false alarms. If the ROI is not set, the entire frame is considered the region of interest.

All the events except “Object Crosses a Region” and “People Counting” support the use of ROI.

1. Open the Event Configuration/Search dialog. For more information, refer to Event Configuration/Search Dialog on page 175.

2. If you opened the Event Configuration/Search dialog using the Video Player, select the event type from the Event menu.
3. Click the Create Region of Interest button.

4. In the Video Player pane left-click to create a starting point for the area you want to highlight. A green dot displays.

5. Click another point in the area you want to highlight. A red line connecting the two points displays.

6. Continue clicking points to expand the highlighted area.

7. Use the mouse to drag and drop any of the green vertices or the entire ROI if adjustments are necessary.

---

**Note:** If at any time you want to remove a highlighted area, select it and click the Delete Region of Interest toolbar button.

8. Only the highlighted area is recorded or searched.
Video Search Performance Requirements

A fast network, 100 Mbps or greater, is recommended between the site where video is located and the site where the computer running the Video Player is located. A fast network is recommended because video is analyzed/searched on the client side, therefore the faster video can be transmitted from the server side, the faster the search will be.

The hard drive speed on the server side must be able to support the number of clients using the server. Clients include Video Players and archive servers.

A fast CPU on the client computer is also recommended. Generally, when the network and server side hard drive are fast enough, the CPU on the client side can be the bottleneck. A Pentium III based computer is required although a Pentium IV computer is recommended.

Search Video/Audio

You can search video and audio using the Video Player or Event Configuration/Search dialog. To search video using the Video Player, simply verify recorded video is playing and select the start/end date. However, the Event Configuration/Search dialog enables you to perform detailed searches quickly. Complete the following to search video using the Event Configuration/Search dialog.

1. Open the Event Configuration/Search dialog. For more information, refer to Open the Event Configuration/Search Dialog on page 180.
2. If you opened the Event Configuration/Search dialog using the Video Player, select the event type from the Event menu.
3. From the Player menu select Select Start/End Times. The Date / Time window opens. Enter the desired date and time ranges you wish to search and click [OK].
4. From the Player menu select Frame Rate.
5. Set the configuration parameters for the event or load a previously saved set of channel configuration parameters. For more information on event configuration parameters, refer to the IntelligentVideo Event chapters in the IntelligentVideo User Guide. For more information on audio events, refer to IntelligentAudio on page 231. For more information on channel configurations, refer to Video Channel Configuration Dialog on page 185.
6. Click the search toolbar button. Events that meet the configuration parameters display in the Alarm History pane.

View Search Results

There are several ways to view the recorded video associated with the video search results.
From the Event Configuration/Search dialog:

- Click any part of the graph, in the Event Feedback pane.
- Double-click a thumbnail or listed event, in the Alarm History pane.

**Video Channel Configuration Dialog**

Video channel configuration parameters can be applied to real-time IntelligentVideo processing and to recorded video searches. The Video Channel Configuration dialog is used to configure event parameters that apply to the video channel itself and not the video processing algorithms. For example, if the source video has a lot of motion, background learning time may need to be increases so the video processing engine picks out static scene elements more accurately.

For detailed IntelligentVideo Event configuration information, refer to the IntelligentVideo User Guide.

---

### Video Channel Configuration Dialog

<table>
<thead>
<tr>
<th>Form Element</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Video Channel Configuration listing window</td>
<td>Displays the video channel processing properties and user-configured values. Parameters are sorted into types. Values are modified directly in the listing window. A new value may be entered or selected from the drop-down list. Click [Explain] to read a detailed description of the selected property.</td>
</tr>
<tr>
<td>OK</td>
<td>Accepts the video channel configuration changes and closes the dialog.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Rejects the video channel configuration changes and closes the dialog.</td>
</tr>
<tr>
<td>Load Configuration</td>
<td>Displays an Open window from which you can select the “.XML” configuration file you want to load.</td>
</tr>
</tbody>
</table>
Video Channel Configuration Dialog (Continued)

<table>
<thead>
<tr>
<th>Form Element</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save Configuration</td>
<td>Saves the set of video channel configuration parameters for reuse.</td>
</tr>
<tr>
<td>Reset to Defaults</td>
<td>Resets all parameter settings to their original default settings.</td>
</tr>
<tr>
<td>Show Parameters Only For</td>
<td>Select this check box to display only parameters which are relevant to</td>
</tr>
<tr>
<td></td>
<td>the selected event. Only events configured for the current channel are</td>
</tr>
<tr>
<td></td>
<td>available in the drop-down list.</td>
</tr>
<tr>
<td>Show Advanced Parameters</td>
<td>Select this check box to view additional parameters used for</td>
</tr>
<tr>
<td></td>
<td>troubleshooting and diagnostics. The default setting hides the</td>
</tr>
<tr>
<td></td>
<td>advanced parameters.</td>
</tr>
<tr>
<td>Explain</td>
<td>Click this button to read a detailed description of the selected</td>
</tr>
<tr>
<td></td>
<td>property.</td>
</tr>
</tbody>
</table>

Open the Video Channel Configuration Dialog

The Video Channel Configuration dialog can be opened using the IntelligentVideo Events form (System Administration) or using the Event Configuration/Search dialog available through the Video Player.

Using the IntelligentVideo Events form

1. Open System Administration.
2. From the Video menu, select IntelligentVideo. The IntelligentVideo folder opens.
3. Click the IntelligentVideo Events tab.
4. Select (place a check mark beside) the appropriate camera.
5. Click [Modify].
6. Select an IntelligentVideo Server from the drop-down list.
7. Click [Channel Configuration] (located below the camera listing window on the right side). The Video Channel Configuration dialog opens.

Using the Event Configuration/Search Dialog

1. Open the Event Configuration/Search dialog. For more information, refer to Open the Event Configuration/Search Dialog on page 180.
2. Click [Channel Configuration] (located on the lower right side of the window). The Video Channel Configuration dialog opens.

Configure Video Channel Parameters

Two types of parameters are available: basic and advanced. Parameters are defined per channel and for each event there is a unique set of parameters. By default, only basic parameters display. If you want to set an advanced parameter, click the Show Advanced Parameters check box. Advanced parameters should only be set by expert level administrators.
A parameter can be set by entering or selecting a value from the drop-down list in the listing window.

1. Display the Video Configuration dialog. For more information, refer to Open the Video Channel Configuration Dialog on page 186.
2. It is recommended that you select the Show Parameters Only For check box.
3. Select (highlight) a property name.
4. Select or enter the property value.
5. Repeat steps 3 and 4 for each property.
6. Click [Save Configuration] if you would like to be able to load these configurations at another time.
7. Click [OK].

Matrix View

Matrix view allows the user to view multiple video streams at once in the Video Player window. Video streams can be arranged for viewing in the Video Player using preconfigured templates. Once video streams have been added to a template, this layout can be saved so that it can be loaded by another user or monitoring station.

Select Template Dialog

The Select Template dialog is used to load an empty matrix view into the Video Player. Each template has a fixed number of video cells arranged in a different layout. Once a template has been loaded, drag and drop cameras from the System Status Tree to monitor them in the Video Player. The Select Template dialog is displayed by selecting View > Template from the Video Player menu.
Save Layout Dialog

The Save Layout dialog is used to create a layout that can be reused at another time. Layouts can be made available to all users or it can be limited to the current user or local workstation. The Save Layout dialog is displayed by selecting Play > Save Layout from the Video Player menu.

<table>
<thead>
<tr>
<th>Field(s)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save as new layout</td>
<td>Select this radio button to create a new layout.</td>
</tr>
<tr>
<td>Private (assigned to the current user)</td>
<td>Select this check box to make the new layout available only to the current user.</td>
</tr>
<tr>
<td>Local (assigned to this workstation)</td>
<td>Select this check box to make the new layout available only on the local workstation.</td>
</tr>
<tr>
<td>Overwrite existing layout</td>
<td>Select this radio button to replace an existing layout.</td>
</tr>
<tr>
<td>Listing window</td>
<td>Select the layout you wish to overwrite from the listing window.</td>
</tr>
<tr>
<td>Remove</td>
<td>Click this button to remove the layout selected in the listing window.</td>
</tr>
</tbody>
</table>
Load Layout Dialog

The Load Layout dialog is used to display layouts that have been previously saved by a user in the Video Player. The Load Layout dialog is displayed by selecting Play > Load Layout from the Video Player menu.

Save Layout Dialog

<table>
<thead>
<tr>
<th>Field(s)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Private (assigned to the current user)</td>
<td>Filter the list of available layouts to display only private layouts assigned to the current user.</td>
</tr>
<tr>
<td>Local (assigned to this workstation)</td>
<td>Filter the list of available layouts to display only locally created layouts.</td>
</tr>
<tr>
<td>Listing window</td>
<td>The list of available layouts.</td>
</tr>
</tbody>
</table>

Matrix View Procedures

Monitor Video in Matrix View

The Video Player in matrix view can be used to view live or recorded video from multiple cameras simultaneously.

1. Follow the procedures to Launch Video (Live/Recorded) From a Camera on page 170 in the Video Player.
2. The Video Player displays. From the View menu, select As Matrix. You can also select the Matrix View toolbar button.

Note: Matrix view displays up to 32 cameras. There may be more cameras available than can fit in the viewable area. You may scroll or resize the window to view additional cameras. To resize the window hover the pointer
over the corner or edge of the window until a double-headed arrow displays. Then drag the window to its desired size.

3. The screen below displays Matrix view in the Video Player.

![Matrix view in Video Player]

**Note:** When viewing multiple cameras simultaneously, please note that the system automatically displays each window in such a way that it is active (the status bar for each window is blue.) Therefore any command will be applied to every window. To deselect a window, place the cursor in the window and click. The status bar is gray when the window is deselected.

**Note:** For PTZ cameras in matrix mode, double clicking on a single video launches a new single video window with PTZ enabled automatically.

### Create a Matrix Layout

Layouts can be configured to display video channels in a matrix view. There are multiple templates for creating layouts. Once configured, layouts can be saved and loaded on client workstations.

1. Follow the procedures to Launch Video (Live/Recorded) From a Camera on page 170 in the Video Player.

2. The Video Player displays. From the **View** menu, select **Template**.

3. Choose a static template from the Select Template dialog.

4. Empty video cells are displayed in the chosen template. Click and drag cameras to the template to assign them to a video cell.
Note: Cameras can be cleared from the template by selecting them and clicking the Remove button . Selected video cells are indicated by a blue bar at the bottom the video cell, while unselected video cells display a gray bar. Video cells can be selected or deselected with a single right-click.

Save a Matrix Layout

Once cameras have been assigned to the video cells of a template, the layout can be saved for reuse by a different operator or monitoring station.

1. Follow the procedures to Launch Video (Live/Recorded) From a Camera on page 170 in the Video Player.
2. The Video Player displays. From the Play menu, select Save Layout.
3. The Save Layout dialog is displayed.
   • To create a new layout:
     a. Select the Save as new layout radio button.
     b. Enter a descriptive name for the layout.
     c. Select the Private or Local check boxes if the layout should be available only to the current user or workstation.
   • To replace a previously saved layout:
     a. Select the Overwrite existing layout radio button.
     b. Highlight the layout you wish to overwrite.
4. Click [OK] to save the layout.

Load a Matrix Layout

Previously saved layouts can be used by different users on different workstations.

1. Follow the procedures to Launch Video (Live/Recorded) From a Camera on page 170 in the Video Player.
2. The Video Player displays. From the Play menu, select Load Layout.
3. The Load Layout dialog is displayed. The list of available layouts can be filtered by selecting the Private (assigned to the current user) or Local (assigned to this workstation) check boxes.
4. Select a layout from the list.
5. Click [OK] to load the layout.
Pan, Tilt, and Zoom

Pan, Tilt and Zoom (PTZ) control is supported by all Lenel video recorders. Using PTZ you can control a camera’s movements and its ability to view images at different ranges (zoom in or out).

Digital PTZ is provided for cameras that do not have PTZ support. Digital PTZ allows the user to pan, tilt, and zoom throughout the camera’s field of view without moving the camera.

Configure PTZ with LNVR or LNVS Machines

LNVR and LNVS machines do not need a matrix switcher for PTZ control. Therefore, these machines do not require special procedures in B.A.S.I.S. for PTZ control; simply configure the recorder and camera.

For more information, refer to Video Recorder Form Procedures on page 35.

Configure PTZ with all other Digital Video Recorders

LDVR, Loronix, and Generic Video machines require a matrix switcher (either real or virtual) for PTZ control. Complete the following in B.A.S.I.S. to configure PTZ control for these machines.

1. Verify the default matrix switcher type settings in B.A.S.I.S. are appropriate. For more information, refer to Chapter 4: Modify a Matrix Switcher Type on page 150.
2. Add the matrix switcher. For more information, refer to Chapter 4: Matrix Switcher Folder on page 145.
3. Configure the video recorder. For more information, refer to Chapter 2: Add Video Recorders Other Than LNVR/LNVS Recorders on page 39.
4. Configure the camera. This includes linking the camera to the matrix switcher. For more information, refer to Chapter 2: Configure Cameras Other Than LNVR/LNVS Cameras on page 71.
Using PTZ in the Video Player

The following screen shows the addition of PTZ control in the Video Player.

- **Using the PTZ Toolbar.** Click \[ icon to activate PTZ. Use the remaining buttons to pan or tilt the camera, as well as, zoom in, zoom out, and focus the camera. You can also press and hold the zoom, focus, or iris buttons to achieve the preferred view.

- **Using the Mouse.** After you click \[ icon to activate PTZ you can pan, tilt, and zoom by right or left clicking your mouse in the video window. A left click moves the camera toward the cursor. The camera keeps moving in that direction until the mouse button is released. The camera moves with direction and speed determined by the mouse position relative to the center of the video window. If you move the mouse while holding the left button down, the camera changes the direction and speed accordingly. If you right-click in the top half of the screen the camera zooms in until you release the mouse. If you right-click in the bottom half of the screen the camera zooms out until you release the mouse. You can also use the mouse scroll wheel to zoom in/out. Scroll up to zoom in and scroll down to zoom out. The farther away from the center the mouse is the faster the camera moves.

- **Using the Keyboard.** After you click \[ icon to activate PTZ you can use the keyboard arrow keys to pan, tilt, and zoom. The left and right arrow keys pan the camera left and right. The up and down arrow keys tilt the camera up and down. Hold the <Shift> key down while pressing the up or down arrows.
zooms the camera in or out. They keyboard keypad may also be used to control PTZ.

- **Using a Joystick.** After you click to activate PTZ you can use video controllers, such as joysticks, to pan, tilt, and zoom. Iris and focus are also available if supported by the joystick.

---

**Notes:**
The Zoom, Focus, and Iris control buttons are only enabled if the corresponding operations are supported by the camera in the current PTZ mode.

The speed of the pan and tilt operation is calculated based on the distance from the mouse click position to the center of the image along with the current zoom position. If the camera is zoomed in, the same mouse click will cause a slower movement. This functionality is subject to individual cameras. If a camera doesn’t support getting the current zoom position, the movement will not slow.

---

**PTZ Options Dialog**
The PTZ Options dialog is used to configure PTZ locking options and PTZ control behavior. PTZ controls can be customized to send either relative, continuous, or mixed commands with a single mouse click. The PTZ Options dialog is available from the **Options** menu in Alarm Monitoring.
Note: The video window must be re-opened to use the new settings.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Default access mode    | Used to specify the locking mode used by default when video is launched for a PTZ camera.  
“Locked” access mode gives control of the PTZ functions to the first user to activate PTZ. If another user attempts to activate PTZ for the same camera, they will receive a message that PTZ control is locked by another user.  
“Shared” access mode allows multiple users to have access to the PTZ controls at the same time. |
| Timeout (in seconds)   | If the Timeout (in seconds) check box is selected, you may specify an amount of time (in seconds) after which the PTZ controls will become unlocked. After this period another user may gain control of the camera.  
For no timeout on locking, simply clear the Timeout (in seconds) check box. Unlocking will only occur when the video window is closed, PTZ control is cancelled (by deselecting the PTZ button), or PTZ locking mode is changed to shared (by deselecting the PTZ locked button).  
Note: The PTZ timeout value is not utilized with background PTZ tours. |
### PTZ Control Adjustment Parameters

Server and client (digital) modes can be configured with different settings. Adjustments to the client modes can be only be configured by editing the `ACS.INI` file on the Alarm Monitoring workstation. Parameters should be placed in the `[DigitalVideo]` section.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mouse mode</td>
<td>“Continuous” moves the camera while the user holds the mouse down and stops when the mouse is released. The camera moves with direction and speed determined by the mouse position relative to the center of the video window. If the user moves the mouse while holding the left button down, the camera changes the direction and speed accordingly. “Click-to-center, then continuous” first issues a click-to-center command with a mouse left-click. If the user continues holding the mouse button, continuous mode is turned on (as described above). This mode is only available when the camera supports both continuous and relative PTZ commands. “Drag or double-click-to-center” allows the user to either drag the image to issue subsequent relative commands or double-click on a point to make that point the center of the image.</td>
</tr>
<tr>
<td>Zoom mode</td>
<td>“Continuous” continuously changes the corresponding setting while the user keeps pressing the left mouse button and stops when the button is released.</td>
</tr>
<tr>
<td>Focus mode</td>
<td>“Step, then continuous” first issues a relative step command with a mouse left-click. If the user continues holding the mouse button, continuous mode is turned on. This mode is only available when the camera supports both continuous and relative PTZ commands. “Step mode” issues relative step commands each time the user clicks a corresponding button.</td>
</tr>
<tr>
<td>Iris mode</td>
<td></td>
</tr>
<tr>
<td>Zoom factor (&gt;1.0)</td>
<td>The number that the current focal length is multiplied (or divided) by when the zoom in or zoom out button is pressed in step mode.</td>
</tr>
<tr>
<td>Focus step (1-100)</td>
<td>Determines the step size for relative commands. Values are normalized numbers from 1 to 100 (where 1 is the smallest and 100 is the largest).</td>
</tr>
<tr>
<td>Iris step (1-100)</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** The video window must be re-opened to use the new settings.
## Pan and Tilt Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Default</th>
<th>Possible Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>ServerMouseMode</td>
<td>Pan and tilt operations in server mode:</td>
<td>0</td>
<td>0, 1, or 2</td>
</tr>
<tr>
<td></td>
<td>• 0 = Click-to-center, then continuous</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• 1 = Drag or double-click-to-center</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• 2 = Continuous</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Note:</td>
<td>This parameter can also be configured with the Mouse mode drop-down list on</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>the PTZ Options dialog.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ClientMouseMode</td>
<td>Pan and tilt operations in client (digital) mode:</td>
<td>0</td>
<td>0, 1, or 2</td>
</tr>
<tr>
<td></td>
<td>• 0 = Click-to-center, then continuous</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• 1 = Drag or double-click-to-center</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• 2 = Continuous</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MixedPanAndTiltTimeOutMS</td>
<td>Sets the timeout value used in Click-to-center, then continuous (in milliseconds).</td>
<td>300</td>
<td>0 - 65535</td>
</tr>
</tbody>
</table>

## Zoom Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Default</th>
<th>Possible Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>ServerZoomMode</td>
<td>Zoom operation in server mode:</td>
<td>0</td>
<td>0, 1, or 2</td>
</tr>
<tr>
<td></td>
<td>• 0 = Step, then continuous</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• 1 = Step mode</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• 2 = Continuous</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Note:</td>
<td>This parameter can also be configured with the Zoom mode drop-down list on</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>the PTZ Options dialog.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ClientZoomMode</td>
<td>Zoom operation in client (digital) mode:</td>
<td>0</td>
<td>0, 1, or 2</td>
</tr>
<tr>
<td></td>
<td>• 0 = Step, then continuous</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• 1 = Step mode</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• 2 = Continuous</td>
<td></td>
<td></td>
</tr>
<tr>
<td>RelativeZoomStep</td>
<td>The number that the current focal length is multiplied (or divided) by when</td>
<td>2</td>
<td>&gt;1.0</td>
</tr>
<tr>
<td></td>
<td>the zoom in or zoom out button is pressed in step mode.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MixedZoomTimeOutMS</td>
<td>Sets the timeout value used in Step, then continuous mode (in milliseconds).</td>
<td>300</td>
<td>0 - 65535</td>
</tr>
</tbody>
</table>
## Focus Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Default</th>
<th>Possible Values</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>ServerFocusMode</strong></td>
<td>Focus operation in server mode:</td>
<td>0</td>
<td>0, 1, or 2</td>
</tr>
<tr>
<td></td>
<td>• 0 = Step, then continuous</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• 1 = Step mode</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• 2 = Continuous</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>This parameter can also be configured with the Focus mode drop-down list on</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>the PTZ Options dialog.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>ClientFocusMode</strong></td>
<td>Focus operation in client (digital) mode:</td>
<td>0</td>
<td>0, 1, or 2</td>
</tr>
<tr>
<td></td>
<td>• 0 = Step, then continuous</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• 1 = Step mode</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• 2 = Continuous</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>RelativeFocusStep</strong></td>
<td>Determines the size of each step in step mode. Value is normalized for the</td>
<td>2</td>
<td>1 - 100</td>
</tr>
<tr>
<td></td>
<td>range of focus available for the camera.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>This parameter can also be configured with the Focus step (1-100) field on</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>the PTZ Options dialog.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>MixedFocusTimeOutMS</strong></td>
<td>Sets the timeout value used in Step, then continuous mode (in milliseconds).</td>
<td>300</td>
<td>0 - 65535</td>
</tr>
</tbody>
</table>

## Iris Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Default</th>
<th>Possible Values</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>ServerIrisMode</strong></td>
<td>Iris operation in server mode:</td>
<td>0</td>
<td>0, 1, or 2</td>
</tr>
<tr>
<td></td>
<td>• 0 = Step, then continuous</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• 1 = Step mode</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• 2 = Continuous</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>This parameter can also be configured with the Iris mode drop-down list on</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>the PTZ Options dialog.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>ClientIrisMode</strong></td>
<td>Iris operation in client (digital) mode:</td>
<td>0</td>
<td>0, 1, or 2</td>
</tr>
<tr>
<td></td>
<td>• 0 = Step, then continuous</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• 1 = Step mode</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• 2 = Continuous</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
**Iris Parameters**

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Default</th>
<th>Possible Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Relative Iris Step</td>
<td>Determines the size of each step in step mode. Value is normalized for the range of iris available for the camera. Note: This parameter can also be configured with the Iris step (1-100) field on the PTZ Options dialog.</td>
<td>2</td>
<td>1 - 100</td>
</tr>
<tr>
<td>Mixed Iris TimeOutMS</td>
<td>Sets the timeout value used in Step, then continuous mode (in milliseconds).</td>
<td>300</td>
<td>0 - 65535</td>
</tr>
</tbody>
</table>

**PTZ Joystick Selection**

If multiple joysticks are connected to the same workstation, the ACS.INI file can be used to specify which joystick will be used. Each connected joystick is listed as a parameter in the [DigitalVideo] section as InputDeviceName1, InputDeviceName2, etc. Set InputDeviceName (without a number) equal to the joystick name you wish to use as it is written in the file.

**Configure PTZ Locking**

PTZ options can be configured in Alarm Monitoring.

1. From the Options menu select PTZ Options.
2. The PTZ Options dialog is displayed.
3. The Default access mode drop-down list is used to specify the locking mode used by default when video is launched for a PTZ camera.
   - Locked access mode gives control of the PTZ functions to the first user to activate PTZ. If another user attempts to activate PTZ for the same camera, they will receive a message that PTZ control is locked by another user.
   - Shared access mode allows multiple users to have access to the PTZ controls at the same time.
4. A timeout can be enabled for PTZ control with the Timeout (in seconds) check box.
   - If selected, you may specify an amount of time (in seconds) after which the PTZ controls will become unlocked. After this period another user may gain control of the camera.
   - For no timeout on locking, simply clear the Timeout (in seconds) check box. Unlocking will only occur when the video window is closed, PTZ control is cancelled (by deselecting the PTZ button), or PTZ locking mode is changed to shared (by deselecting the PTZ locked button).

**Presets**

Client side presets can be absolute camera positions or PTZ commands. Presets are added to the PTZ Presets drop-down and can be selected by the user to
control the camera. To open the PTZ Presets dialog, click \[\text{PTZ}\] in the Video Player window to activate PTZ, then select the **Options > Presets** menu item or click the Preset button \[\text{Preset}\] in the PTZ toolbar.

**PTZ Preset dialog in Advanced mode**

The PTZ Preset dialog has both a simple and an advanced mode. The simple mode can be used to configure a preset for an absolute camera position or to delete an existing preset. The advanced mode can be used to configure a preset for an absolute camera position or to configure a PTZ command.

![PTZ Preset dialog](image)

<table>
<thead>
<tr>
<th>Field</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type new name or select existing preset</td>
<td>Enter descriptive name for the preset or select an existing preset from the drop-down.</td>
</tr>
<tr>
<td>Overwrite selected preset</td>
<td>Select this check box to replace an existing preset with a new camera position or command.</td>
</tr>
<tr>
<td>Delete</td>
<td>Click this button to delete the selected preset.</td>
</tr>
<tr>
<td>Advanced</td>
<td>Click this button to toggle between the simple and advanced PTZ Preset dialogs.</td>
</tr>
</tbody>
</table>
Add an Absolute Preset

To set a client side preset for an absolute camera position using the PTZ Preset dialog in simple mode:

1. In the Video Player window, click \[ \text{Move to absolute position} \] to activate PTZ.
2. Use the PTZ controls to move the camera to the desired position.
3. From the Options menu, select Presets or click the Preset button \[ \text{Move to absolute position} \] in the PTZ toolbar.
4. The PTZ Preset dialog is displayed in simple mode. Enter a descriptive name for the preset or select an existing preset from the drop-down.
5. If you want to overwrite an existing preset, select the Overwrite selected preset check box.
6. Return to the video player window and adjust the camera position if desired.
7. Click [OK] to save the preset.
Add a Relative or Continuous Preset

1. In the Video Player window, click \[\text{PTZ}\] to activate PTZ.

2. From the Options menu, select Presets or click the Preset button in the PTZ toolbar.

3. The PTZ Preset dialog is displayed. Enter a descriptive name for the preset or select an existing preset from the drop-down.

4. If you want to overwrite an existing preset, select the Overwrite selected preset check box.

5. Click [Advanced].

6. Select the Move relatively by or Move continuously radio button.

7. Return to the Video Player window and execute the desired preset command. This will automatically populate the values in the PTZ Preset dialog.

8. Return to the PTZ Preset dialog.

9. If you are configuring a continuous command, enter the Duration (sec) that the camera should move for.

10. Click [Test] to view the preset in the Video Player window.

11. Make adjustments to the configuration as needed, then click [Save].

Add a Camera Side Preset

The following procedure allows you to add preset previously configured on the camera to the system and give it a descriptive name.

1. In the Video Player window, click \[\text{PTZ}\] to activate PTZ.

2. From the Options menu, select Presets or click the Preset button in the PTZ toolbar.

3. The PTZ Preset dialog is displayed. Enter a descriptive name for the preset or select an existing preset from the drop-down.

4. If you want to overwrite an existing preset, select the Overwrite selected preset check box.

5. Click [Advanced].

6. Select the Camera preset radio button and enter the number of the camera side preset in the text box.

7. Click [Test] to view the preset in the Video Player window.

8. Click [Save].
PTZ Tours

PTZ tours can be created using absolute camera positions and PTZ commands. PTZ tours can be run manually, continuously, or scheduled to run at specific times. PTZ tours should begin with an absolute camera preset to ensure the tour is properly executed.

PTZ Tour Dialog

The PTZ Tour dialog allows you to add, modify, delete, and run PTZ tours. To open the PTZ Tour dialog, click in the Video Player window to activate PTZ, then select the Option > Tours menu item.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type new name or select existing tour</td>
<td>Enter descriptive name for the tour or select an existing tour from the drop-down.</td>
</tr>
<tr>
<td>Overwrite selected tour</td>
<td>Select this check box to replace an existing tour with a new configuration.</td>
</tr>
<tr>
<td>Delete</td>
<td>Click this button to delete the selected tour.</td>
</tr>
</tbody>
</table>
5: Video Monitoring

<table>
<thead>
<tr>
<th>Field</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Listing window</td>
<td>The list of the presets that make up the tour.</td>
</tr>
<tr>
<td></td>
<td>Edit the Delay (sec) column to change the number of seconds the tour should pause after executing the currently selected preset.</td>
</tr>
<tr>
<td>Continuously</td>
<td>Select this check box to run the tour continuously.</td>
</tr>
<tr>
<td>On the background PTZ tour server</td>
<td>Select this check box if you wish to continue running the tour after the video player has been closed. Select the PTZ tour server from the drop-down.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Background PTZ tours can only be interrupted by a user with a higher priority or by the user that started the tour. The PTZ timeout value is not utilized with background PTZ tours.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> A PTZ Tour Server must be configured on the Digital Video &gt; PTZ Tour Server tab in System Administration to run a tour continuously in the background. For more information, refer to PTZ Tour Server Form on page 110.</td>
</tr>
<tr>
<td>Save</td>
<td>Click this button to save the tour.</td>
</tr>
<tr>
<td>Exit</td>
<td>Click to exit the PTZ Tour dialog.</td>
</tr>
<tr>
<td>Up/Down</td>
<td>Use the [Up] and [Down] buttons to reorder the presets in the listing window.</td>
</tr>
<tr>
<td>Remove</td>
<td>Remove the selected step from the tour.</td>
</tr>
<tr>
<td>Run</td>
<td>Click this button to test the tour in the video player window.</td>
</tr>
</tbody>
</table>
Add a PTZ Tour

PTZ tours are composed of a sequence of camera presets.

1. In the Video Player window, click to activate PTZ.
2. Use the PTZ controls in the Video Player window to move the camera to the desired start point.
3. Open the PTZ Presets dialog by selecting Options > Presets from the Video Player menu.
4. In the PTZ Preset dialog, click [Advanced].
5. Click [Current] to update the absolute position values to the current camera position.
6. Enter a name for the starting point of the tour and click [Save].
7. Open the PTZ Tour dialog by selecting Options > Tours from the Video Player menu.
8. Click <Click here to add new step> in the listing window.
9. Select the preset from the drop-down and enter the amount of time the tour should pause before the next step in the Delay (sec) column.
10. Create the next preset:
   a. In the PTZ Preset dialog, enter a preset name for the next step of the tour.
   b. Select the radio button for the type of preset you wish to configure.
   c. Return to the Video Player window and execute the command for the preset.
   d. Click [Save] in the PTZ Preset dialog.
11. Add the preset to the tour:
   a. In the PTZ Tour dialog, click <Click here to add new step> in the listing window.
   b. Select the preset from the drop-down.
   c. In the Delay (sec) column, enter the amount of time the tour should pause before executing the next step of the tour.
12. Repeat steps 10 and 11 to add additional steps to the tour.
13. When you have finished creating the tour, click [Save] in the PTZ Tour dialog.
5: Video Monitoring

Run a PTZ Tour

1. In the Video Player window, click 📺 to activate PTZ.
2. Launch the PTZ Tour dialog by selecting Options > Tours from the Video Player menu.
3. Select the PTZ tour from the listing window drop-down.
4. Click [Run].

Note: The Preset button in the PTZ toolbar will remain pressed while the tour is running. To interrupt the tour, simply execute any PTZ command or menu option. The tour will also stop if control is taken over by another user with higher PTZ priority level or when the PTZ control is given up by closing the video window or deselecting the PTZ button. If the tour is set to run in the background, an option will be given to resume the tour once PTZ control is relinquished.

Remote Monitor

Remote Monitor (RM), commonly referred to as “camera call-up”, is a video monitoring application that can be run on any PC with or without B.A.S.I.S. installed. Configuration is performed in System Administration. The RM application behaves as a slave to the Alarm Monitoring application which is used to send video commands allowing the user to:

• Launch video on the RM or Remote Monitor Group (RMG).
• View status of the RMs in the System Hardware Tree and the RMGs in the Device Group window.
• Send matrix mode, camera selection, and video playback commands to the RM.
• Mute audio.
• Drag and drop cameras onto the RM or RMG icon to start live video playback.
• Drag and drop alarms with associated video onto the RM or RMG icon to start recorded video playback.
• Launch a local monitor window on the Alarm Monitoring workstation to send commands performed in the window to the RM.

LNVR Security

Currently there is no secure communication between the RM and the B.A.S.I.S. software. The RM must use another method of authentication to an LNVR with security settings because it cannot receive credentials from the B.A.S.I.S. server.
To enable authentication with the LNVR, log on to the RM client with a Windows user account that belongs to the LNVUsers group or configure RM to run as a LNVUsers group member.

**Note:** If anonymous DCOM is disabled on the LNVR, the Windows user logged on to the RM client must be authenticated by the LNVR as Everyone or Administrator.

---

### Add Cameras to a Remote Monitor

Cameras can be added via multiple drag and drop operations.

The source of the camera can be one of the following:
- Camera icon in the System Status Tree
- Alarm icon that has associated video from the Alarm view

The target of the drag and drop operations can be one of the following:
- RM icon in the hardware tree or device group view
- RMG icon in the device group view
- Local monitor window

Cameras that have been added to a Remote Monitor appear in the System Status Tree below the RM and are referred to as video cells or Remote Monitor Cells (RMC). RMGs are displayed in the Device Group window with lists of the RMGs that belong to each group. Cameras added to RMGs are added to each RM that belongs to that group.

- 🎥 - Remote Monitor
- 🎥 - Remote Monitor Cell
- 🎥 - Remote Monitor Group

### Remote Monitor Right-click Options

Commands are available for RMGs and RMCs through a right-click menu and drag and drop functionality. Right-click options specific to Remote Monitors are listed in the table below.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Launch Video</td>
<td>Launches the local monitor window in Alarm Monitoring.</td>
</tr>
<tr>
<td>(RM)</td>
<td></td>
</tr>
</tbody>
</table>

---
Remote Monitor Right-click options

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Launch Video</td>
<td>Launches video on the RM and the local monitor window in Alarm Monitoring.</td>
</tr>
<tr>
<td>(RMC)</td>
<td></td>
</tr>
<tr>
<td>Download Database (RM)</td>
<td>Synchronizes the RM with the camera channels assigned in Alarm Monitoring.</td>
</tr>
<tr>
<td>Remove All (RM)</td>
<td>Removes all video from the RM.</td>
</tr>
<tr>
<td>Remove (RMC)</td>
<td>Removes the video cell from the RM.</td>
</tr>
<tr>
<td>Select (RMC)</td>
<td>In matrix view, changes to single player mode with the selected video cell.</td>
</tr>
<tr>
<td>Matrix</td>
<td>Switches the RM to matrix view.</td>
</tr>
<tr>
<td>Single</td>
<td>Switches the RM to single player mode.</td>
</tr>
<tr>
<td>Next</td>
<td>In single player mode, selects the next video cell in the list</td>
</tr>
<tr>
<td>Prev</td>
<td>In single player mode, selects the previous video cell in the list.</td>
</tr>
<tr>
<td>Live</td>
<td>Changes to live video on each video cell in the RM.</td>
</tr>
<tr>
<td>Recorded</td>
<td>Changes to recorded video on each video cell in the RM.</td>
</tr>
<tr>
<td>Pause</td>
<td>Pauses the video playback on each video cell.</td>
</tr>
<tr>
<td>Play</td>
<td>Resumes the video playback on each video cell.</td>
</tr>
<tr>
<td>Stop</td>
<td>Stops the video playback on each video cell.</td>
</tr>
<tr>
<td>Frame Advance</td>
<td>Advances one video frame on each video cell.</td>
</tr>
<tr>
<td>Fast Forward End</td>
<td>Fast forwards to the end on each video cell.</td>
</tr>
<tr>
<td>Mute Audio</td>
<td>Mutes the audio on the RM or video cell.</td>
</tr>
<tr>
<td>Unmute Audio</td>
<td>Turns mute off for the RM or video cell.</td>
</tr>
</tbody>
</table>

Local Monitor Window in Alarm Monitoring

The Local Monitor Window (LMW) is a mirror of the RM that can also be used to send commands from Alarm Monitoring. To open the LMW, right-click on the RM or RMC in the System Status Tree and select **Launch Video**. If the LMW is opened from an RMC, the RM will switch to single view and display the selected video cell.

The following commands will be sent to the RM while manipulating video in the LMW:

- Remove selected cameras. This can be done by selecting **Remove Video** from the right-click menu in matrix mode, by selecting **Remove Video** from the Control menu, or by pressing the delete key.
- Switch to matrix view or single player view.
- Select camera, move to the next camera, and move to the previous camera in single player view.
• Switch between live and recorded video.
• Change recorded video time frame.
• Pause, resume, stop, frame advance, and fast forward to end commands.
• Mute audio, when selected from the right-click menu. If audio is muted in the LMW by clicking the speaker icon, this command will not be sent to the RM.

Remote Monitor Application

The Remote Monitor Application (RMA) behaves as a slave to Alarm Monitoring and does not support any video commands. The user has the following commands available:

• Launch and exit the application. Upon exit, the RMA looses video cell information. When the RMA comes back online, it must be synchronized via the Download Database command in Alarm Monitoring.
• Move and resize the main window.
• Close the application window.
• Open the window and exit the application by right-clicking the application’s icon in the system tray.
• Mute audio on one or more cameras by clicking the speaker icon.
• Turn on and off automatic window launch via the Auto launch on command in the Options menu. When this setting is enabled, the RMA window will open to the previous position when the RM receives a matrix mode, camera selection, or video playback command.
• Activate full screen mode by selecting Full Screen from the Options menu. To deactivate full screen mode, press <Esc>. You can also toggle full screen by pressing <Alt> + <Enter>.
• Change the TCP/IP connection port.
**Change the Remote Monitor TCP/IP Port**

The Remote Monitor TCP/IP port is used by B.A.S.I.S. to communicate with the Remote Monitor. The port number in the Remote Monitor application must match the port number defined in System Administration.

1. In the Remote Monitor application, select the **Connection > Settings** menu option.
2. The Connection Settings window is displayed.
   
   ![Connection Settings Window]

   a. Enter the new port number in the **TCP/IP Port** field.

   b. Click [OK].

**Application Profiles**

Users of the Remote Monitor application can save the current settings as a profile for later use. Settings such as TCP/IP port number, window position, always on top, launch on command, and full screen mode are part of a Remote Monitor application profile.

---

**Note:** Remote Monitor must be run by a user with Administrative permissions to save or remove profiles.
Save a Remote Monitor Profile

1. In the Remote Monitor application, select the Profile > Save As menu option.

2. The Save Profile window is displayed.

   - To create a new profile, select the Create New radio button and enter a Name.
   - To change an existing profile, select the Overwrite Existing radio button and highlight the profile you want to update.

3. Click [OK] to save the profile.
Load a Remote Monitor Profile

1. In the Remote Monitor application, select the Profile > Load menu option.
2. The Load Profile window is displayed.
   
   ![Load Profile Window]
   
   a. Select the profile you want to load.
   b. Click [OK].
Remove a Remote Monitor Profile

1. In the Remote Monitor application, select the Profile > Save As menu option.

2. The Save Profile window is displayed.

   a. Select the Overwrite Existing radio button.
   b. Highlight the profile you wish to delete.
   c. Click [Remove].

3. Click [OK] to close the Save Profile window.
5: Video Monitoring
Chapter 6: Video Verification

Video verification is the process of comparing “live” (as it is happening) video with a photograph stored in the database. When a person swipes a badge through a reader, you can use video verification to compare the cardholder’s photo.

Displayed by:
The Video Verification window can be displayed several ways:
- Select the Video Verification toolbar button.
- From the View menu select Video Verification.

Video Verification Configuration Dialog

<table>
<thead>
<tr>
<th>Form element</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Video verification type</td>
<td>Select <strong>Use digital video verification</strong> if you are using cameras that connect to a video recorder or <strong>Use standard video verification</strong> if you are using CCTV.</td>
</tr>
<tr>
<td>Use all video enabled readers</td>
<td>Select this check box to use all readers that have a Device-Camera Link established in System Administration.</td>
</tr>
<tr>
<td>Reader listing window</td>
<td>If you do not wish to use all applicable readers, select each camera that you wish to use individually.</td>
</tr>
<tr>
<td>Maximum number of videos to display</td>
<td>Select a number 1-10 from the drop-down list to indicate the maximum number of items you wish to display in the Video Verification window.</td>
</tr>
</tbody>
</table>
Digital Video Verification

Digital Video Verification is used with cameras connected to a video recorder.

- Live video and cardholder information is displayed for each video verification item.
- Multiple video verification views can be displayed concurrently in the Digital Video Verification window. The most recent view appears on top.
- If multiple cameras are linked to a device, the camera with the View Order of 1 (from the Device - Camera Links form in System Administration) will be displayed.

Digital Video Verification Window

Digital Video Verification Procedures

Set Up Digital Video Verification

Several procedures must be completed in System Administration prior to using Digital Video Verification. Refer to the System Administration User Guide for additional information about each of the following steps.

1. Configure the video recorders and cameras that will be used with Digital Video Verification.
2. Configure the additional devices (such as readers) that will be used with the cameras for video verification.
3. Configure a Device-Camera link for each camera and device pair. If more than one camera is associated with a device, the camera with a view order of 1 is used with video verification.
**Standard Video Verification**

Standard Video Verification is used with CCTV cameras.
- Alarms are displayed in the Video Verification window.

**Standard Video Verification Window**

<table>
<thead>
<tr>
<th>Form element</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Panels/readers window</td>
<td>Lists all panels and readers in the system.</td>
</tr>
<tr>
<td>Selected readers</td>
<td>Contains those readers from which the Video Verification window will receive information. If this list is empty, no alarms will display in the Video Verification window.</td>
</tr>
<tr>
<td>Live video</td>
<td>Displays live video from a CCTV (camera) device at a specific location.</td>
</tr>
<tr>
<td></td>
<td>- If you see a black box instead of live video, it means that either there is no camera available or the camera isn't working properly.</td>
</tr>
<tr>
<td></td>
<td>- If you see a “Live video not available” message, it means that your System Administrator has made live video from that location unavailable to Alarm Monitoring stations.</td>
</tr>
<tr>
<td>Photograph</td>
<td>Displays a specific cardholder record photo.</td>
</tr>
<tr>
<td>On new event display</td>
<td>Includes the Photograph and Video check box fields.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Video</strong>: If checked, pan, tilt and zoom CCTV commands are automatically enabled. If unchecked, pan, tilt and zoom CCTV commands must be manually invoked. Live video remains visible regardless of the state of this check box.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Photograph</strong>: If checked, as each new alarm arrives, the corresponding cardholder photo displays.</td>
</tr>
</tbody>
</table>
Standard Video Verification Procedures

Add or Remove Readers

To add or remove readers using the video verification window, the reader must be added to the Selected Readers list.

Note: The Panels/Reader list is located in the upper left portion of the Video Verification window. The Selected Readers list is located in the lower left portion of the Video Verification window.

- To add an entry to the Selected Readers list, double-click the reader in the Panels/Readers list.
- To add a entry to the Selected Readers list, select one or more alarm(s) before you open the Video Verification window, the corresponding reader(s) will be added automatically.
- To add all the readers associated with a particular panel, double-click the panel entry in the Panels/Readers list.
- To remove a reader from the Selected Readers list, double-click the reader’s entry in the Selected Readers list.

Display the Cardholder Photo and Live Video

Clicking an alarm in the video verification alarms window displays both the cardholder photo and live video from a camera at the reader. Live video continues to display until one of the following happens:

- You click another alarm.
- Another alarm arrives (this is true only if the Video check box is selected.)
Notes:  The Video check box must be selected to display live video when a new alarm occurs.  
The Photograph check box must be selected to display the cardholder's photograph when a new alarm occurs.

Delete an Alarm in the Video Verification Window

- To remove an alarm from the alarms window, click the alarm then select Delete from the Edit menu or right-click the alarm and select Delete.
- To clear all alarms from the alarms window, select Delete All from the Edit menu.
Appendices
Appendix A: Exporting Video

The B.A.S.I.S. installation includes a conversion utility that converts exported video from the LDVR or LNVR native format to an “.asf” format. The “.asf” file format is playable on any machine that has Microsoft’s Windows Media Player and does not require any additional software to play video. The video converter is located at: C:\Program files\Common Files\Lenel\LVConvert.exe.

You can run the conversion utility either from a command line or by launching the utility. To use the standalone video conversion utility to export video, refer to Convert and Export Video on page 228.

The video converter is also available from within the VideoViewer and Alarm Monitoring applications. When used standalone, the source file can be changed in the Lenel Video Converter window; when used in Alarm Monitoring and VideoViewer it cannot. To use the video converter in VideoViewer or Alarm Monitoring to export video, refer to Export Video to a File on page 227.
## Video Converter Window

<table>
<thead>
<tr>
<th>Form Element</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source file</td>
<td>Identifies the export file to be converted to the Windows Media format.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The <strong>Source file</strong> and <strong>Output file</strong> fields cannot be modified in Alarm Monitoring or VideoViewer; they can only be modified when using the standalone version of the video converter.</td>
</tr>
<tr>
<td>Browse</td>
<td>Search for the export file to be converted to the Windows Media format.</td>
</tr>
<tr>
<td>Output file</td>
<td>Name of the new file to be created.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The <strong>Source file</strong> and <strong>Output file</strong> fields cannot be modified in Alarm Monitoring or VideoViewer; they can only be modified when using the standalone version of the video converter.</td>
</tr>
<tr>
<td>Browse</td>
<td>Search for the location the new file should be created in.</td>
</tr>
<tr>
<td>Generate Overlay</td>
<td>If enabled, additional information such as time and date will be overlaid on the video image. If this check box is selected, the default is to show the date and time in the top-left corner.</td>
</tr>
<tr>
<td>Customize</td>
<td>Enables the user to customize the format and the content of overlay information.</td>
</tr>
<tr>
<td>Status area</td>
<td>Updates as the video is exported to show how much video has been exported and how much video still needs to be exported.</td>
</tr>
<tr>
<td>Convert</td>
<td>Converts the file from its native format to an “.asf” format.</td>
</tr>
<tr>
<td>Close</td>
<td>Closes the window without converting the file from its native format to an “.asf” format.</td>
</tr>
<tr>
<td>Help</td>
<td>Displays online help.</td>
</tr>
</tbody>
</table>
Video Export Dialog

<table>
<thead>
<tr>
<th>Form Element</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output Type</td>
<td>Specifies the format for the exported video:</td>
</tr>
<tr>
<td></td>
<td>• Native Format - video format determined by the video recorder</td>
</tr>
<tr>
<td></td>
<td>• Windows Media Format - overlay may be applied to the video</td>
</tr>
<tr>
<td>Digital Signature</td>
<td>Specifies whether the watermarking uses the default or custom key/signature. For more information, refer to Authenticate a Video File with Watermarking on page 229.</td>
</tr>
<tr>
<td>Custom Signature</td>
<td>Specifies a custom digital key/signature.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The Custom Signature is case sensitive.</td>
</tr>
<tr>
<td>File Name</td>
<td>Search for the location the new file should be created in.</td>
</tr>
<tr>
<td>Comments</td>
<td>Text entered in this field will be displayed during the digital signature verification process.</td>
</tr>
<tr>
<td>Generate Overlay Image</td>
<td>If enabled, additional information such as time and date will be overlaid on the video image. If this check box is selected, the default is to show the date and time in the top-left corner.</td>
</tr>
<tr>
<td>Customize</td>
<td>Enables the user to customize the format and the content of overlay information.</td>
</tr>
<tr>
<td>Export</td>
<td>Saves the recorded video to a file using the configured options.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Aborts the export after the process has begun.</td>
</tr>
<tr>
<td>Close</td>
<td>Exits the dialog without exporting the video.</td>
</tr>
<tr>
<td>Help</td>
<td>Displays online help.</td>
</tr>
</tbody>
</table>
**Customize Overlay Information Dialog**

<table>
<thead>
<tr>
<th>Form Element</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date Location</td>
<td>Identifies which corner(s) the date will be printed. Possible values are top-left, top-right, bottom-left, bottom-right, and none. If none is selected, the field will not be shown. The default is to show the date and time in the top-left corner and no text.</td>
</tr>
<tr>
<td>Time Location</td>
<td>Identifies which corner(s) the time will be printed. Possible values are top-left, top-right, bottom-left, bottom-right, and none. If none is selected, the field will not be shown. The default is to show the date and time in the top-left corner and no text.</td>
</tr>
<tr>
<td>Text Location</td>
<td>Identifies which corner(s) the additional text will be printed. Possible values are top-left, top-right, bottom-left, bottom-right, and none. If none is selected, the field will not be shown. The default is to show the date and time in the top-left corner and no text.</td>
</tr>
<tr>
<td>Row fields</td>
<td>If more than one piece of information is printed in the same corner, this field allows you to specify if one item should appear above the other one. If the items are on the same row, they will be printed one after the other.</td>
</tr>
<tr>
<td>Text</td>
<td>Enter any additional text that you want to appear in the video. For example, the text could identify the location where the video came from.</td>
</tr>
<tr>
<td>Change</td>
<td>Allows the user to specify a different font, style, and color of the printed information.</td>
</tr>
<tr>
<td>Transparency</td>
<td>Specifies the transparency level of the printed text where 0 means the text is invisible and 100 means the text is opaque.</td>
</tr>
<tr>
<td>OK</td>
<td>Accepts the changes and closes the dialog.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Closes the dialog without applying any changes.</td>
</tr>
<tr>
<td>Load Settings</td>
<td>Loads a previously saved overlay configuration.</td>
</tr>
<tr>
<td>Save Settings</td>
<td>Saves an overlay configuration.</td>
</tr>
</tbody>
</table>
Video Conversion Procedures

The following procedures are used to convert, export and play B.A.S.I.S. video clips.

Note: The conversion utility converts “.lnr” or “.info/.spfs” files into “.asf” format.

Export Video to a File

This procedure describes using the video converter in VideoViewer or Alarm Monitoring. When using the standalone video conversion utility, refer to Convert and Export Video on page 228.

Recorded video and audio can be saved/exported to a file. By default the video clip is saved as “.asf” which can be played on any Microsoft Windows Media Player. In addition, video clips can be saved in Lenel proprietary formats. For LDVR hardware, proprietary formats include “.info” and “.spfs” files and for LNVR hardware the proprietary format is “.lnr” files.

Note: If you have video files in proprietary formats, you can use the conversion utility available at: C:\Program Files\Common Files\Lenel\LVConvert.exe. For more information, refer to Appendix A: Exporting Video on page 223.

1. While viewing recorded video in the Video Player, select Set Start/End Date from the Options menu.
2. The Date/Time window opens. Fill in the appropriate dates and times and click [OK].
3. From the Options menu select Export Video. The Video Export Dialog is displayed.
4. Select the Output Type from the drop-down list. The specific file type is determined in step 5.
5. Click the [...] button to browse for a location to save the exported video file. The Save As window opens.
   a. Select the file location.
   b. Enter the file name.
   c. Select the desired file format (*.asf), (*.info), (*.spfs), or (*.lnr).
**A: Exporting Video**

**Note:** The file formats available in the drop down list reflect the output type chosen in Step 4.

d. Click [Save].

6. The Windows Media Format allows the use of an overlay image.
   a. Select the **Generate Overlay Image** check box to overlay the time and date on the video image.

7. To customize the content of overlay information, click [Customize]. The Customize Information Overlay Dialog opens. Click [Export].

**Convert and Export Video**

This procedure describes using the standalone video conversion utility. When using the video converter in VideoViewer or Alarm Monitoring, refer to Export Video to a File on page 227.

The conversion utility is installed with B.A.S.I.S. and can be executed from a command line as well as by launching the utility.
Using the Conversion Utility

1. Navigate to C:\Program Files\Common Files\Lenel.
2. Run the LVConvert.exe program in this directory.
3. The Video Converter window opens. Enter the source file name.
4. Enter the output file name.
5. Optional - Select and customize any overlay information.
6. Click [Convert].
7. Click [Close] when the conversion is complete.

Using a Command Line

1. Click Start, then select Run. The Run dialog opens.
2. Enter “LVConvert.exe -i InputFile.lnr -o OutputFile.asf [-c ConfigFile.xml] [-s]” where:
   • i specifies the input file
   • o specifies the output file
   • c (optional) specifies the overlay configuration file. If not specified, overlay information will not be generated.
   • s (optional) silent run. If specified the application will not pop up any error/status dialog boxes. This is useful if you are running the application as part of a script.
3. Click [OK].

Play Exported Video Clip Using Windows Media Player

1. Launch the Windows Media Player. On most Windows machines, you can do this by clicking Start, then Programs > Accessories > Entertainment > Windows Media Player.
2. On the File menu, select Open.
3. Type in the location of the video clip, or click on [Browse] to navigate to it.
4. Click [OK] (or [Open] if you browsed to the file). The video clip will be played in the Media Player window.

Authenticate a Video File with Watermarking

Embedding a watermark in the video file is equivalent to signing a digital identification on the content of the video. If the video is manipulated, the watermark is destroyed. The authenticator can verify whether a received video has been tampered with by attempting to match the signature.

The Watermarking feature allows the individual exporting the video to set a custom digital signature which can later be verified by the recipient of the video file.
Set a Watermark

1. From the Video Export Dialog in Alarm Monitoring or VideoViewer, select “Native Format” from the Output Type drop-down.
2. Select the type of signature, “Custom” or “Default”, from the Digital Signature drop-down list.
3. If you selected “Custom”, in the Custom Signature text box, enter a key for authentication (case sensitive). The recipient of the file will need to know this key to determine the validity of the video file.

Note: The Default signature type does not require a key for authentication.

4. Select other options as desired and click [Export] to finish. For more information, refer to Export Video to a File on page 227.

Authenticate the Watermark

Authentication of the watermark occurs with the stand-alone Lenel Video Player (LVPlayer.exe).

1. Navigate to the C:\Program Files\Common Files\Lenel directory and run LVPlayer.exe.
2. From the File menu, select Open File.
3. From the Control menu, select Verify Signature. The Signature Details dialog is displayed.
4. If a custom signature was entered during export, type the key entered in the Enter Signature text box.

Notes: The custom signature is case sensitive.
If the Default signature type was used during export the Enter Signature text box will be grayed out.

5. Click [Verify Signature]. A message will be displayed indicating whether the authentication was successful.
Appendix B: **IntelligentAudio**

IntelligentAudio performs audio analysis on forensic (live or recorded) video in Alarm Monitoring or VideoViewer. The Video Search can be used to monitor live or scan recorded video for audio events. Searches can be performed based on the type and volume of sound detected.

The Audio Level event can be configured in System Administration to trigger alarms in Alarm Monitoring. For more information, refer to IntelligentAudio Events Form on page 139.

Once Video Search is launched, select an IntelligentAudio event from the Event > Select Event > IntelligentAudio menu.

---

**Audio Level**

The Audio Level event identifies sound events crossing a volume threshold.

**Event Properties**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threshold</td>
<td>Volume threshold for detection. Use the level displayed on the Event Feedback pane to determine a value appropriate to the scene.</td>
</tr>
<tr>
<td>Minimal Duration (seconds)</td>
<td>Length of time that sound should continue before an event is detected. The range of values is 0.010 to 10.000 seconds.</td>
</tr>
</tbody>
</table>

**High Pitch Sounds**

Typical high pitch sounds include: screams, sirens, squealing tires, etc.

**Event Properties**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threshold</td>
<td>20</td>
</tr>
<tr>
<td>Minimal Duration (seconds)</td>
<td>0.500</td>
</tr>
</tbody>
</table>
Impact Sounds

Typical impact sounds include: fallen object, crash, gunshot, etc.

Event Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threshold</td>
<td>Volume threshold for detection. Use the level displayed on the Event Feedback pane to determine a value appropriate to the scene.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimal Duration</td>
<td>Length of time that sound should continue before an event is detected. The range of values is 0.060 to 10.000 seconds.</td>
</tr>
</tbody>
</table>

Unclassified Sounds

The Unclassified Sounds event can be used to detect sounds not classified as impact or high pitch. For example, undefined noise, speech, car starting, etc.

Event Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threshold</td>
<td>Volume threshold for detection. Use the level displayed on the Event Feedback pane to determine a value appropriate to the scene.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimal Duration (seconds)</td>
<td>Length of time that sound should continue before an event is detected. The range of values is 0.060 to 10.000 seconds.</td>
</tr>
</tbody>
</table>
Index

Symbols
"D" protocol .......................................................... 153
example .................................................................. 156
message format ...................................................... 153
standard command set .............................................. 153

A
Add
camera ....................................................................... 71
event settings .......................................................... 109
matrix switcher .......................................................... 147
matrix switcher type .................................................. 150
readers ..................................................................... 218
video recorder .......................................................... 39
virtual matrix switcher ................................................. 147
Alarm - Video Configuration form ................................. 90
procedures ................................................................ 92
Apply
motion mask to a camera ........................................... 77
Archive Server form .................................................. 94
field table ................................................................. 94
procedures ................................................................ 96
ASCII protocol example .............................................. 156
Audio Level event .......................................................... 140
Authenticating video files ............................................ 229
setting a watermark .................................................. 230
Automatic gain control .................................................. 105

B
Binary protocol example .............................................. 156
Blind camera configuration
LNVS ........................................................................ 70
Blind Camera event
automatic gain control ................................................. 105
Blind camera event
configuration/search dialog ......................................... 104
overview ................................................................ 103
Brightness Change event
configuration/search dialog ......................................... 106
overview ................................................................ 106
Buffering Video ........................................................... 167

C
Camera form
Audio sub-tab .............................................................. 63
Capacity sub-tab .......................................................... 67
Communication sub-tab ................................................. 44
Connection sub-tab ....................................................... 47
Event Mode sub-tab ...................................................... 61
Event Recording sub-tab .............................................. 61
In-camera storage sub-tab ............................................ 64
Normal Mode sub-tab .................................................. 57
procedures ................................................................ 68
add camera with LNVR recorder ............................... 68
add camera with LNVS recorder ............................... 70
add LDVR, Generic Video or Loronix cameras .............. 71
Quality sub-tab .......................................................... 53
Record settings sub-tab ................................................. 50
Video sensor sub-tab ................................................... 55
Video sub-tab ............................................................. 54
Camera Inputs form ..................................................... 79
procedures ................................................................ 81
Camera lookup .......................................................... 168
Camera Outputs form ................................................... 82
procedures ................................................................ 83
Cameras (surveillance-only) ......................................... 172
Capture an image ....................................................... 173
Capture Video on Demand ........................................... 74
Capture Video on Event ............................................... 73
Client Side Caching ..................................................... 167
Configure ................................................................... 71
camera ................................................................. 71
perspective correction ............................................... 134
video channel parameters ......................................... 135
Conventions used in this documentation .......................... 13
Convert and export video ............................................. 228
Create a video event .................................................... 173
Custom command grammar
direct PTZ systems ................................................... 152
matrix-based systems ............................................... 151
Customize Overlay Information Dialog ......................... 226

D
Delete
alarm in standard Video Verification window .................. 219
matrix switcher ......................................................... 148
matrix switcher type .................................................... 150
Device - Camera Links form .......................................... 87
procedures ................................................................ 88
Digital Video folder ...................................................... 17
Alarm - Video Configuration form ................................. 90
Archive Server form ..................................................... 94
Camera form .............................................................. 42
Camera Outputs form ................................................... 82
Device - Camera Links form .......................................... 87
PTZ Tour Server form .................................................... 110
Security form ............................................................. 99
Index

Video Processing form ................................ 101
Video Recorder form .................................. 26
Digital video recorders overview ..................... 17

E
Event Configuration/Search
dialog .................................................. 124, 175
open dialog ............................................ 123
procedures ............................................. 131
Event Configuration/Search Dialog
procedures ............................................... 180
Event properties ....................................... 131
Event recording
 increase frame rates ................................ 75
Event settings - add .................................. 109
Export video to a file .................................. 227
Exporting video
digital signatures ..................................... 229

F
Frame rates-increase during events ..................... 75

I
Images capture ........................................ 173
In-Camera Storage .................................... 64
camera configuration .................................. 65
camera requirements .................................. 64
IntelligentAudio Events form ......................... 139
procedures ............................................. 142
IntelligentVideo Events form
field table ............................................. 117
procedures ............................................. 120
IntelligentVideo form
field table ............................................. 185
IntelligentVideo Server form
field table ............................................. 114
procedures ............................................. 116
IVS form .................................................. 114

L
Launch .................................................... 170
Launch video from camera ............................ 170
LDVR video recorder
 add camera ............................................ 71
 add multiple cameras .............................. 41
 add recorder ........................................ 39
LDVR-408 video recorder overview ............... 20
LDVR-444 video recorder overview ............... 21
LDVR-SP video recorder overview ................ 18
LDVR-SP30 video recorder overview .............. 19
LNVR video recorder
 add camera ............................................ 68
add recorder .......................................... 36
overview ............................................... 22
security and passwords ............................. 27
LNVS video recorder
 add camera ............................................ 70
add recorder .......................................... 38
overview ............................................... 23
Load a video file ...................................... 171

M
Masking motion ........................................ 77
Matrix switcher
 form ..................................................... 145
overview ............................................... 145
Matrix switcher type
 form ..................................................... 149
procedures .......................................... 150
Matrix switcher variable designations .............. 155
Modify
 matrix switcher ........................................ 148
 matrix switcher type ................................ 150
Monitor video
 in matrix view ........................................ 189
 with multiple cameras (successively) ........... 172
 with one specific camera .......................... 171
Motion detection configuration ....................... 77
LDVR ..................................................... 23
Motion Detection event
collection/search dialog ............................. 108
overview ............................................... 107
Motion mask applied to camera ..................... 77
Motion masking ....................................... 77
Multi-drop support-virtual matrix switcher
 LDVR-408 ............................................. 21
 LDVR-444 ............................................ 22
 LDVR-SP .............................................. 18
 LDVR-SP30 .......................................... 19

P
Pan, tilt, and zoom
 configure ............................................. 192
control adjustment .................................... 196
control locking ........................................ 199
how to use ............................................ 193
LDVR-408 ............................................. 20
LDVR-444 ............................................ 21
LDVR-SP .............................................. 18
LDVR-SP30 .......................................... 19
presets ................................................. 199
tours ................................................. 203
with matrix switcher ................................. 145
Password
 change network video .............................. 101
Pelco "D" protocol .......................................... 149
  example.................................................. 156
message format .......................................... 153
  standard command set.................................. 153
Perspective Correction
  configure................................................ 134
Play exported video ...................................... 229
PTZ .......................................................... 192
PTZ Tour Server form ...................................... 110

R
Region of Interest
  set......................................................... 132, 182
Remote Monitor ........................................... 206
  add cameras ............................................. 207
  change TCP/IP port .................................... 210
  LNVR security .......................................... 206
  local monitor window .................................. 208
  right-click options ..................................... 207
Remote Monitor application ................................ 209
  profiles ................................................... 210
Remote Monitor application
  procedures................................................ 84
Remote Monitor form ...................................... 85
Remote Monitor form
  procedures................................................ 85

S
Search
  video ....................................................... 184
Security form .............................................. 99
  procedures................................................ 101
Set up monitoring station to view video .................. 160
Standard video verification
  display cardholder photo and live video.............. 218
  remove readers.......................................... 218
Surveillance-only cameras .................................. 172
Switch between camera and monitor views ................. 192
Switch camera views in Video Player ...................... 172

T
Time-lapse recording
  configure with LDVR .................................... 78
  configure with LNVR and motion detection .......... 79
Two-way audio ............................................. 168

V
Variables for matrix switchers .......................... 155
Video
  create event ............................................ 173
  export ................................................... 227
  monitor ................................................... 172
  search ...................................................... 184
  view search results .................................... 184
Video Channel Configuration
  configure parameters .................................... 137, 186
  dialog ..................................................... 135
  open dialog .............................................. 134, 186
  procedures.............................................. 137
Video Channel Configuration dialog ...................... 185
Video Export ............................................. 224
Video monitor features .................................. 167
Video monitoring
  checklist ................................................ 160
  Video monitoring features
    browser-based VideoViewer .......................... 167
    Camera lookup ........................................ 168
    client side caching .................................. 167
    Two-way audio ........................................ 168
  Video monitoring procedures ......................... 170
  Video Monitoring window ................................ 159
  Video Player ............................................ 161
    switch camera views .................................. 172
  Video Processing form .................................. 101
    field table ............................................ 102
    procedures............................................ 109
  Video Recorder form
    Archiving/Purging sub-tab ............................. 31
    Connection sub-tab .................................... 26, 28
    LNVR procedures ...................................... 36
    LNVS procedures ...................................... 38
    other recorder procedures ............................ 39
    procedures............................................ 35
    add other recorders ................................... 39
    Recording sub-tab ..................................... 29
    right-click menu ...................................... 40
  Video recorders overview ............................... 17
  Video Search window .................................... 175
  Video Verification
    digital video ........................................... 216
    standard CCTV ......................................... 217
  Video Verification window ............................... 215
    display.................................................. 215
  Video-change network video password .................. 101
  VideoViewer (Browser-based) .......................... 167
View
  video files ............................................. 171
  video tour .............................................. 160
Virtual matrix switcher .................................. 145

W
Watermarking .............................................. 229
  authentication......................................... 230
B.A.S.I.S.® ET690 Digital Video Software User Guide
Product version 6.1, item number E844, revision 1.015, July 2008

Content of this document copyright © 1999-2008 by Lenel Systems International, Inc. BadgeDesigner™, FormsDesigner™, and MapDesigner™, are trademarks used by Stanley Security Solutions with permission from Lenel Systems International, Inc. Windows, Windows Vista, Windows XP, and Windows 2003 Server are trademarks and Microsoft is a registered trademark of Microsoft Corporation. Integral and FlashPoint are trademarks of Integral Technologies, Inc. Crystal Reports for Windows is a trademark of Crystal Computer Services, Inc. Other product names mentioned in this User Guide may be trademarks or registered trademarks of their respective companies and are hereby acknowledged.

Information in this document is subject to change without notice. No part of this document may be reproduced or transmitted in any form or by any means, electronic or mechanical, for any purpose, without the express written permission of the authors.

The software described in this document is licensed to Stanley Security Solutions by Lenel Systems International, Inc. Portions of this product were created using LEADTOOLS © 1991-2008, LEAD Technologies, Inc. ALL RIGHTS RESERVED. The software includes ImageStream® Graphic Filters. Copyright © 1991-2008 Inso Corporation. All rights reserved. ImageStream Graphic Filters and ImageStream are registered trademarks of Inso Corporation.